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Thank you for purchasing IBM WebSphere Homepage Builder
Version 4.0 for Linux. I1BM WebSphere Homepage Builder
Version 4.0 for Linux (called Homepage Builder hereafter) is an
application that assists you in creating Web pages.

You probably already know that you must use a special language
called HTML (Hypertext Markup Language) to create Web
pages. HTML tags consists of alphabetic letters and symbols.
Does that mean that a lack of special knowledge of HTML will
prevent you from creating Web pages?

The answer is No. Even if you do not know what HTML is at alll,
Homepage Builder enables you to create your own Web pages.
If you have used a word processor, you can utilize Homepage
Builder right away, because the operations of this application are
similar to those of a word processor.

Homepage Builder includes convenient materials and accessory
tools. If you want to create Web pages quickly, you can use the
materials and templates attached to Homepage Builder. If you
want to create your own original materials, you can use the
accessory tools called WebArt Designer and Web Animator.

Homepage Builder offers both advanced functions and easy
operation at the same time. Create your own Web pages with
Homepage Builder!
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About this guide

This User's Guide explains how to use Homepage Builder. This book is for beginners
who know at least the basic Linux operations.

(I)Note ]

Windows and dialogs shown in this guide and those displayed on your monitor might
be different. It depends on your system.

Screen shots of a Web browser shown in this guide are taken from Netscape
Navigator 4.7. Information on the Internet—that is, Web pages or Web sites—are
subject to change without notice.

How this guide is organized

Each chapter and appendix contains the following information:

Chapter 1. Web pages and Homepage Builder
This chapter introduces Homepage Builder, explains what Web pages are, and
explains which chapter or section of this User's Guide you should read to do what
you want to do. Reading this chapter helps you to expand your imagination in
creating your original Web pages.

Chapter 2. Installing and starting Homepage Builder

This chapter explains the system requirements, how to start and end Homepage
Builder, and how to view online help when problems occur.

. 4
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Creating Web pages

i

Chapter 3. Tutorial: Creating your Web pages in an hour
You can create your Web pages in an hour using the templates and materials
Homepage Builder offers. Follow the instructions in this chapter to become accus-
tomed to Homepage Builder.

Qrmediate:

Chapter 4. Basic knowledge
This chapter explains the basic knowledge and operations of Homepage Builder.
You will learn such terms as site, Web page, and attribute.

Chapter 5. Editing text
Chapter 6. Creating tables
Chapter 7. Inserting images
Chapter 8. Setting links

Chapter 10. Creating materials
These chapters explain essential tasks for creating Web pages.

@anced:

Chapter 9. Designing Web pages using style sheets
A style sheet is a very recent technology that is likely to become essential for Web
page creation. You can use it to design your Web pages.

Chapter 11. Advanced techniques
This chapter explains such advanced techniques as the frame function, images
maps, dynamic HTML, and so on.

. 4



Uploading

Chapter 12. Uploading Web pages
This chapter explains how to upload your Web pages to your provider's server to
make them accessible on the Internet.

Other information

Chapter 13. Other functions
Appendix

Glossary

Index

Homepage Builder User’s Guide



Chapters you should read

You do not need to read this guide from the beginning to the end. You should read
chapters 1, 2, 3, 4, and 5 in order and then go on to the chapters you are interested in.

Vocabulary

This guide explains difficult vocabulary where it first appears and in the “Glossary”.

Mouse operations

The following list shows typical mouse operations:

Symbol Meaning

Point Put the mouse pointer on the target object.

Click Point to the target object and press the left mouse button
once.

Double-click Point to the target object and press the left mouse button
twice.

Drag Move the mouse pointer while pressing the left mouse button.

Drag and drop | Move the mouse pointer while pressing the left mouse button.
Then release the mouse button at the target point.

Abbreviations

This guide uses the following abbreviations:

[ Abbreviation Formal Meaning ]
Windows Microsoft(R) Windows(R) 95, Windows 98, Windows NT(R)
4.0, or Windows 2000
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Chapter

1

Web pages and
Homepage Builder

This chapter introduces Homepage Builder, explains what
Web pages are, and explains which chapter or section of this
User’s Guide you should read to do what you want to do.
Reading this chapter helps you to expand your imagination in
creating your original Web pages.

I.l_

*** What are Web pages? .............cccovenennen. 1-2
*** Sample Web pages ..........cccceeveienienenns 1-4
*** Webh pages on the Internet ................... 1-10

Note: The stars (* to *%%) indicate the importance of the task. The most important tasks are marked by *%*. 11



What are Web pages?

You probably have seen Web pages using a Web browser. See the following sample

Web page to examine the structure of a general Web page.

1-2

This is a sample Web page.

To highlight the title,
sometimes images i
are used.

title

CEE
|

If you click a link,
another page appears.

image with a link

Home News Download Support Search

WebSphere

Homepage "1/«

& Sy
P Productlnfo

P Partial support of HTML 40

P Offering and custonization of dynamic HTML

If you click an image
with a link, another
page appears.

Web browser

An application for view-
ing Web pages.
Netscape Navigator and
Microsoft Internet Ex-
plorer are well-known
Web browsers.

URL is the address
of a Web page.

Tables are often used
for page layout.

Web pages can contain

GIF images or JPEG
images.

URL

An address of a Web
page. It usually begins
with http://www.... Be-
cause each URL is
unigue, you can access
the target URL from any-
where in the world.

Homepage Builder User’s Guide

link

A function to jump. If
you click text or an im-
age to which a link is
set, you jump to another
page or another place in
the same page.

e



A Web page is an HTML file

If you use Netscape Navigator, select Page source from the View menu. The HTML
language, such as the following sample, appears.

If you open the preceding Web
page with a text editor instead of
a Web browser, you see this

i (W 23 . O X
HTML source file. Tl oo ;
i File Sessians Opticns Help
<tDOCTYPE HTHML PUBLIC "-//W3C//DTD HTHML 4.8 Transitional//EN">
<HTHL>
<HEAD>

<HMETA name="GENERATOR" content="I1BM WebSphere Homepage Builder U4.8.8 for Linux
<TITLE>Homepage Builder Sample Web Page</TITLE>

</HEAD>

<BODY bgcolor="H#FFFFFF" text="#000006" link="#2967%e" vlink="#3366CC" alink="#33
<CENTER>

TABLE width="6080">

<TABLE...>

~
o}
=
S
El
=
b

Indicates a table. <TD colspan="8" align="right"><IHG src="navi.GIF" width="233" height="18"
</TR>
<TR>
<TD colspan="3"><IMG src="title.JPG" width="688" height="168" border="0"><
<fTR>
<TR>
<TD><B>Henu</B></TD>
<TD colspan="2"><B>Headlines</B></TD>
</TR>
Indicates an image. T
<FONT size="2"><IMG src="goldarrow.gif'" alt="=*" border=""8">&nbsp; <A href=
nbsp; <A href="/toppage/featu
<|IMG..> @<IMG src="goldarrou.gif" nbsp; <A href="http://prodinf
<IMG src="goldarrow.gif" nbsp; <A href="http://prodinf
<IMG src="goldarrow.gif" ">&nbsp; <A href="/toppage/servi
<IMG src="goldarrou.gif*" alt="s" border="0">&nbsp;@<A href="/toppage/prodi
</FONT></TD>
<TD rowspan="2" width="300" valign="top" align="left'>
@ <P><FONT size="2"><IMG src="goldarrow.gif" alt="="|border=""8">&nbsp; <A hr
(WSINYE), &quot;HTHL Source,&quot; and &quot;Preujew.tquot;
26,16 Top

Indicates a link.

<IMG src="goldarrou.gif"

=L

Indicate a paragraph.

“To create a Web page” is actually “to prepare a file written in HTML.” Because HTML is a
computer language that consists of many tags, we are not familiar with HTML in our everyday
lives.

Now we come to Homepage Builder. Without any knowledge of HTML, you can create Web
pages or a Web site easily with Homepage Builder as if you create documents with a word
processor. HTML tags need not concern you, because the required tags are automatically
embedded into the document.

Chapter 1. Web pages and Homepage Builder 1-3



e
Sample Web pages

St Using templates and materials

Novice _ | .
Chapter 3, “Tutorial: Creating your Web pages in an hour”

If this is the first time for you to create a Web page or to use Homepage Builder, use
the templates and materials Homepage Builder supplies. Chapter 3 of this guide
describes how to create Web pages in an hour.

Templates
® o

Templates for Web pages consist of an optimum combination of materials. You can replace
these materials with others if you like.

( If you combine these materials, )

This framework for your Web
page is automatically generated.

\
.

Chef's Suggestion
BT EEr S e

\
.

1-4 Homepage Builder User’s Guide



Materials
@ @

Homepage Builder offers various materials. See the following examples.

Background images

Title images

Welcome to

My ,

Home ¢, ~

Page %‘& ,

Header and footer
%%i&‘ i el bdeg g SEaEdE A SES LT
GEREEAE LG ue Ak u s s TEE AL

Chapter 1. Web pages and Homepage Builder 1-5



Sample Web pages

Intermediate

Learning about basics

Chapter 4,
Chapter 5,

Chapter 6,

“Basic knowledge”
“Editing text”
“Creating tables”
Chapter 7, “Inserting images”
Chapter 8, “Setting links”
Chapter 10, “Creating materials”

Once you have created a framework using templates or materials, enrich the content
of your Web pages so that they are brimming with your own creativity.

Content is crucial to Web pages

Content is the crucial element in Web pages. Express on your Web pages something you
have long thought, something you want other people to know, or ideas that no one else has hit
upon. Homepage Builder will be your partner.

4 N\

See this example.
The author of this Web ( )
page used the Garden-
ing template to make a
framework and then
enriched its content.

Floral Arrangements
“ : ”
A ABC Florist, we are proud of our customer service and the Entering text” on
quality of our praducts, Owr top-selling foral arrangernents are; page 5_2

\ P Five sizes available.
‘ y g 1810, 315, $20, £25, 830 plus delivery charge
|/Order Cade: F1
z }‘_- |One Dozel! Tulips
“Inserting an image” .7. e aniny “Creating a table” on
on page 7-2 £ |Order Cade: F2 page 6-2
 Three pansy pots
‘ ¥ |10 phus delvery charge ‘
Order Code: F3
Inserting a horizontal -Add't' e . “Inserting a heading”
» - 1lonal Services@
rule” on page 5-15 on page 5-13
« Potted green plants
| « Frutbaskets
» Balloen bouguet ‘
“Creating a ”St" on » Christmas centerprece ///
page 5-17
e @ “Setting a link on text”
\ Mail To place vour order, elick here
o .on page 8-2
1-6 Homepage Builder User’s Guide



Types of headings Types of lists
° o0

The following six types of
headings are available. The following three types of lists are available.

“Inserting a heading” on “Creating a list” on page 5-17

page 5-13
(" . ) Bulleted list
1. Flower Basket
Head lng 1 s Flower Basket 2 DOne Dozen Tu]jps
s One Dozen Tulips
Heading 2 Ordered list
Headi“g 3 Definition list ~
. Flower Basket
Heading 4 Five sizes available.
F10, §15, $20, $23, $30 plus delivery charge
Heading 5 Cne Dozen Tulips
Arrangement in a vase.
Heading 6 $15 phus delivery charge
- J - J
Creating your original materials
® @

Example of lettered buttons

You can create lettered buttons and
decorate photos with frames using the
WebArt Designer accessory tool.

Chapter 10, “Creating materials”

Example of
photos with
HEINES

Chapter 1. Web pages and Homepage Builder 1-7



e
Sample Web pages

et Using the latest technology

AdvaHGEd Chapter 9, “Designing Web pages using style sheets”
Chapter 11, “Advanced techniques”

Homepage Builder is compatible with such recent technologies as style sheets,

dynamic HTML, and so on.

Web pages using the latest technology can be viewed only
on Web browsers that are compatible with that technology.

Sample Web page that uses various techniques
® o

Dividing a window, embedding sound or a Java applet, or inserting an access counter makes
your Web page impressive.

See this example. The author of this Web page used
the Gardening template to make a framework,

enriched its content, and then used various tech- “Customizing a Java

applet” on page 11-28

nigues to make the Web page impressive. .
“Dividing a Web ; - ™
browser window (1)” . ————roers g bR CRNRI IR LR SRR
on page 11-3 Kok st

“Setting multiple links
on a single image” on
page 11-11

“Receiving readers’ @
responses” on page Ml Home

11-2
LSl iR RIR LRI R

S e S

For Your Dream Wedding

We specialize in wedding services. Our designers and
bridal consultants will make your special day a besiful
andmemorable experience.

§L

“Editing a script
program” on page .

11-24 ‘ “Embedding a plug-in
object” on page 11-26

L/

1-8 Homepage Builder User’s Guide



Forms Dynamic HTML

uestionnaires, order forms, and so on
° (q ) °

b

You can make questionnaires or order :
forms using the form function. |

“Creating a form” on page 11-17

* Basketball and Related Products

Order Form
Deliver to: Basketshoes
Sebmston: :Basketball
e [ * ?::: [E}mform Order
swonienn [
i F
s [
= -
- Homepage Builder offers sample dynamic
i HTML.
= “Using dynamic HTML” on page 11-33
| =7 e A—
il [ ERon e

Style sheets
® @

The following two Web pages look different,
but both of them use the same HTML file.

The combination of HTML and style sheets

can make your Web.pa.ges beautiful. The first page does not use a style sheet,
Chapter 9, “Designing Web pages whereas the second one uses a style sheet
using style sheets” to change layout, color, and font.
Titl This is an example of the same
1tie Web page using a style sheet.
pag g y
Style Sheet 1
Style Sheet 2

Style Sheet 1
Style Sheet 3

Style Sheet 4 H Style Sheet 2
Style Sheet 5 Style Sheet 3
s List-1

: Lns Style Sheet 4

Style Sheet §

List-1
0o JList-2
This is an example of a Web page list2

that does not use a style sheet.

Chapter 1. Web pages and Homepage Builder 1-9
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Sample Web pages
Sl Web pages on the Internet

Chapter 12, “Uploading Web pages”

Even if you have created wonderful Web pages, no one can view them as long as
they are stored in your computer. If you want someone to view your Web pages, you
have to transfer all the files composing your Web pages to an Internet Service
Provider. Web pages on the Internet are accessible from anywhere in the world.

/' A

Homepage Builder offers a func-

tion for transferring all the files
making up your Web site at once.

aaaaaaaaaa

If your Web site is successfully
transferred to a provider’s server,
it is on the Internet. A Web

browser enables other people to LRl iaiBl i iRl
view your Web site. e
o J
provider server

An agent that provides a connection to A computer that stores many Web sites

the Internet. Many providers offer a on the Internet.
service for registering Web sites.

1-10 Homepage Builder User’s Guide



Installing and start Chapter

Homepage Builder 2

After you install Homepage Builder, you can start it. This
chapter explains the system requirements, how to install, start,

and end Homepage Builder, and how to view online help when
problems occur.

*%  System requirements ..............coceeieenens 2-2
*** Installing Homepage Builder .................. 2-3
*x* Starting and ending Homepage Builder...... 2-5

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 2-1



System requirements

To run Homepage Builder, you need the following:

2-2

Operating system

One of the following is required:
- RedHat 6.1 or 6.2

- SUSE Linux 6.3 or 6.4

- Turbo Linux Workstation 6.0

- Caldera OpenLinux 2.4

Computer Personal computer with Pentium® Processor (166 MHz or more
is recommended.)

Memory 64 MB or more is recommended.

Hard disk For the minimum configuration, 70 MB or more of free hard disk

space is required.

For the online User’s Guide, 10 MB or more of free hard disk
space is required.

For the online multimedia tutorial, 30 MB or more of free hard
disk space is required.

Other hardware

A CD-ROM drive to install the program.

Homepage Builder User’s Guide




This section explains how to install Homepage Builder on the hard disk of your com-

puter.

(1)Note

By default, the program is
installed in the /opt/
hpbuilder4 directory. To
change the default top di-
rectory, use the --relocate
option of the rpm com-
mand. For example, to
change the top directory
from /opt to /usr/local, use
the following command:

# rpm -ivh —-relocate

fopt=/usr/local
hpbuilder-4-1.0.i386.rpm

Installing Homepage Builder

@ Turn on your computer, and start Linux.
@ Log in to Linux as super user (root).

@ Insert the Homepage Builder CD into the CD-ROM
drive of your computer.

@ To mount the CD-ROM drive, type the following
command and press Enter:

# mount -rt iso9660 /dev/cdrom /mnt

Change the parameters /dev/cdrom and /mnt as necessary
for the configuration of your system.

@ Move to the /mnt directory.
# cd /mnt

@ Type the following command and press Enter. For
Package-file-name, specify the name of the pack-
age you want to install.

# rpm -ivh <RPM Package-file-name >

Chapter 2. Starting Homepage Builder 2-3



When the installation is complete, exit from the /mnt
directory.

#cd/

@ Unmount the CD-ROM drive.

# umount /mnt

Qn_ @ Take out the CD from the CD-ROM drive.

2-4

To uninstall Homepage
Builder, do the following:

1. Log in to Linux as super
user (root).

2. Type the following com-
mand and press Enter.
For Package-file-name,
specify the name of the
package you want to
uninstall.

$ rpm -e <RPM
Package-file-name>

Homepage Builder User’s Guide



When installation is complete, you can start each component of Homepage Builder by
issuing the hpbuilder command, as follows.

() Note |

The hpbuilder command can be found in the /bin directory under the installation direc-
tory (for example, /opt/hpbuilder4/bin).

If any process fails while
running Homepage Builder,
type the following command

and press Enter to clean up
the failed process:

$ hpbclean

Starting and ending Homepage Builder
To start the HTML editor of Homepage Builder, type the
following command and press Enter:

$ hpbuilder -e

To end the program, click File --> Exit on the menu.
Starting and ending WebArt Designer

To start WebArt Designer, the image-editing tool, type the

following command and press Enter:

$ hpbuilder -c

To end the program, click File --> Exit on the menu.

Chapter 2. Starting Homepage Builder 2-5
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Starting and ending Web Animator

To start Web Animator, the animated GIF tool, type the
following command and press Enter:

$ hpbuilder -a

To end the program, click File --> Exit on the menu.

Starting and ending File Transfer
To start File Transfer, type the following command and
press Enter:

$ hpbuilder -f

To end the program, click the £ icon.

Starting and ending the online tutorial
To start the online tutorial, type the following command
and press Enter:

$ hpbuilder -t

To end the program, click File --> Exit on the menu.

Homepage Builder User’s Guide



About the Homepage Builder main window

You can manage Web sites and Web pages on the left side of the window, and you can

open and edit pages on the right side of it.

— Tool bar

Menu bar

the menu bar.

One Dozen Tulipsa
[fmengementin e vese

15 pls dcivery charged
(Order Code: F2

HTML Source tab

Normal tab

——— Contents tab

File tab

Link tab

The Link pane, displayed when you click the Link tab, enables you to view the link hierarchy from

the top page of a site.

You can call all the Homepage Builder functions from the menu items on

You can call frequently used functions from the buttons on the tool bar.

played.

played.

Edit Web pages on the HTML Source pane, displayed when you click
the HTML Source tab, only when you want to edit HTML source directly.

The Normal pane, displayed when you click the Normal tab, is the
normal editor of Homepage Builder.

The Contents pane, displayed when you click the Contents tab, enables you to select and insert
materials into a Web page that is opened on the right side of the window.

The File pane, displayed when you click the File tab, shows a list of folders and files within a site
folder. In this view, files are divided into those to be transferred and those still unused.

Chapter 2. Starting Homepage Builder

e \When you open a page
that includes frames, the
Frame HTML Source and
No Frame tabs are dis-

P Notes

e If a site is not yet opened,
the contents of the Link
and File tabs are not dis-

2-7
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Tutorial: Creating yc Chapter
Web pages in an ho 3

You can create your Web pages in an hour using the tem-
plates and materials Homepage Builder offers. Follow the
instructions in this chapter to become accustomed to
Homepage Builder.

This chapter explains how to create Web pages at your

computer, view its link hierarchy, and view them on a Web
browser.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

To effectively acquire the knowledge and skills for creating
a Web site, read the following sections in order:

*x* Greating a framework of Web pages ......... 3-2

*%*% Viewing the link hierarchy of Web pages....3-9

*** Viewing Web pages on a Web browser .... 3-13

*%% Enriching the content ......................... 3-14

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 3-1



( Creating a framework of Web pages )

L 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

¥

( Enriching the content )

The easiest way for you to create a framework of Web
pages is to use templates for Web pages that consist of
an optimum combination of materials. You can replace
materials if you like.

Start Homepage Builder and click the Cancel
button on the Welcome to WebSphere Homepage
Builder dialog.

“Starting and ending Homepage Builder” on
page 2-5

@ Select New from the File memu.

FPersonal 4
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@ Vocabulary

wizard

A user interface that en-
ables you to do tasks step
by step. You just need to
select something or answer
the question and then click
the Next button. Wizards
are often used in the Win-
dows world, because they
enable you to do tasks ac-
curately. On each dialog
box of a wizard, click the
Next button to advance to
the next step, or click the
Back button to return to the
previous step. Click the
Cancel button to cancel the
operation. On the last dia-
log box, click the Finish
button to activate what you
selected or entered.

€@ Click the Multiple Pages tab, and then click the OK
button to start the wizard for creating a framework

of a Web site.

Hew

Page | Frame | Application

‘our favarite \Web pages
can be created easily,
selecting genre or image
paits. ou can create Top
page and subpages linked
by the tap page.

Click DK button below. start
the wizard

QK I Cancel | Help I

The following is the first dialog box of the wizard.

~Select Genre

C ess
Hobby & Interest
Life Style

ature
Schaal
Seience
Sports
Testurs Series
Town Business

~Theme

Casual

Farmal?

Gorgeous =l

ek [ mes | cancel Help
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@ @ Select one item in the Select Genre list, and then

If you want to select some-
thing experimentally, click
Town Business on the Se-
lect Genre list, and then
click Restaurant in the
Theme list.

(¢ Tip ]

If you select the No text
check box ( [+ ) at the bot-
tom of the Select Banner
Image list, text such as
“WELCOME TO MY HOME
PAGE" disappears. Then, if
you later clear the No text
check box ( "), the text
reappears.

Homepage Builder User’s Guide

select one item in the Theme list.

Create Mutiple Pages - 1/5

[~ Select Genre
Conceptual Series

<ot [ hets | tancdl | Hew |

You can view the design for the selected theme on
the right side of the dialog box. This design is a

template that consists of optimal materials for the
theme.

@ Click the Next button to go to the next step. The

following dialog box appears:

Create Mutiple Pages - 2/5

~Select Background

Bl Diagonal Shipe =
Blue Green Stipe
Blue Grid
Blue Note Pad | |
Blue Paper
Blue Stipe

Cat Paws
Circuit Board Edges
ok

:Cream Vellow Wl

—Select Banner Image
Business People 5

Butterlly Title
Camers

Cat
Cl

Circuit Board Circle:
.......

™ HoText

cBack | Mew> | Cancel Help
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@ On this dialog box, you can replace a background
image or a banner image with a different one.

If you want to replace materials, select a back-
ground image in the Select Background list, select
a banner image in the Select Banner Image list,
and click the Next button.

If you do not want to replace materials, just click the
Next button. The following dialog box appears:

Create Mutiple Pages - 3/5

(- Sielec Header/Eooter

Cark, Slips |
Dog Biscuits

Dynamic

Ethric

Femirine _I
Gold

Gorgeous

Green Blue Eaves & Step

Green Flovs

- Select lcon Image

Biiliant =
Butterlly

Cand Suit

Cat J
Cireuit Seope

Clouds [White)

Color Bl

Color Notebook

cBack [ mews | concel | Hep |

On this dialog box, you can replace header and
footer images or icon images with different ones.

If you want to replace materials, select a header
and footer image in the Select Header/Footer list,
select an icon image in the Select Icon Image list,
and click the Next button. The following dialog box
appears.

If you do not want to replace materials, just click the
Next button.
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@ Vocabulary

top page

Normally the first page of a
Web site. However, in this
wizard, what is referred to
as the top page is actually
an ordinary Web page that
has been designed in a top-
page style, and you can use
it as an ordinary Web page.

@ Vocabulary

subpage

A Web page linked from the
top page.

(¢ Tip ]

The e-mail address entered in
E-mail Address becomes the
transmission destination for
mail. If you do not have an e-
mail address, leave E-mail
Address blank and clear the
Include E-mail Address in
Subpages check box.

(¢ Tip ]

To add a subpage, enter a title
for the subpage in Subpage
Title to Be Added or Re-
placed, and click the Add but-
ton. To delete one of the
subpages, select the title of the
subpage in Titles , and click
the Delete button.

Create Mutiple Pages - 4/5

~Top Page Seftings
Tite

E-mail Address

Subpage Titls to Be Added of Fieplaced

Add Beplace | Delete

[¥ Include E-mail Address in Subpages

@ Enter the title of the top page in Title under Top
Page Settings , and enter your e-mail address in E-
mail Address .

€l Enter the title of a subpage in Subpage Title to Be
Added or Replaced .

] Click Subpage 1, and then click Replace to replace
the title of the subpage.

@ Replace Subpage 2 and Subpage 3 with your
preferred titles in the same manner.

Create Mutiple Pages - 4/5 If you Want to enter
something experi-
mentally, enter
“Chef’'s Suggestion”
for the title.

If you want to create subpages experimentally,
enter the following three subpage titles:
“Appetizer,” “Entree,” and “Dessert. ”
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(¢)Tip

If you substituted materials
and want to record the set-
ting as a new template, click
the Register button, enter
any text in Theme, and
click the OK button. The
next time you start the wiz-
ard, you can conveniently
select the recorded setting
as a template.

(¢ Tip ]

To create a folder using the
Specify Folder dialog box,
double-click the existing
folder, click the Create
Folder button, enter a
folder name, and then click
the OK button.

For example, to create a
folder named “sitetop” im-
mediately under the C
drive, select c: under Drive,
double-click c:\ under
Folder , then click the Cre-
ate Folder button. When
the Create Folder dialog
box appears, enter “sitetop”
and click the OK button.
From now on you can se-
lect a sitetop folder in the
Folder list.

@ Click the Next button to display a dialog box for
confirming the settings. The following dialog box
appears:

Create Mutiple Pages - 5/5

FEmm
[

& A default folder is already specified in Specify
Target Folder . To change this folder, click the
Browse button to display the Specify Folder dialog
box.

@ See the tip on the left and create a folder for saving
Web page related files.

Spe Falder
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(1)Note

To select a folder in the
Specify Folder dialog box,
double-click the folder
name. You cannot select a
folder with a single-click.

(¢ Tip ]

If you used one of tem-
plates, the HTML file name
for the top page is
index.htm. (index.htmis a
file name often used for the

top page. )

(3 Double-click the folder name and click the OK
button to close the Specify Folder dialog box. The
name of the folder you selected is automatically
specified in Specify Target Folder .

{d Click the Finish button. The top page appears on
the right side of the Homepage Builder main win-
dow. The HTML file name and page title are dis-
played on the title bar of the main window.

Now you created a framework for your Web site.
Continue to the next page to view the link hierarchy
of your Web site.
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Viewing the link hierarchy of Web pages

( Creating a framework of Web pages )

A 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

¥

( Enriching the content

)

O

Details about a site are ex-

plained in Chapter 4.

A typical Web site permits jumping from the top page to
subpages, which is referred to as linking. Homepage
Builder enables you to view the link hierarchy. You must
register your Web pages as a site, however.

@ Select Site Wizard from the Site menu to start the
wizard for making a site.

@ Select Create a Site, and enter any site name.

~Select an Operation

=

& Cieste a Site
Site Name
Site 1

Specily a name for the site. Choose a
name that is easy to understand.

LEEZ € Charge the Existing She Settings

The site name i
required

<o [ Mews | Camcel | Hep |

€@ Click the Next button to display a dialog box for

specifying a file name of the top page.

- Site Setting:

Top Page [ |

Specify the file name of the top pagelfar
example. indet html. indes. htm, default b, If 3
new fils name is specified, the file s created

Top Folder (Source Folder) Select

Specify the top folder to put the files for Web
pages. f the top page above is specified. the The settings in this page
Felder name is inpLt in this field automatically. are required.

“ou can change the folder. The folder also
mears the source folder for transerting,

Detal $etings |

< Back Hewt> Cancel | Hep |
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OUI——

The “sitetop” folder selected
within the following figure
was created in the previous
section of this guide, using
the Specify Folder dialog
box.

@ Click the upper Select button to display a dialog
box for specifying the file name.

@ Select the folder you saved the Web pages in Look
in. Click index.htm to enter “index.htm” for the file
name.

=

| Sarewe  EE| Gl E]E

sub2 htm
|BEJs b3 hitm

@ Click the Open button. The file name of the top
page and the folder name of the site are entered
automatically.

:
e | R

Bl B B
s | [BEEEEE

Click the Next button to display a dialog box for
specifying the destination server.
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(¢)Tip

You can specify the destina-
tion server later.

“Registering the desti-

nation server” on page 12-2

@ Click the Next button without any specification,
because you can specify the destination server
later.

€1 On the next dialog box, Operation after Setting
Completion , select Open the Site after Closing
Settings , and click the Finish button. The “Do you
want to close all open documents?” message
appears.

Click the No button. The wizard ends and the link
hierarchy appears on the right side of the main
window:
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Can you see the link hierarchy of your Web site? If
you created a Web site using one of templates, the
Web site makes the following hierarchy:

[ e —— e
index.htm (top page)

Homepage Builder User’s Guide

subl.htm (subpage 1) sub2.htm (subpage 2) sub3.htm (subpage 3)

You have now created your Web pages as a site.
You can check the link hierarchy or file organiza-
tion at any time. Continue to the next page to view
your Web site on a Web browser.




Viewing Web pages on a Web browser

( Creating a framework of Web pages )

L 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

¥

( Enriching the content )

(1)Note

You can use this function
only if you have installed
Netscape Navigator in your
computer.

(¢)Tip

If you have changed any-
thing on the Web page, a
dialog box for confirming
whether to save the change
appears before the Web
browser starts. Click the
Yes button on the dialog
box.

(I)Note ]

You can view pages using
style sheets or dynamic
HTML only if you have in-
stalled Netscape Navigator
4.0 or later.

The appearance of a Web page in Homepage Builder
and in a Web browser (an application for viewing Web
pages) differ to some extent. You can check how your

Web page looks on a Web browser, while you are editing

it with Homepage Builder.

Navigator starts.

B
File

scape: Chef's Suggestion

Viewing a Web page on Netscape Navigator

To view a Web page on Netscape Navigator, the Web
browser of Netscape Communications Corporation, click
E while the Web page is displayed. Then Netscape

ator
& 2 @

Back  Foward  Reload Home  Search Netscape

19 =2 A

CheP’s Suggestion

—
[ [SOUEERNN [Docurert Dene

I
= E e
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( Creating a framework of Web pages )

L 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

A 4

( Enriching the content )

@ Vocabulary

drag and drop

Pointing to the target object,
pressing the left mouse but-
ton, moving the mouse
pointer to the target loca-
tion, and then releasing the
mouse button.

Enrich the content of your Web pages by entering text,
pasting the images, and so on. From now on you will be
creating real Web pages abounding with your own cre-
ativity.

Opening a Web page to be edited
Open a Web page you are going to edit.

@ If a Web page is currently open, click the X button
in the upper right corner of the Web page window
(not the main window) to close it. If multiple pages
are currently open, close them all.

=181 x|

@ Select a page (for example, the subl.htm file in the
following figure) on the Link pane, and drag and
drop it to the right side of the main window.
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The Web page opens. The HTML file name and
page title are displayed on the title bar of the main
window.

Entering text

@ After opening a Web page, enter any text that enriches

your Web site.

Details about the procedure . . .
for entering or editing text is @ Enter any text. (See the following example in which

explained in Chapter 5. subl.htm is edited. )
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@ Delete unnecessary text and images using the
Delete or Backspace key. (See the following
example in which subl.htm is edited. )

Closing a Web page

Close a Web page you have finished editing.

Click the X button in the upper right corner of the
Web page. Then the dialog box for confirming
whether to save the change appears.

@ Click the Yes button.

Now you have learned the foundation for creating
a Web site. If you want to learn a lot more, go on
to Chapter 4.
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Chapter
Basic knowledge 4

This chapter explains the basic knowledge and operations of
Homepage Builder. You will learn such terms as site, Web
page, and attribute.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

*x% Sites and Web pages ..........cccoeveveiininnennn. 4-2
*xx Creatingasite ............cocevviiiiiiiiinnn. 4-4
*x% Creating a Web page..............ccoevenvnvenenen. 4-7
*x% SavingaWeb page..........coeevnieiiiiinnennn. 4-9
*x% Opening a site and a Web page ................. 4-11
*x Using the Welcome dialog box.................. 4-14
*x Using attributes and the right mouse button......... 4-16

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 4-1



Sites and Web pages

Basically site refers to the place on a Web server where a Web page or Web pages
are. Homepage Builder also uses the term site for the place on your computer where
your Web page or Web pages are.

(1)Note ]

Place the top page immedi-
ately under the main folder,
even if you create
subfolders like the illustra-
tion on the right.

@ Vocabulary

top page

The first page (home page)
of a Web site.

Sites are folders, and Web pages are HTML files

Homepage Builder frequently uses the terms site and
Web page. A site means a group of Web pages com-
bined with links, whereas a Web page means an indi-
vidual Web page.

One site has multiple pages. The relationship between a
site and a Web page is similar to the relationship be-
tween a folder and a file in the Windows world. In fact,
on the Web server, sites are managed as folders and
Web pages as files. Conceptually, a Homepage Builder
site performs the same operation on your computer as
the site on the server. Under this concept, you can
assume any folder on your computer to be a site folder,
and you can place multiple Web pages in it.

A Web page is an HTML file. Because an HTML file is a
text file, you can open it with a word processor or text
editor. Images and sounds embedded within the Web
page are other files. See the following illustration. Nor-
mally you collect all files that organize a Web site within a
single folder, as shown in the illustration on the left. For a
big Web site, however, you can create subfolders accord-
ing to file types, as shown in the illustration on the right.

Site folder Site folder

Web pages (HTML files)

Images

Sounds
. Subfolder for Subfolder Subfolder
Web pages for images for sounds
Subfolders
Normally you collect all files that You can create subfolders
organize a Web site within one folder according to file types
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OU——

You can edit Web pages
without creating a site. The
purpose of creating a site is
to view the link hierarchy
and to make it easy to
transfer all the files that or-
ganize your Web site to the
Web server.

Flow for creating Web pages

When using Homepage Builder, Web pages are gener-
ally created in the following order.

@ Create a new site.
“Creating a site” on page 4-4
“Viewing the link hierarchy of Web pages” on
page 3-9

@ Create several Web pages within a site and insert
text and images within each Web page. At this
stage, you work on the site on your computer.

€l Upload the site to the Web server. At this stage,
the site on the Web server matches the site on your
computer.

The creation of Web pages thus begins by creating a
virtual site in your computer and ends with the upload of
the site.

The site is also useful for updating your Web site or Web
pages. The structure and update information of the site
is always saved in your computer, so beginning with your
second upload, just the updated files are transferred to
the server.

Your computer Web server

Chapter 4. Basic knowledge
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You can create a site in any of the following three ways:
e Creating a site and a blank top page simultaneously

e Creating a site and multiple Web pages simultaneously using templates
e Creating a site from existing or previously created Web pages
This section focuses on the first way. For the second and third ways, see the second

Tip in this section.

OUI—

You can edit Web pages
without creating a site. The
purpose of creating a site is
to view the link hierarchy
and to make it easy to
transfer all the files that or-
ganize your Web site to the
Web server. @ “Sites and
Web pages” on page 4-2

(¢ Tips ]

« To create a site and mul-
tiple Web pages simulta-
neously using templates,
select Create a Site with
Multiple Pages using
Template .

To create a site from exist-
ing or previously created
Web pages, select Create
Site from Existing

Pages.

To make a frame-using
page the top page, select
Create Site from Exist-
ing Pages , and then se-
lect a frame-using page
file as the top page file.

Start Homepage Builder. The Welcome to
WebSphere Homepage Builder dialog box

appears.

“Starting and ending Homepage Builder” on
page 2-5, “Using the Welcome dialog box” on page
4-14

@ On the Create a Site tab, select Create a Site with
a Blank Top Page , select the Open the Site to
Create at Start up radio button, and then click the
OK button.

€@ On the Select an Operation dialog box, Create a
Site is already selected. Enter the site name under
it, and click the Next button.
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BB EEEE

@ Click the Select button.

@ @ The following dialog box appears. Select a site

folder in Look in and enter the file name for the top

't_if] reco?’""e”g?g that %0“ page in File name . (Ordinarily, you enter

either select a folder wit “index.html” or “index.htm.” However, if there is a
nothing in it or create a new . . :

folder by clicking | and guide to file names from the provider who has the
assigning a folder name. Web server, follow that guide.)
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OU

If you want to create
subfolders for each file
type, click the Detail Set-
tings button.

OUI——

To change the site settings,
select Site Wizard from the
Site menu, select Change
the Existing Site Settings
and a site name, and then
click the OK button.

OUI———

To delete a site, select De-
lete Site from the Site
menu, select a site name,
and then click the OK but-
ton. The site registration is
canceled. (Folders and
files are not deleted.)

| amee  EE||c] E[E]

index_htm

HTML files ("t htm;* shtrml " shtr) =

=

—

@ Click the Open button. The file name of the top
page you selected appears under the Select but-

ton.

Set Site ltems

- Site Setting:

Top Page

C-\mysiteindes him

Specify the fils nams of the top pagelfar
example, indet i, indes. htm, default b, f 3
new fils name is specified, the file s created

The setfings in this page
are required.

Detal Setings |

<Back | Fnsh | cancel | Hep |

Click the Finish button to open a new site and top
page. The link hierarchy is displayed on the left
side of the main window and a blank top page is
displayed on the right side.

Select Document Properties from the Edit menu,
and then specify the title and background color for

the top page. "Creating a Web page” on page
4-7

Edit the top page. Chapter 5 (and later chap-
ters)
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This section explains how to create a blank Web page from scratch. This operation

enables you to create Web pages without templates; in other words, you do not have
to install templates to do this operation. After creating a blank Web page, specify the
page title and background color.

@ Related HTML tags

<IDOCTYPE HTML PUBLIC ““>
<HTML></HTML>
<HEAD></HEAD>
<TITLE></TITLE>
<BODY BGCOLOR= ></BODY>

OU

Another approach to creat-
ing a Web page is to select
New from the File menu.

“Creating a framework of
Web pages” on page 3-2

OUI——

The title you enter here is
also the title for Favorites
or Bookmarks of Web
browsers.

@ Click the E icon to create a

@ Select Document Properties

blank Web page.

from the Edit menu

to display a dialog box for the page settings.

€@ Click the Document Info tab
title in Document Title .

Attribute

, and then enter any

Tag, IDUcument Fioperties

Document Info IBackglnundﬁTexl En\nrl Meta Infnl Dthersl

[

Document Tite: |F\oral Arangements]

Base LIRL |

Defaulk Target: |

Extended.

[

[ o |

Caneel

Help

Chapter 4. Basic knowledge
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O

“Saving a Web page” on
page 4-9 explains how to
save an edited page.

@ Click the Background/Text Color tab, and then
click the colored button to the right of Background
to display the following pull-down menu:

x|

Document Properties

Text
Lirk.
Wisited Link
Active Link

@ Click any color (or click the Others button to select
a different color), and then click the OK button. The
background color is set.

Attiibute X

Document Properties

@ Click the OK button. Then the background color
changes and the page title is displayed on the title
bar of the main window.
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Save a new or edited Web page in either of the following ways:
e Saving while editing
e Saving with a different file name
e Saving when closing the Web page

@11_ Saving while editing

If you save a new Web
page in this way, the dialog Click E to save a Web page you are editing with the

box for assigning a file same file name.

name appears. Specify the

D MEN, sl GIEE Saving with a different file name
Save button.

@ Select Save As from the File menu to display the
dialog box for assigning a file name.

@ Specify the file name in File Name, and click the
Save button.

€@ If you inserted any objects, such as images, on the
Web page while editing, the following dialog box
appears:

ination: [C:\mpsite’, Browse.

W Copy Files to the Folder

Cancel Help

@ Confirm the target location, and click the OK button.
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(1)Note ]

If you save a new Web
page in this way, a dialog
box for assigning the file
name appears. Specify the
file name, and click the
Save button.

Saving when closing the Web page

When you close a Web page after having edited it, the
dialog box for confirming whether to save the changes
appears.

@ Click the X] icon in the upper right corner of the
Web page. If there are any changes after you
saved the Web page before, the following dialog
box appears:

To save the
changes, click
the Yes button.

To close the Web To continue

page without editing the page,
saving, click the click the Cancel
No button. button.

@ If you inserted any objects, such as images, on the
Web page while editing it, a dialog box for confirm-
ing the target location appears. Check the target
location, and click the OK button.
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You can open a site and Web page you have already created. First, open the site,
and then open the target page. (You can open the target page without opening the

site.)

(¢) Tips

« “Creating a site” on page
4-4 explains how to create
a site.

« “Creating a Web page” on
page 4-7 explains how to
create a Web page.

OUI———

The names of all sites you
have created are displayed
in the Open Site dialog
box.

OUI———

To open another site, select
Close Site from the Site
menu to close the currently
opened site, and then se-
lect Open Site from the
Site menu to open another
site.

Opening a site

following dialog box:

Open Site

o]

Concel | Hep |

@ Select Open Site from the Site menu to display the

@ Select the target site, and then click the OK button.

The site opens. (The following figure shows an
example of the left side of the main window when a

site opens.)

aub1 htm
+ aub2 htm
3] ub3 him

Files Linked by index him =
Flaral Arranger
Wedding Servi
Qrde orm

Green Flower
wr_il.gif Flower
Flower
Flowers

Flower

Mail lcon
fr.git Green Flower
{Background)

Chapter 4. Basic knowledge

— Link tab

Enables you to view the link
hierarchy from the top page.

File tab

Enables you to view the
subfolders and files stored in the
site folder.

Contents tab
Enables you to insert materials.
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o) Tip ]
.htm and .html

Both “.htm” and “.html” are
extensions affixed to HTML
files. “.html” is used in the
UNIX (Linux) operating
system that most Web
servers install, whereas
“.htm” is often used in the
Windows world to reduce
file name extensions to
three letters. Both have the
same meaning, but note
that some servers permit
only “.html.”

Opening a Web page

You can open an HTML file stored on your computer as
follows. (There are several other methods for opening a
Web page. See the Tip on the end of this section.)

Click the ﬂ icon to display the following dialog box:

pen

SAmysite = = NEE

EiJsub2 him
|Eijsub3 him

T
HTML files (*.html;* htm;* shiml;*.shim) El

@ Specify a Look in and File name, and then click
the Open button. Then the page opens.

der - i

mmmmm

ABC Florist

HTML Source tab

You should edit Web pages on the HTML Source
pane, displayed when you click the HTML Source
tab, only when edit HTML source directly.

Normal tab
The Normal pane, displayed when you click the
Normal tab, is the normal editor of Homepage Builder.
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Automatic correction of
syntax errors

Normally there are no syn-
tax errors (HTML mistakes)
in Web pages edited in
Homepage Builder. How-
ever, if you edit an HTML
source directly, there might
be syntax errors due to en-
try mistakes. Homepage
Builder is designed to cor-
rect syntax errors automati-
cally when a Web page is
opened.

To disable automatic error
correction, open the Option
dialog box by selecting
Options from the Tool
menu, and clear the
Correct HTML Syntax
Errors Automatically

option on the General
panel.

You can open not only a single Web page but also
multiple Web pages.

Other methods for opening a Web page

Here are some other methods for opening a Web page.
They will help you open the target Web pages quickly.

« To open recently edited pages (up to 7 pages), select the
File menu, and then select the target file name on the
pull-down menu.

« If you have opened a site, you can use the right mouse
button to click the target HTML file (*.htm or *.html) in the
Link or File pane, and then select the Edit menu. Or
drag and drop the target HTML file onto the right side of
the main window.
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You can do the tasks explained in this chapter easily by using the Welcome to
WebSphere Homepage Builder dialog box that appears when you start Homepage
Builder.

Either of the following methods displays the Wel-
come to WebSphere Homepage Builder dialog
box.

e Start Homepage Builder. "Starting and
ending Homepage Builder” on page 2-5

e |f Homepage Builder has already started, close
the opened site and Web pages, and then
select Open Opening Dialog from the File
menu. (If any site or Web page is opened, you
cannot select this menu.)

@ Click either of the following three tabs, select a
task, and then click the OK button to begin the task.

e Create a Site tab

Creates a site and a blank
top page simultaneously.

“Creating a site” on
page 4-4

Creates a site and multiple
Web pages simulta-
neously using templates.

Registers Web pages you
previously created as a
site.
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e Open an Existing Site tab

Opens one of sites you have created.

e Edit Without Using the Site tab

ilder

Creates a Web page at
any place regardless of
sites.

Creates a framework of a
Web page or Web site
using templates regard-
less of sites.

Opens the recently edited
HTML files.
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@ Vocabulary

4-16

Using attributes and the right mouse button

Knowledge of attributes and clicking using the right mouse button makes Homepage
Builder operations easy.

element

One of the fundamental
units that compose a Web
page. For example,
paragraphs, horizontal
rules, tables, and images
are elements.

What are attributes?

Each element inserted on a Web page contains
attributes. For example, a table contains such attributes
as width and color, whereas an image contains such
attributes as width and height. Attributes are used mainly
for changing appearance.

When you construct a table, you first create the table
itself and then you change its width or color. When you
insert an image, you first insert the generic image, and
then you change its width or height. Thus, when you
work with elements in Homepage Builder, you first create
or insert elements, and then you change their attributes.

Your method for changing attributes is the same for all
elements. When you think “l want to change something
about this element,” you need to change its attributes as
follows:

@ Click the element using the right mouse button to
display a pop-up menu.

Delete Columin
Delete Table
Shaw Table Frame

Release Link

Edit Image.
Edit Image Map(1]...

ment Froperties...

Extended Attributes..
Atributes
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LI
What is a nested element ?

If an element contains
another element, the one
inside is called a nested
element. For example, if a
table contains an image,
the image is a nested
element.

@ Click the Attributes menu to display the Attribute
dialog box.

€l Check the element name displayed in the Tag list box
on the Attribute dialog box. It might not be the target
element name; it might be a nested element instead.
To display attributes of the target element, select the
target element name from the Tag list box.

Atribute
e | o 4
e |paoe
- D it Properties
fowr_i1.g¥
ermae Text

Height

| ™ Show Border width: |0 3: pivels ‘

Image
T~ Uss Server-Sids Image Map
CSIM Name:

Extended. |

Cancel Help

@ Change the values of the attributes as you like.

@ Click the OK button to make the changes take
effect.

Clicking using the right mouse button

In the preceding description, if you click an element using
the right mouse button, menus other than Attributes
appear. Most applications that run under Windows
enable you to click using the right mouse button to do
various tasks. Homepage Builder enables you to click
using the right mouse button not only on elements but
also on files and folders. If you want to do a certain task
with an element, a file, or a folder, try clicking it using the
right mouse button.
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Chapter

Editing text 5

This chapter explains how to edit text after opening the target
Web page. It also explains how to make easy-to-read Web
pages by using such elements as headings, horizontal rules,
and lists.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
[ J

*x* Enteringtext....................ll 5-2

.
*  Changing the appearance of text....... 5-5
Floral Arrangements

P g S £ v *  Aligningtext.........coooeiiiiiiiiiinnann. 5-8
Flower Basket - - -

e e **% Deleting, moving, or copying text ..... 5-9
One Dozen Tulips 1 H

é? T *  Findingtext..........ccooveniiinininnnnss 5-11
15 plus delivery charge
Order Code: F2

. .

Y S —— % |nserting a heading ..................... 5-13

rder Code: F3

— * Inserting a horizontal rule.............. 5-15
*  Creatingalist...............oeoeeninins 5-17
*  Inserting atextfile ...................... 5-20

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 5-1
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Because originally HTML is a text-based language for the Internet, entering text is the
basic technique for editing a Web page.

@ Related HTML tags

<P></P>
<BR>

(¢)Tip

To delete the preceding
character, press the Back-
space key. To delete the
next character, press the
Delete key.

Entering text

@ Click where you want to start entering text, to
position the cursor there.

Floral Arrangements
|

@ Enter text using the keyboard.

Floral Arrangements

At ABC Flotist, we are proud of our customer service and the quality of our
products. Our top-selling floral atrangements arel

Making a line break

Press the Enter key to make a line break. Aline break is
indicated by d .

(¢)Tip_____________________________
To hide the d marks, select Options from the Tool menu to

display the Option dialog box. Then click the Appearance
tab, and clear the Show Newlines check box.

To make a new paragraph (rather than a line break) when
you press the Enter key, select the Create a Paragraph by
Pressing the Enter Key check box on the General panel of
the Option dialog box.
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OUI——

The @ button in the upper
left of the Special Charac-
ters dialog box is for
nonbreaking space. Using
the Space key on the key-
board, you can enter only
one space. However, by
clicking this nonbreaking
space button multiple times,
you can enter more than
one space.

Note that some special
characters may not be dis-
played on the panes of
Homepage Builder.

Entering special characters

To enter special characters that are not on your key-

board, such as a trademark and copyright symbols:

@ Position the cursor on the location where you want

to insert a special character.

@ Select Special Characters from the Insert menu to
display the following dialog box:

Special Characters

£

=3

e

- | ®

ol o|--

o | | | | [

S I O =2 Pl L 22

ele o | | |es | || 1 |-

v o | | o | 5 | -
el TN 2N I = = P
ot (o | o | % | i | =

e e e et o e | |2 |-

€l Click the character to insert it.

el

Floral Arrangements

At ABC Floist, we are proud of our customer service and the quality of our
products. Out top-selling floral arrangements are

Chapter 5. Editing text
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Inserting the date and time

To insert today's date and time:

Position the cursor on the location where you want
to insert the date and time.

@ Select Date and Time from the Insert menu to
display the following dialog box:

Date and Time

hMonday, May 08, 2000 2:20:15 PM

€@ Select the formats for date and time, and click the
OK button to insert the date and time.

Floral Arrangements

| Monday, May 02, 2000 22015 FM]| |

At ABC Florist, we are prowd of our customer service and the gquality of our
products. Our top-selling floral arrangements are:
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This section explains how to select text (a character string) and change its size, color,

or face. It also explains how to make the text bold, italic, or underlined.

@ Related HTML tags

<FONT SIZE= COLOR=
FACE=></FONT>

<B></B>
<|></I>
<U></U>

fo)Tip

To select the target text with
the keyboard, rather than
the mouse, press and hold
the Shift key and press one
of arrow keys.

Selecting the target text

To select the target text, drag it.

Floral Arrangements

A N=ORalaletyl e ate proud of our customer service and the quality of our
products. Our top-selling floral arrangements are:

Changing the size of text

To change the size of text:
@ Select the target text.

@ Click theﬂicon to enlarge the text, or click the
ﬂ icon to reduce it.

Floral Arrangements

FAFNTORALSSE vwe are proud of our customer service and the quality of our
products. Our top-selling floral arrangements are

Chapter 5. Editing text
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fo)Tie

If the color you want to use
is not available, click the
Others button to select a
color.

fo)Tie

To change the color of text,
you can also use the color

palette. After selecting the

target text, click the =i icon
to display the color palette,
and double-click any color

on the palette.

Changing the color or face of text

To change the color or face of text:
Select the target text.
@ Click the n icon to display the following dialog

box.

Fonts Attributes

€ To change the color of the text, click the

icon to the right of Color, and then click any color

from the pull-down menu.
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(1)Note

The selectable fonts vary,
depending on the computer
you are using.

(I)Note ]

If the font specified here is
not available when some-
one views your Web site
with his or her computer, a
substitute font is used.

(¢)Tip ]

To undo the preceding op-
eration, select the same
text again and click the
same button. The text re-
turns to its original state.

(1)Note

Depending on the fonts in-
stalled on your computer,
you may not be able to
make text bold or italic.

@ To change the face, select a font name in Face.

Fonts Attributes

—
_—|

Mew Century Schoolbook
Times

@ Click the OK button to make the changes effective.
Making text bold, italic, or underlined .

To make text bold, italic, or underlined:
@ Select the target text.
@ Click any of the following three buttons.

( Button Example
ﬂ Makes the text bold.

ﬂ Makes the text italic.

Explanation

Floral Arrangements

Floral Arrangements

Floval Arranzetments

g Underlines the text.
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By default, the entered text is aligned to the left. You can change this default, how-
ever, and align any paragraph to the right or center.

@ Related HTML tags

a
<P ALIGN=></P>

Homepage Builder User’s Guide

Paosition the cursor on the target paragraph.

Click the % icon to center the paragraph, or the
% icon to align it to the right.

Flower Basket«

Five sizes available. o

$10,$15, $20, $25, $30 plus delivery charged
Order Code: F1

Flower Basketd
Five sizes available o

$10, $15, $20, $235, $30 plus delivery charged
Order Code: F1

Flower Basket«

Five sizes available o

$10, $13, $20, $25, 930 plus delivery charged
Order Code: F1

The original text is aligned to the left, like the first
paragraph. You can realign it to the center, like the
second paragraph, or to the right, like the third para-
graph.



You can delete, move, or copy text just as you do with other word processors or text
editors.

OUI——

To delete a blank para-
graph, press the Back-
space key.

(¢ Tip ]

If you cut the text in this
way, the text is temporarily
saved in the clipboard.

Deleting text

To delete unnecessary text:
@ Select the target text.

@ Click theﬂicon. Or press the Delete key to
delete the text.

Moving text

To move text, cut and paste it.
@ Select the target text.
@ Click the # | icon to cut the text.

€@ Position the cursor on the location where you want
to insert the text.

@ Click the E icon to insert the text at the cursor
location.
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(¢)Tip

You can undo the previous
operations.

If you made a mistake, click

the icon. This cancels
the immediately preceding
operation.

You can undo up to 10 pre-
vious operations. To redo
the operation, click the
icon.

Copying text
To copy text to the clipboard and paste it into another
location:
@ Select the target text.
@ Click the icon to copy the text to the clipboard.

€@ Position the cursor on the location where you want
to insert the text.

@ Click the H icon to insert the text in the cursor
location.
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To find specific text in the Web page you are currently editing or in all the Web pages

within the site:

OUI——

To distinguish between up-
per and lower case, select
the Match Case check box.
To search text preceding
the cursor position, select
the Find Backward check
box.

@ Select Find from the Edit menu to display the Find
dialog box.

@ Select the range to be searched from the Search
Scope list box. (If you want to search text in the
Web page you are editing, select In Page. Or if you
want to search text in all the Web pages within a
site, select the site name.)

€@l Enter the text to be searched in the Find What

field.

The following figure is the entry example when
searching for text in the Web page you are editing:

Search Scope: Iln Page -
Find What: ~ [ioral | Clase |

I™ Match Case
™ Find Backward

The following figure is the entry example when
searching for text in all the Web pages within a site:

Find x|
Search Scope: | My Site -
Find What: [fioral =l Close

I~ Match Case
™ Find Backward
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To replace the text with dif-
ferent text, select Replace
from the Edit menu.

9-12
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Click the Find Next button. If you selected In
Page, the searched text is highlighted. If you
selected a site name, a list of the names of HTML
files that contain the searched text is displayed on
the Find Result dialog box. Double-click an HTML
file name to open the Web page and search again
within that page.

The following figure is an example of search results,
when In Page has been selected:

The following figure is an example of search results,
when a site name has been selected:

C:\mysitesub3 him
Coimysitetindzs bim
Cimysitetsubl him




Inserting a heading

You can add headings to help those who visit your Web site for the first time find their
target content easily. This section explains how to insert headings, which are actually
a type of paragraph, and how to change the type of a paragraph.

OUEEETAINEESS | Types of paragraphs

<P></P> When you enter text into the editor of Homepage Builder, a
<H1></H1> paragraph of Normal type is automatically created. You
<H2></H2> can change the paragraph into a heading or other type of
<H3></H3> paragraph. The following types of paragraphs are available.
<H4></H4> p N
<H5></H5> p;ﬁ%ﬁ;;ﬁs Explanation Display example
<H6></H6> Normal This is the normal £ ABC Florist, we ars proud of our

parag raph. If nothing is customner service and the quality of our

<ADDRESS></ADDRESS> SpeCified, thIS type Of Z;:.ducts Our top-selling floral arrangetments
<BLOCKQUOTE></BLOCKQUOTE> paragraph is created.
<PRE></PRE> Heading There are six levels of Floral Arrangements

headings: Heading 1 to
Heading 6 . Heading 1 is
the highest level, and
heading 6 is the lowest.
On a Web browser,
heading text is often
displayed in bold font and
its size typically becomes
bigger as the heading level
increases.

Address This is a paragraph for MNew Fark, 10504, TL5A
entering addresses. On a

Web browser, the text is
often displayed in italics.

Block quote Thisis a paragraph for At ABC Flerist, we are proud of
entel’ing quOted State- our customer service and the
ments. On a Web quality of our products. Our top-

. ing foral —
browser, the paragraph is seling florel axsangements are

often indented.

Text in this format is
displayed with fixed-space
fonts. Youcantypetwoor || . | o | i« | o |
more continuous spaces " "
just as you can when you
are working with Notepad,
one of the Windows
accessory tools.

Preformatted

| 123 | 456 | 78O | 123 |
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fo)Tip

To insert another type of
paragraph, select
Paragraph and then any
paragraph name from the
Insert menu.

(¢ Tip ]

You can select another type
of paragraph, such as
Address or Block Quote
from the list box.

Inserting a heading

To add a new heading:

@ Click where you want to insert a heading. Select
Paragraph and then Heading 1 from the Insert
menu to create a blank paragraph for entering the
heading text.

&1 him - Untitledt ]

@ Enter the heading text.

e ht

‘ IFloral Arrangements I

Making any type of paragraph into a heading

Click the target paragraph and select a heading level
(Heading 1 to Heading 6 ) from the list box on the upper
left of the main window. The paragraph becomes the
selected type of heading.

Heading 1 "I

t arrnal

Heading 2
Heading 3
Heading 4
Heading 5
Heading &
Addressz
Block Quote
Preformatted
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Horizontal rules are frequently used for delimiting text.

@ Inserting a horizontal rule

<HR> @ Position the cursor on the location where you want
to insert a horizontal rule.

@ @ Click thejicon to insert the horizontal rule.

To delete a horizontal rule,
click it and press the Delete
key. Or click it using the
right mouse button, and
select Delete from the
displayed pop-up menu.

At ABC Florist, we are proud of our customer service and the gquality of our products.
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(¢ Tip ]

If you want to change some

attributes for practice, do

the following:

« Select Center as
Alignment .

o Select 85 % as Width .

Changing attributes of a horizontal rule

You can change the attributes of a horizontal rule, such
as its boldness and width as follows:

@ Click the horizontal rule using the right mouse
button, and select Attributes from the pop-up menu
to display the Attribute dialog box.

@ Change any item.

Attribute x|

Harizortal Rule

€l Click the OK button to change the appearance of
the horizontal rule.

At ABC Florist, we are proud of our customer service and the quality of our products
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Lengthy text is difficult to read. Use lists for easy-to-read and good-looking text.

<UL><LI></UL> p N
<OL><LI></OL> List type Explanation Display example
Bulleted | A bullet precedes e Floral Arrangements
list | each listitem. © Flower Basket
o One Dozen Tulips
o Additonal Services
o Potted green plants
o Fruit baskets
Ordered | A number (1, 2, 3, 1. Floral Arrangements
e T T T 1. Flower Baslet
list 1, ii, iii, and so op.) 2 Cne Dozen Tulips
precedes each list | o sdditional Services
item. 1. Potted green plants
2. Fruit baskets
Definition | Each item is Floral Arrangemerts
) ) Flower Baslet, One Dozen Tulips
I|St f0||0wed by Its Additional Services
def|n|t|on Fotted green plants, Frutt baskets

Chapter 5. Editing text
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(¢) Tips ]

To indent (nest) a list item
after entering multiple list
items, position the cursor
on the list item you want to
indent and click the £ |icon.
You can indent items by
one level only. You cannot
indent the first item in the
list.

To remove an indentation,
click the &/ icon.

(¢ Tips ]

To divide a list into two lists,
position the cursor where
the list is to be divided and
press the Enter key twice.

To join two contiguous lists,
press the Delete key
between them.

Bulleted list

Create a field for each list item of the bulleted list, and
then enter any text in it, as follows:

@ Click the = icon to create a field for a list item.

Additional Servicess

@ Type the text for the first item. To go to the next
item, press the Enter key. To make a line break,
press and hold the Shift key and then press the
Enter key.

Additional Servicesa

o Fruit basketd]

Ordered list

Create a field for each list item of the ordered list, and
then enter any text in it, as follows:

@ Click the J icon to create a field for a list item.

Additional Servicesa

i
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@ @ Type the text for the first item. To go to the next

item, press the Enter key. To make a line break,

To change an item number, press and hold the Shift key and then press the
click the target item using Enter key.

the right mouse button, click

the Attributes menu, click Additional Servicesa

the Item tab, and type a

new number for the item in L. Fruit basketd

the Number field.

Definition list

A definition list is a list of items with their definitions.

@ Select List and then Definition List from the Insert
menu to create a field for a list item.

Additional Services«

@ Type the text for the first item, and press the Enter
key to create a field for the definition.

Additional Servicesa

Fruit haskets

€@ Type the text for the definition of the first item. To
go to the next item, press the Enter key. To make a
line break, press and hold the Shift key and then
press the Enter key.

Additional Servicesa

Fruit baskets
oranges, apples, pears, grapefruit, bananas and other fruits of the seasnnl
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Inserting a text file

To insert a text file (*.txt) at the location where you positioned the cursor:

@ @ Select File from the Insert menu to display the

_ _ Open dialog box.
To insert an HTML file

(*-htm or *.html) instead of a @ Select Text files from the Files of type list box,
text file, select HTML files specify the name of the target text file, and click the

from the Files of type list . . . .
% I 7 (€ elsle e Open button to display the following dialog box:

and select Insert an HTML InsertiGik
Document or Insert an  Specify How ta Insert File
HTML Document with ¢ Create One Prefomatted Text Black
Related Files in the Insert
File dlalog box. € Divide the Text into Mormal Paragraphs
" Convert Comma Separated Data to a Table
TO insert a CSV flle (*'CSV) " Convert Tab Separated Data to a Table
as a table, select CSV files B s T B

from the Files of type list
box in the Open dialog box,
and select Convert

1 gt at WML Decurientwith H elated Files

Comma Separated Data | EEl b |
to a Table in the Insert File
dialog box. €@ To insert the content of the text file at the cursor

position, select one of the following insertion
methods, and click the OK button. (Normally, select
Preserve Line Breaks or Divide the Text into
Normal Paragraphs .)

« Create One Preformatted Text Block , making
one paragraph of preformatted text.

« Preserve Line Breaks , leaving the line breaks
in the text file.

» Divide the Text into Normal Paragraphs ,
eliminating line breaks and creating a new
paragraph at a blank line of the inserted text.
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Chapter

(reating tables 6

An attractive layout is possible through the skillful use of
tables. Naturally, you can use tables to arrange data. In Web
pages, you can also use tables to lay out images and text in
absolute positions.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
(S J

(| —e *x* Creating atable.............................. 6-2
*  Changing the size and position of a table........ 6-6
*  Changing the table attributes.............. 6-8
*  Changing the cell attributes ............. 6-12

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 6-1
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Creating a table

You can create a new table, even using spreadsheet software to manage the data.
You can add or delete columns and rows later.

@ Related HTML tags

<TABLE></TABLE>
<TR></TR>
<TD></TD>

O U

To delete an unnecessary
table, click the table using
the right mouse button, and
select Delete Table .

(o) Tip ]

Another way to create a
table is dragging the ﬂ
icon downward diagonally
to the right. A table array
appears, as shown in the
following figure:

The small squares indicate
cells. After dragging to
adjust the number of cells,
release the mouse button to
create a blank table with
the specified array.

Creating a table

To create a blank table and fill it with text:

@ Position the cursor at the location where you want
to create a table, and click the % icon to display
the Insert Table dialog box.

@ Enter the number of rows in the Rows field and the
number of columns in the Columns field:

Insert Table X|

Columrs: |2 _Ij I’E

Cancel
Bows: 2 _Ij @ —I
Help

€@l Click the OK button to create a blank table:

§

@1 Position the cursor in a cell and type the data for
that cell. Move to the next cell and type its data,
and so on:

Five sizes avallable d

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

‘ One Dozen Tulipsd

’7 Flower Baskets

Arrangement in a vase.d
$15 plus delivery charged
Ozrder Code: F2|

e

Homepage Builder User’s Guide



(1)Note ]

When you create a table
from CSV format data, cells
that include numerals only
are automatically aligned to
the right, whereas other
cells are aligned to the left.

Creating a table by inserting spreadsheet data

You can insert a spreadsheet file or spreadsheet data
created by a spreadsheet application into Homepage
Builder in one of the following ways. The spreadsheet

file must be in either the CSV (comma-separated values)

format or the tab-separated format.

e Copy the data in the editor of a spreadsheet

application and paste it into the editor of Homepage
Builder by clicking the target position using the right

mouse button and then clicking Paste.
or:

e |If there is a spreadsheet file in the CSV format or
tab-separated format, select File from the Insert

menu, open the file using the displayed dialog box,

and select Convert Comma Separated Data to a
Table or Convert Tab Separated Data to a Table
on the displayed Insert File dialog box.

Chapter 6. Creating tables
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fo)Tip

You can add a column or
row to the top, bottom, left,
or right of the clicked cell.

(¢)Tip

You can also add a column
to the right of the selected
cell by clicking the & icon.
You can also add a row
under the selected cell by
clicking the & icon.

(¢ Tip ]

To add multiple rows or
columns at a time, select
Specify and Add from the
pop-up menu, enter the
number of rows or columns
to be added in the dialog
box, and then click either
the Above , Below, Left, or
Right button.

Adding a column or row

To add a column or row to the table:

Click a cell.

Flower Basketd
Five sizes available o
$10, $13, $20, $25, 530 plus delivery charged
Order Code: F1

One Dozen Tulips«
5 |Amrangement in a vase.d

$15 plus delivery charged
Order Code: F2 -

Three pansy potsd
L0 plus delivery charged
Order Code: F3

@ To add a column, press the % icon on the Table
toolbar for 2 or more seconds. To add a row, press
the @ icon for 2 or more seconds until the following
pop-up menu appears:

el lE=R NN
Inzert Above the Cel

Inzert Below the Cell
Specify and Add...

€@ To add a column or row, select any menu except
Specify and Add .

Flower Basketd
Five sizes available.d
$10, 515, 20, 525, $30 plus delivery charged
Order Code:F1

One Dozen Tulipsd
o fittangement in a vase.d

$15 plus delivery charged
Order Code: F2|
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PI)Note

When a column or row is
deleted, the content of the
cells is also erased. To
avoid erasing the content of
the cells, select Option
from the Tool menu and
clear the Delete the Table
and the Contents check
box on the General tab of
the Option dialog box.
Then when you delete a
column or row, its content
moves to the preceding
column or row.

Deleting a row or column

To delete an unnecessary column or row:

@ Click any cell that the unnecessary column or row
includes.

@ Click the icon to delete the column. Click the
&l icon to delete the row.
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Changing the size and position of a table

You can specify the table size either in pixels or in percentage. You can also place
the table in the center of the screen for a symmetrical layout.

@ Related HTML tags

<TABLE WIDTH= HEIGHT= >
<CENTER></CENTER>

@ Vocabulary

pixel

A small square colored dot
that is frequently used as a
unit defining the display
resolution or the image
size. In HTML, a pixel is a
unit defining the size of
each element.

(o) Tip ]

To change the size of a
certain cell, click the target
cell and drag one of the
eight black square marks
around it.

Specifying the table size in pixels

To specifying the table size in pixels, just drag the table.

@ Click outside the table border to select the entire
table.

Flower Basketd
Five sizes available. o

$10, 515, $20, $25, 530 plus delivery charged
Order Code: F1

One Dozen Tulipsd
"3 |Atrangement in & vase. m

$15 phus delivery charged
Order Code: F2

Three pansy pots+
$10 phas delivery charges
Order Code: F3

I

@ Drag one of the eight black square marks on the
perimeter of the table to change the table size.
When you release the mouse button, the new size
is defined.

[Flower Basketd

Five sizes available o
$10, $135, $20, $235, $30
iplus delivery charged
(Order Code: F1

One Dozen
Tulips«
\Atrangement in a vase.d"
$15 plus delivery
charged

Order Code: F2

3

‘Three pansy pots+
3 (310 plus delivery
charged

(Order Code: F3
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Specifying the table size in percentages

If you do not want to define the absolute table size—for
example, because you want to change the table size
according to the screen size of a Web browser—specify
the size in percentages (%).

@ Click the table using the right mouse button and
select Attributes from the pop-up menu to display
the Attribute dialog box.

@ Click the Table tab.

€@ Type a percentage (0 to 100) in the left box of Table
Width , then select % in the right box.

@ Click the OK button to change the table size.

Placing a table in the center

To place the table in the center of the screen for a
symmetrical layout:

@ Click outside the table border to select the entire
table.

@ Click the % icon to place the table in the center.

Flower Basketd

Five sizes available o
$10, $15, $20, $25, $30
plus delivery charged
Order Code: F1

One Dozen
Tulipsd

" 2 |Artangement in avase.d’
$15 plus delivery
charged

Order Code: F2

Three pansy pots+
510 plus delivery

5

charged
Order Code: F3
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After creating a table, you can change its appearance by changing the attributes of
the entire table. For example, you can:

6-8

@ Related HTML tags

<TABLE CELLPADDING=
BORDER= BGCOLOR=

Add color to the table.
Hide the table borders.
Add a title to the table.
Increase the cell padding.

Paste wallpaper into the background of the table.

BACKGROUND= > a

<CAPTION ALIGN= >

Homepage Builder User’s Guide

Click the target table using the right mouse button,
and select Attributes from the pop-up menu to
display the Attribute dialog box.

Click the Table tab. Using the Table panel dis-
played, you can change an attribute for the entire
table.

Attribute

Tag: ITahIe j
{TabEY Row | cet |

— Lavout
Alighment: [Bwito) -

Text Flow: I~ Left ™ Right

Tatewidhi [ = [oeels 7]

Tatle Height: [~ =] m

Cell Spacing: l? pixels

Cell Padding: _,j ik Q

@—-’7 Show Border : |1 3 pirels

Caption
’7(3‘ Mone {7 Topofthe Table ¢ Bottom of the Table |

® Lo )
— Background

LCaolor: - Il _.i Q
Image: Browse, II |
Extended... | e

(1] I Cancel | Help |




O Increasing the cell padding

Specify the size of the white space between borders and
content in Cell Padding . If nothing is specified, the
default is 1. (The following figure is an example of the
changed appearance.)

Flower Basketd

1 Five sizes available o

$10, $135, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd
2 Atrangement it a vase o

$15 plus delivery charged
Order Code: F2

Three pansy pots«
3 | $10plus delivery charged
Order Code: F3

(@ Hiding the table borders a

If you use a table for layout, you might want to hide its
borders. To do so, clear the Show Border check box.
Though borders become dotted lines in the editor of
Homepage Builder, they are hidden in the screen of Web
browsers. (The following figure is an example of the
changed appearance.)

_____________________________

:: ::Flowcr Basket+ I
1) Five sizes available d

rsI0, $15, $20, $25, $30 plus delivery cha.rgeﬂ
" IOrder Code: Fl1 "

:: ::Onc Dozen Tulipsd "
Vi datrangement in a vage.d n
e 1815 plus delivery charged "
,. | Order Code: F2 "

e R ] 1

" 1 Three pansy pots+ I

-IBI :‘310 plus delivery charged '
' |Order Code: F3 i
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@ Adding a title to a table

To add a title to a table, select Top of the Table or
Bottom of the Table in the Attribute dialog box. After
clicking the OK button, enter any title in the blank field
displayed. (The following figure is an example of the
changed appearance.)

Five sizes avalable o
$10, $15, $20, $23, $30 plus delivery charge

Flower Basket«
Order Code: F1

(@ Adding color to a table

To add color to the entire table, click the colored button to
the right of Color in the Attribute dialog box and select
any color from the pop-up menu displayed. (The
following figure is an example of the changed
appearance.)

Flower Basketd
Five sizes available o
$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

Atrangement it a vase. o
$15 plus delivery charged
Order Code: F2

[

Three pansy potsd
$10 plus delivery charged
Osder Code: F3

[
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Sample wallpapers exist in
the

/opt/hpbuilder4/system
/hpbuilder4/sample/image
/wallppr directory.

@ Pasting wallpaper into the background of a table

Click the Browse button in the Attribute dialog box to
select and paste a wallpaper image as the background
for the table. (The following figure is an example of the
changed appearance.)

Flower Basketd

Five sizes available o

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

Arrangement it a vase. o
$15 plus delivery charged
Order Code: F2

Three pansy pots4d
$10 plus delivery charged
Order Code: F3

[

€@ Click the OK button to make the changes take
effect.

Chapter 6. Creating tables
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After creating a table, you can change its appearance by changing the attributes of
individual cells. For example, you can:

e Change a data cell into a header cell.

e Align text in a cell to the right.
Merge cells horizontally or vertically.

e Add color to a cell.
If you want to change the attributes of multiple cells at a time, select multiple cells
before the following operation.

@ Click the target cell using the right mouse button

and select Attributes from the pop-up menu to

<TD ALIGN= COLSPAN= display the Attribute dialog box.
ROWSPAN= BGCOLOR= >
<TH></TH> @ Click the Cell tab. Using the Cell panel displayed,
you can change the attribute for the selected cell.
Attribute
Tag  [Tatle =l

Table | Row {EE1 7]

Cell Typ
e_‘:(‘ Header Cell & Data Cell ‘

— Layout
Horizontal Alignment: | [Auta] —t e

Wertical Alighment: [ata) -

Cell Width; 3: Iplxels hd
Cell Height [ = ek

V¥ wrap Lines Automatically

Join Cell
0 ’VQU\umns. | 3: E Bows: I | 3: E ‘
 Background

Color, ! II ;!

e [E= ]
™ Apply ta the Entire Calurn Extended. |
Ok I Cancel | Help |

@0
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You can also join cells
horizontally by clicking the
left cell to be joined, and
then clicking the | icon.

@ Changing a data cell into a header cell

There are two types of cells: data cells and header cells.
Cells are ordinarily data cells. Header cells are typically

bold and displayed in the center. Select Header Cell to

change a data cell to a header cell. (The following figure
is an example of the changed appearance.)

_}
Floral Aﬂangements“

Flower
1 Five sizes
$10, $15, %
Order Ct

One D¢

@ Aligning text in a cell to the right

If you want to align text (usually numbers) to the right,

select Right from the Horizontal Alignment  box. (The

following figure is an example of the changed a
appearance.)

Floral Arrangements

Flower
o | Wive sizes
$10, 15,4
Order Ct

One D¢

@ Joining cells horizontally

To join cells horizontally, type 2 or a higher number (for
the number of cells to be joined) in Columns under Join
Cells in the Attribute dialog box for the cells to be joined
in a rightward direction from the selected cell. To cancel
the joining, delete the number in Columns . (The follow-
ing figure is an example of the changed appearance.)

=
Floral Arrangements| |

Flower Basketd

Five sizes available d

$10, $15, $20, $25, §30 plus delivery charge d
Order Code: F1

One Dozen Tulipsd
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O

You can also join cells
vertically by clicking the top
cell to be joined, and then
clicking the &/ icon.

O

Another way to change the
cell color is to select a cell
or cells, click the & icon to
display the color palette,
and then double-click on
any color on the palette.

O

To change the attributes for
the entire row that include
the selected cell, click the
Row tab and specify each
item.

@ Joining cells vertically

To join cells vertically, type 2 or a higher number (for the
number of cells to be joined) in Rows under Join Cells

in the Attribute dialog box for the cells to be joined in a
downward direction from the selected cell. To cancel the
joining, delete the number in Rows. (The following figure
is an example of the changed appearance.)

Floral Arrangements
e m

Flower Basketd

Five sizes available o

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

w123 M prangement in a vase.d
$15 plus delivery charged
Order Code: F2

Three pansy potsd
$10 plus delivery charged
Order Code: F3

3 Adding color to a cell

To add color to the selected cell, click the colored button
to the right of Color in the Attribute dialog box, and
select any color from the pop-up menu displayed. (The
following figure is an example of the changed

appearance.)
_ |
Flower Basketd T
! d
Order Code: F1

" =
Five sizes available o
|—|One Dozen Tulipse

I Floral Arrangements
$10, 135, $20, $25, $30 plus delivery charge

€@ Select the Apply to the Entire Column  check box
to change the attributes to all the cells in the same
column.

@ Click the OK button to make the changes take
effect.
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. . Chapter
Insertmg images 7

For your Web pages, you will use image files in the JPEG or
GIF format. The JPEG format image permits the use of colors
more than the GIF format image, so it is suitable for
photographic data.

This chapter explains how to insert images into a Web page,
how to change the image attributes, how to edit an image, and
S0 on.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

2. Open a Web page to be edited.
“Opening a site and a Web page” on page 4-11

o J
, — *x* Inserting an image .............................. 1-2
LA AL A *  Changing the size of the displayed image ...7-4
ww:—sm}::::im *x Deleting, moving, or copying an image ..... 7-5
: *  Laying out text around an image.............. 7-7
*x Adding an explanation to an image ........ 7-11
*  Editinganimage .............coceiiieinnnnns 7-13

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 7-1
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The insertion of an image is the first step in handling images in Homepage Builder.

@ Related HTML tags

<IMG SRC= >

(¢ Tip ]

You can insert an image file
of a format other than GIF
or JPEG into the edit field
of Homepage Builder. The
file is automatically con-
verted to the GIF or JPEG
format image file.

Appendix C, “Image file
formats”

(1)Note ]
When the Eg mark
appears

This mark appears if an
image is not inserted cor-
rectly. Check the file name
or folder.

O

While you are dragging the
image on the edit field, the
cursor that indicates the
inserting point is displayed.
When you drop an image, it
is inserted at the cursor
position.

Inserting an image with a drag-and-drop operation

You can view all the images in a certain folder to select
the target image before inserting it with a drag-and-drop

operation.

@ Click the Contents tab to open the Contents pane.

@ Select the target folder in the upper side of the
Contents pane to view the image files in it.

Imae Fles ¢ i jod; prcy; bmps wf; emf; 4if, 2]

flask_tp.gif

L.

flawr_i2.oif

L@

flowr i1 gif

flowr_i3.if

To select materials attached to
Homepage Builder quickly, select
Image in the top box of the Contents
pane.

@ Click the target image, drag it, and drop it into the
Normal pane of the Web page you are editing.
The image is inserted into the position where it was

dropped.

Floral Arrangements

Flower Basketd
Five sizes available. o

(B0, $15,%20, $25, $30 plus delivery

charged
Order Code: F1

One Dozen Tulipsd
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Inserting an image by specifying a file name

If you know the file name of the target image, this method
might be easier.

@ Position the cursor at the location where you want
to insert an image.

@ Click the al| icon to display the Open dialog box.

€l Select the target image file, and click the Open
button to insert the image.

Efoma_tror &l X
B} Eijoerve_bign  [Eijoerde_idg  Eoreen_b
w2t Eilare_begt  [Elgarde_migit  Sjoreen_b
Eiffowr_is.git e_bd. n_b
[Eiffarma_b1.gi
Eiforma_it gi

|Eifnask_migit  [gEjforma,_i

fovis | [ o |
R [
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Changing the size of the displayed image

After inserting an image, you can change its displayed size.

(1)Note

This task changes only the
appearance of the image; it
does not change the actual
image size.

“Editing an image” on
page 7-13

@ Related HTML tags

<IMG SRC= WIDTH= HEIGHT= >

(1)Note

If you drag one of the black
square marks in the four
corners, the vertical-
horizontal ratio of the image
does not change. However,
if you drag one of the black
square marks not on the
corners, the ratio changes.

(o) Tip ]

To return the image to its
original size, click it using
the right mouse button,
select Attributes from the
pop-up menu to display the
Attribute dialog box, click
the Set Size button, and
click the OK button.

To clear the specification of
the image size, click Clear
in the Attribute dialog box.

@ Click anywhere on the target image to select it.

Floral Arrangements

Flower Basketd
Five sizes available o
510, $15, $20, $25, $30 pl
charged

Order Code: F1

| [Mna Taran Taline

@ Drag one of eight black square marks around the
image to change its displayed size. When you
release the mouse button, the size is determined.

- Floral Arrangements

Flower Basketd
Five sizes available o
410, $15, $20, $25, $304
delivery charged
Order Code: F1

One Dozen Toho
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This section explains how to delete an unnecessary image, how to move an image to
another position, and how to copy an image or to paste the same image repeatedly.

Deleting an image

To delete an unnecessary image, click it using the right
mouse button, and select Delete from the pop-up menu.

Moving an image

To move an image:
@ Click the target image to select it.

@ Click the center (any part other than eight black
square marks) of the image.

€@ Drag the image. When you release the mouse
button, the new position is fixed.

Chapter 7. Inserting images
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Copying an image

To copy an image or to paste the same image
repeatedly:

@ Click the target image to select it.

@ Click the center (any part other than eight black
square marks) of the image.

€@ Press and hold the Ctrl key and drop the image.
When you release the mouse button to paste the
dragged image, the image is copied in the new
position. Keep holding the Ctrl key and click for
each copy you want.

F10 plus deltvery charged
Order Code: F3
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Ordinarily, you can lay out only a single line of text beside an image. However, you
can change this setting and lay out several lines of text beside an image to make it
into a natural layout. Then you should probably increase the spacing of the image to

improve its appearance.

@ Related HTML tags

<IMG SRC= ALIGN= >

Typing text beside an image

When you type text beside an image, you see that only a
single line of text is laid out beside the image. The other
lines are below the image.

é“ For Vour Dream Weddingd

We specialize in wedding services. Our designers and bridal
consultants will make wour special day a beauwtifisl and
metmorable expetience.

Flowing text around an image

To flow text to the left or right of an image:

@ Click the target image using the right mouse button,
and select Attributes from the pop-up menu to
display the Attribute dialog box.

Chapter 7. Inserting images 1-7
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@ Select the Left or Right check box next to Text,
and click the OK button.

Attribute

If you selected the Left check box, text flows on the
right side of the image.

| For Your Dream Weddingd

B " fife spectalize in wedding services. Our designers and
W pridal consultants will make your special day a heautiful
Bnd memarable experience.

If you selected the Right check box, text flows on
the left side of the image.

For Your Dream Weddings

We specialize in wedding services. Cur designers and
bridal consultants will make wour special day a beautifal
and memorable expetience.
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You can also flow text be-
tween two images. In this
case, to end text flow in the
middle of the text, select
Move Vertically Down

Until Both Margins Are
Clear on the Line Break
dialog box.

€@ To end text flow in the middle of the text, press and
hold the Ctrl key and press the Enter key at the
point where you want to end the flow.

@ If you selected the Left check box, select Move
Vertically Down to a Clear Left Margin  on the
Line Break dialog box. If you selected the Right
check box, select Move Vertically Down to a
Clear Right Margin .

Line Break

@ Press the OK button. The text flow ends at the
point you specified.

@F ot Vour Dream Weddingd
3

dJ

We specialize in wedding services. Our designers and bridal
consultants will makce wour special day a beautiful and memorable
expetience.
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Increasing space around an image

Adding the suitable space around the image gives it a
neat appearance.

@ Click the target image using the right mouse button
and select Attributes from the pop-up menu to
display the Attribute dialog box.

@ Type the number of pixels in the fields beside
Horizontal and Vertical of Spacing . (Horizontal
means to the left and right of an image and vertical
means to the top and bottom of an image). The
larger the numerical value, the greater the spacing.

€@ Click the OK button to increase the space around
the image.

ot Vout Dream Weddingd
e specialize in wedding
zervices. Cur designers and bridal
onzultants will make your
epecial day a beautifl and
retnorable expetience.
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Adding an explanation to an image

Inserting images beautifies your Web pages, but the images cannot be displayed by
visitors to your Web site who are not set up to display GIF or JPEG images. An
explanation added to an image enables those who cannot view it to understand its
content. Itis good etiquette to add an explanation to each of your images.

OLEEETLINEEENED | Adding an explanation to each image

<IMG SRC=ALT= > There is no limit to the number of characters you can use

for the explanation, which is called alternate text.

@ @ Click the target image using the right mouse button,

and select Attributes from the pop-up menu to

ImiEg)e ElEnaliens ez display the Attribute dialog box.

needed in instances such

2 @ Enter the explanation for the image in Alternate

« If a Web browser that Text and click the OK button. (The appearance of
AloiEs Ml eIl i the image does not change, but an explanation of

iewing of i [ d. . .
wewmg © .|mages.|s Hse the image is added to the HTML source.)
« If reading images is not

set, to speed up the line.

« If a visually handicapped

nerson is visiting your site. Checking that explanations are added to all images

To check whether the explanations for all the images
used on the Web page being edited have been entered
correctly:

@ Select URL Editor from the Tool menu to open the
URL Editor, which checks alternate text added to
your images and links.

@ Click the Image button to display all the images
used on the Web page being edited. The alternate
text for each image is displayed in Text. If there is
an image with no alternate text, the message ** No
Alternate Text **' is displayed in Text.

€@ Click an image with no alternate text. The file name
of the image appears in the URL field.
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(1)Note ]

Remember to add alternate
text to images with links,
because Web browsers that
do not display images
enable readers to jump
using the alternate text.

To check the alternate text
only for linked images,
select the Linked Image
button instead of the Image
button in the URL Editor.

“Setting a link on an
image” on page 8-8

@ Type the explanation of the image in a field beside
Alternate Text .

URL Editar - Cumnysiterflowr_i3 gif

Tlowr_iT qif floral basket
flowr_iz.gif tulips
Tower_idgif " Mo Afternate Tewt ™

@ Click the Update button to update the information.
Click the OK button to close the URL Editor.
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Editing an image

While editing a Web page, you can resize images and do simple retouching, which is

called editing.

(1)Note ]

If you resize an image
through editing, not only
does the appearance
change, but the actual
image file changes, too.
Therefore, before resizing,
copy the target image file if
necessary.

(¢)Tip ]
To create new images, use

WebArt Designer.

Chapter 10, “Creating
materials”

Here editing includes any of the following:
e Converting an image file from GIF to JPEG format,
or from JPEG to GIF

e Trimming an image

e Rotating an image

e Reducing the size of an image file to match it to the
display size

e Adjusting the image quality or reducing the number
of colors

e Making an image display progressively from a lower
resolution to a higher resolution

e For the GIF format image only, changing one of
colors used in the image into transparency, to blend
the image into the background

e For the JPEG format image only, adding special
effects such as sharpening the image or adding
sepia color

@ Click the target image using the right mouse button
and select Edit Image from the pop-up menu to
display the following dialog box:

i Edit Image

Effect WPEG aniy)
Undo
i~ Save Options

¥ Save as GIF Fomat

~ Save as JPEG
Format
Save as Size

M it

0K | Cancel Help | [} Detai Settings
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@ Click the Help button to display the online help.

€@ Read the online help and edit the image.
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Chapter

Setting links g

Using the link function, a visitor to your site can jump to a
specific Web page simply by clicking text or an image with a
link. This chapter explains how to set a link to text or an
image, how to change a link destination, and so on.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
(S J

— %% Sefting a linkontext............... 8-2
*  Setting a link on an image ........ 8-8
*  Changing a link destination....... 8-9
*  Checking the link status .......... 8-10

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 8-1
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Setting a link on text

There are four types of links according to the link destination. A link might enable you

to jump to:

e Another Web page at your site

e Another place on the same Web page

e Another Web page on the Internet

e A file other than HTML such as an image file, sound file, program file, and so on
This section explains how to set each type of link in the selected text.

@ Related HTML tags

<A HREF= NAME= ></A>

Setting a link to another Web page at your site

You can set a link to another page, for example, to jump
from the top page to any of the subpages of your site.

@ Select the text that you want to link from.

Floral Arrangements

@ Click the @ icon to display the Attribute dialog box
for a link.

@ Click the To File tab.

@ Click the Browse button, select an HTML file as the
link destination in the displayed dialog box, and
click the Open button to specify the selected file
name in the File Name box.

Attribute
Tag IL\nk j
TaFiie | To URL | ToLabel| E-Mai | AddLabel| ToUnsaved L4 | ¥
 File Name
Jsubt b
Browse. .
i Tanget
Extended..
oK I Cancel Help
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To make a Web page dis-
played in the edit field the
link destination, drag the
icon beside the Normal
tab of the destination Web
page and drop it onto an-
other Web page (to include
the link source). The title of
the link destination Web
page is set as the link
source text.

@ Check the specified HTML file name (*.htm or

*.html), and click the OK button to set a link to the

selected text.

Floral Arrangements

Chapter 8. Setting links
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Setting a link to another place on the same
Web page

You can add a label to a specific text on a Web page and
make it the link destination. This method is useful if you
want to place a summary of the Web page at the begin-
ning of the page and then enable a visitor to jump to a
lower part of the page.

@ Select text for the link destination.

The ABC Flotist offers online ordeting of bouguets,
attahgements, baskets, and centerpieces.

Floral Arrangements

@ Click the icon to display the Attribute dialog box
for a link.

€@ Click the Add Label tab, and type a label name.

Attribute
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@ Click the OK button to assign the label to the
selected text. A dotted underline is added to the
labeled text.

The ABC Florist offers online ordeting of boucguets,
arrangements, baskets, and centerpieces.

@ Select text for the link source.

[Floral Arrangements

The ABC Florist offers online ordeting of bouguets,
arrangements, baskets, and centerpieces.

@ Click the icon again to display the Attribute
dialog box for a link.

Click the To Label tab, and select the previously
specified label name from the Label list box.

Attribute
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OL

To set a link to specific text
on another Web page at the
same site, click the Browse
button on the To Label tab,
select the link destination
file, and select the label
name.

@ Click the OK button to set a link to the labeled text.

Floral Arrangements

The ABC Florist offers online ordering of bouguets,
atrangements, baskets, and centerpieces.

Setting a link to another Web page on the Internet

Here, the term “Web page on the Internet” means a URL
beginning with “http: " or “ftp:”.

Select text for the link source and click the icon
to display the Attribute dialog box for a link.

@ Click the To URL tab.

€@ Select http: or ftp:, and then enter the target URL.

Attribute

@ Click the OK button to set the link.
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Setting a link to a file other than an HTML file

To set a link to a non-HTML file such as an image file, a
sound file, or a program file, type the destination file
name on the To File tab in the same way as described in
“Setting a link to another Web page at your site” on page
8-2. If you set a link to a program file, the program can
be downloaded when the link source is clicked on a Web
browser.
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The previous “Setting a link on text” section explains how to set a link on text. You
can set a link on an image in the same way. Then a visitor to your Web site can jump
to the link destination by clicking the image.

@ Related HTML tags

<A HREF= NAME= ></A>

@ Click the image that you want to link from.

[Floral Arrangernents

@ Click the icon to display the Attribute dialog box
for a link.

Attribute

—

—

—

|| T

@ Set the link destination as described in the “Setting
a link on text” section on page 8-2.
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Changing a link destination

After you have set a link, you can use the URL box on the toolbar to change a link
destination or to cancel the link.

o) Tip_______]
To change a link destination
using the Attribute dialog
box that you used for set-
ting a new link, click the
link-source text or image
using the right mouse but-
ton, and select Attributes
from the pop-up menu. Se-
lect Link from the Tag list
box to display the link at-
tributes including a link des-
tination.

O
The URL box is not only for
changing or canceling link
destinations, but also for
setting new links. To use
the URL box to set a new
link, select the link-source
text or image, and enter the
link destination directly into
the URL box.

LI
Another way of canceling a
link is to click the link-
source text or image, and
either clear the URL box on
the toolbar or select Re-
lease Link from the Edit
menu.

Changing a link destination

To change a link destination:

@ Click the link-source text or image to display the link
destination in the URL box on the toolbar.

URL: [sub i

=] Tager | =

@ Delete the old link destination and type the new
one.

URL: [sub htm

=l Tog | |

€@ Press the Enter key to set the new link destination.

Canceling a link

To cancel a link, click the link-source text or image using
the right mouse button, and select Release Link from the
pop-up menu.
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You can use the Link tab of the Site Manager to check that the links for each page
are correctly set. If you find a mistake, you can open the page and correct it.

8-10
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Click the Link tab of the Site Manager. Then in the
upper half of the Link pane, check the hierarchical
link structure with the top page as the apex.

Click the target page to display a list of link destina-
tions. The [3 mark indicates that there is a file for
the link destination. The @ mark indicates that
there is no file (the link is incorrectly set), so open
the corresponding page and correct it.

ere Homepage Builder

ked by index htm

k3] subt.htm

[B)3ubz htm

[3)5ub3.hitm Order Form
Emailto:

[Hgarde_hr.git Green Flower g
[Bynowr_i1.gif Flower
Eynowr_iz.gif Flawer

B garde_t.gif Flowers

By nowr_iz.gif Flower
Hygarde_ml.gif Mail lcon

[#garde_fr.gif Green Flower 3
[#garde_byg.gif (Background)




The following marks might be displayed in the Link pane.

] )
Mark Meaning

Indicates a link to an HTML file.

Indicates a link to a frame page.

Indicates a link to a label.

Indicates a label.

Indicates an image.

Indicates a client side image map.

Indicates a link from an image map.

Indicates a link to a page on a Web server.

Indicates a Java applet.

Indicates plug-in object.

Indicates a link containing an e-mail address.

Indicates a link to an FTP server.

Indicates a link to a CGI program.

Indicates a link to a CSS file.

= ¢ F B Eeé e P FE B E BB E

-
.
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Designing Web pa Chapter
using style sheets 9

A style sheet is a very recent technology that is likely to
become essential for Web page creation. You can use it to
design your Web pages.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

*xx What is a style sheet? .......................... 9-2
e sheet! *  Using templates .........oooevveeeereeeeeeeaenns 9-5
Style Sheet 2 *x* Advanced style-sheet techniques ............. 9-7

Style Sheet 4

Style Sheet 5
SList-1
SList-2
SList-3

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 9-1



9-2

What is a style sheet?

Homepage Builder supports CSS (Cascading Style Sheet), now the standard style
sheet. A style sheet makes it easy for you to change the appearance of your Web

pages at will and to unify the appearance of the entire site. Appendix D, “Cascad-
ing style sheets”

Valuable technology for Web designers

Style sheets are useful technology for those who design
Web pages, because style sheets make it possible for
you to achieve elaborate designs like those in magazines
right on your Web pages. See the following two figures.
Though they use the same HTML file, one uses style
sheet and the other does not.

A Web page that does not use style sheet:

Title On this Web page, HTML describes

the document structure as follows:

® Displaying “Title” in the heading

Style Sheet 2 paragraph.

® Displaying “Style Sheet 1,” “Style
Sheet 2,” and so on, in other

Style Sheet 1

Style Sheet 3

Style Sheet 4 paragraphs'

Style Sheet 5 ® Adding the items “List-1,” “List-2,"
Lt and “List-3" in a bulleted list.
o List-2
o List-3

A Web page that uses style sheet:

This Web page uses the same HTML
Style Sheet 1 as the preceding page, but is

designed as follows using style
Sty1€ Sheet 2 sheets:

Style sheet 3| ® Adding color to the background of
the heading paragraph.
S'I'yle Sheet 4 ® Specifying the position of each

Style Sheet 5 paragraph with absolute coordi-
i1 nates.
SList-2 B .
s ® Using notes as bullets of a list.
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Essential technology in the future?

It is still possible to design Web pages in HTML without
the use of style sheets. However, it is likely that in the
future, the HTML tags that control the appearance will be
abolished and that only style sheets will control the
appearance of Web pages. Thus, style sheet technology
is likely to be essential for anyone who creates Web
pages.

The advantages of style sheets are the following:

e Because the document structure which is repre-
sented by HTML and the design which is repre-
sented by a style sheet are separate, you can
change just the document structure or just the
design.

e You can unify the design of the entire site.

You do not have to sacrifice the HTML for the sake
of the design.

The last point is important. Tables are often used for
layout, but because the actual purpose of a table is to
present comparative data precisely and concisely, using
a table for merely a layout design is an inappropriate use
of HTML. The size and thickness of text is also often
changed with the FONT tag when headings should have
been used, which is another inappropriate use of HTML.
With a style sheet, however, you can lay out text, graph-
ics, and images in the positions you prefer without using
tables, and you can freely change the designs of head-
ings. With a style sheet, you can enhance design while
using HTML correctly.

Chapter 9. Designing Web pages using style sheets
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Flow of Web page creation using a style sheet

Despite the promise of style sheets for the future, only a
few Web browsers can currently display them. Be aware
of the following:
e Even using compatible Web browsers, sometimes
you cannot display style sheets correctly.
e The same style sheet might appear differently
depending on the Web browser used.

We thus recommend that you create Web pages that can
be displayed correctly even without the use of a style
sheet, according to the following flow.

@ Create your Web pages without using a style sheet.
@ Change the appearance using a style sheet.

€@ Check the appearance of your Web pages both on
a style-sheet-compatible Web browser and on a
noncompatible Web browser.
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Homepage Builder offers Web page templates that use style sheets. If this is the first
time for you to use a style sheet, it is recommended that you choose a template and

adapt it.

@ Select New from the File menu to display the New
dialog box.

New

Page | Frame Appication | Muliple Pages |

Click the Application tab to display the Applica-
tion panel, which contains Web page templates
using the latest technology. Templates whose
names begin with <S> use style sheet technology,
and those whose names begin with <D> use dy-
namic HTML technology.

Select one that begins with <S>, and click the OK
button.

<D>Basketball a
<D Curmy

<0 Dolphin Y orld
<D>Honeybee Garden

<D»0val Racing

<D>Pizza House

<D»Plane

<D>Roll Scieen

<D»Satelite

que
< ogue (Blug]
<5»Catalogue [Pink|
<5>Film Library
<5>Flawer [Green]
«5>Flower [Pink]

<5 Laptop Computer |

Style sheet: You can easily create
thig graphical header, using
"barder attribute of style sheet

Ok I Cancel

Help

Chapter 9. Designing Web pages using style sheets
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The corresponding Web page opens in the editor.

97
SN

< \\I

! Bluw Diamond Ring#l
1 vfulticolor Jade Bracelstel

@ At first glance, you might not be able to clearly

distinguish whether a style is defined in the opened
page. If you wish to confirm, click the HTML
Source tab and look at the description between
<STYLE> and </STYLE> at the top of the HTML
source, which defines the style.

page Suilder VA.0.0 for Linux'>

t-size: 32pt; font-weight: bold; color: whil

=:///D: /hpbuilderd/tenplate/data/.

Click the Normal tab again, and edit the Web page,
just as you would any other Web page.



Advanced style-sheet techniques

If you are acquainted with the concepts of HTML tags and style sheets, you can
design your Web pages more freely by using classes and IDs; by embedding styles
directly into each tag; or by using an external style file. This section introduces an
example that use classes to change the color of a paragraph and the color of text in
the paragraph.

@ Vocabulary @ Click the g icon to create a new Web page.

class @ Type any text.
A definition of Web page Use style sheets.
style. You can assign one

class to multiple HTML

tags, so you do not have to €@ Click anywhere on the text using the right mouse

define the same style sev- button, and select Extended Attributes from the

eral Tlmes. _Y0Lt1hcan, for ex- pop-up menu to display the “Extended Attributes”

ample, assign the same :

class both to a table and to dialog box.

2 @ Type “color” in the Class field, and click the Edit (2)
button to display the dialog box for setting the style.

| D Style Definition

A definition of Web page e ——

style. You can embed one [ [

ID to only one HTML tag, so [ e =

you must define the same e Fort Atile

style several times. Be- e L L :

cause you can use classes - S I I

for more general purpose | Iy 104

than IDs, it is recommended { haBlyzz O

that you use classes rather -

than IDs. [ ok | concel | Hep |

LI
You can type any text you
like in the Class field.
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@ @ Click the Color and Background

the text color from the Color list box and the para-

Using the Style Definition
dialog box, you can define
such styles as fonts, lay-
outs, and colors. Define
them as you like.

9-8 Homepage Builder User’s Guide

tab and select

graph color from the Background Color list box.

Attributes dialog box.

text colors.

[Jse style sheets

@ Click the OK button to return to the Extended

Click the OK button to change the paragraph and



@ Click the m icon to display the Style Sheet Man-
ager, which enables you to view all the styles
defined for the Web page being edited. In the
following example, a class named “color” is defined.

Style List{current t document t]
MET

A
colar : white
backaround color : black.

€l Click Show current style status  to view the style
for each HTML tag in the Web page being edited.

et Style Status

Ad
color : white
backaround color : black,

Chapter 9. Designing Web pages using style sheets 9-9
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(reating materials

Use WebArt Designer, a Homepage Builder image-processing
accessory tool, to create three types of images: logos, buttons,
and photo frames. Use the Web Animator accessory tool to
create animation in the animated GIF image format.

Before doing the tasks in this chapter

1. Start WebArt Designer.

“Starting and ending WebArt Designer” on page
10-2

Chapter

10

*x* Starting and ending WebArt Designer...... 10-2
**x Using sample materials
*% (Creating a lettered button
*% Decorating a photo with a frame
*% (Creating an animated GIF

10-1



The WebArt Designer tool enables you to readily create three types of images: logos,
buttons, and photo frames. Moreover, by combining them with the images you have,
you can create images full of variety.

- :
(o) TiP Starting WebArt Designer
The type of materials cre-
ated by WebArt Designer To start WebArt Designer, type the following command,
are “images.” You can and press Enter:
paste them into your Web
pages, just as you do other
images. $ hpbuilder -c
“Inserting an image” on P
page 7-2
WebArt Designer’s main window appears:
Homepage Builder User’s Guide
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Ending WebArt Designer

To end WebArt Designer, select Exit from the File menu.
If you have changed anything on the open image, a

message prompts you whether you want to save the
image.

To save the To exit without ~ To cancel the exit and

changes, click  saving, click continue using WebArt

the Yes button. the No button.  Designer, click the
Cancel button.

Chapter 10. Creating materials 10-3
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The simplest way to create your own materials is to select one of sample materials
that is suitable for your Web pages and change its text or color using WebArt De-
signer.

o) Tip ]
If panes (or tabs) on the left
side are not displayed, click
the @ icon to display
them.

OUI——

The Other pane in the
WebArt Designer main win-
dow is the same as the
Contents pane in the
Homepage Builder main
window.

Click the Other tab at the lower left of the WebArt
Designer main window.

@ Select Webart from the box at the upper left of the
Other pane to display sample materials in the lower
half of the pane.

i, Untitled

[ER
script
sound

Al Files

b_helg mif

b_infio rif
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@ Vocabulary

objects

Elements that make up an
image. You can handle the
following objects using
WebArt Designer:

e L ogo

e Button

e Photo frame
o Clip art

e Image (all the image ele-
ments other than the pre-
ceding objects)

The logo, button, photo

frame, and clip art objects

are WebArt Designer origi-
nal objects. If you click one
of them in the WebArt De-
signer edit field, eight white
square marks appear
around it. You can change
the text, shape, or color of
the object by clicking it us-
ing the right mouse button
and selecting Edit Object
from the pop-up menu.

On the other hand, if you
click an image object in the
edit field, eight black square
marks appear around it.
You cannot change the text,
shape, or color for an image
object, but you can paint
over it using the Paint Tool ,
which you can display by
clicking the ﬂ icon.

€@ Select your preferred image, drag it, and drop it
onto the edit field on the right side.

The following figure, for example, shows how the
image is pasted onto the edit field. This sample
image is composed of two objects: a logo and a

button.
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@ Click the upper of the two images (a logo) lined up
on the right to select it, and then click it using the
right mouse button, and select Edit Object .

A dialog box for editing the logo is displayed.

@ Enter your preferable words for Text on the Text
panel:

. Edit Logo Object
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O U

Just as for logos, if you click
the button using the right
mouse button, and then se-
lect Edit Object , a dialog
box for editing the color and
shape of the button is dis-
played.

LI
If you have done the wrong
operation, Click the ﬂ icon

to cancel the immediately
preceding operation.

Click the ﬂ icon to
reexecute the canceled op-
eration.

The result is immediately reflected in the edit field.

AT

@ You can use the Edit Logo Object dialog box to
freely change such things as the font or color of the
text, outline, and text effects. After editing the logo,
click the X button in the dialog box to close it.

(¢)Tip___________________________]
If you change the text or color, save the object in a file.

“Saving a lettered button” on page 10-12

After having saved objects into a file, you can insert the file
into your Web pages, just as you do with other image files.

@ “Inserting an image” on page 7-2
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You can create a lettered button by selecting a button, creating a logo, and combining
them using WebArt Designer.

Selecting a button

To select one of the sophisticated sample buttons in the
Button pane:

Click the Button tab.

@ @ Select a button, drag it, and drop it onto the edit
field to the right.
Another way to create a
button is to click the =SSR
icon to start the wizard for
creating a button.

@ The following figure shows how a button is pasted

onto the edit field:
If you want to choose a

buttonlike image you have, 0 5510
select Paste File from the
Edit menu, select a file in
the displayed dialog box,
and click the Open button.
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Creating a logo

To create a logo using the Logo pane:

@ Click the Logo tab.
@ Type text in the Text field.

14

€l Select one of samples in the Logo pane, drag it,
and drop it onto the edit field to the right.

B
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OUIE———

Another way to create a
logo is to click the @ icon
to start the wizard for creat-
ing a logo.

OUI———

To delete an unnecessary
object, click an object and
then click the @ button.
Another way is to click an
object using the right
mouse button and then se-
lect Delete from the pop-up
menu.

The following figure shows how a logo (text with an
effect you selected) is pasted onto the edit field:

e

@ To change the logo size, drag one of the logo’s
white square marks other than that at the upper
right corner. To rotate the logo, drag the white
square mark at the upper right corner.

O 0

-

i -
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Pl Note

If you select or create a but-
ton after having created a
logo, combining the two
hides the logo, because the
latest-created object lies on
top of the other objects. To
correct this, you must rear-
range the sequence of ob-
jects lined up on the right
area of the window with a
drag-and-drop operation.

Combining a button and a logo

To combine a button you have selected and a logo you
have created:

@ Click the logo to select it. (The appearance of the
eight white square marks around it indicates that it

is selected.)

@ Drag the center (an area other than the white
square marks) of the logo and position it on the top
of the button to make up a lettered button.

B
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OU

After having saved objects
into a file, you can insert the
file into your Web pages,
just as you do with other im-
age files.

@ “Inserting an image” on
page 7-2

Saving a lettered button

To select objects and save them in one file:

@ Select Select All from the Edit menu to select all
objects on the edit field. The selected objects are
surrounded by thick borders.

@ Select Save Wizard from the File menu to start the
wizard for saving.

Save Wizard (Select Type)

€@ Select Object only , and click the Next button.
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@ Select GIF, and click the Next button.

Save Wizard (Select File Farmat)

Select image fils format

& GiE [Though i s imited to 256 calars to handle, yau can reduce file
size for images. It is rcommended that you save images that

ot need many colors such as llustistions
@ Vocabula ry ‘o1 can specily transparency for part of image

€ JPEG  [tis in geneial use on the Intemet because of its smallfis sis
land incanspicucus mage dearadation. It is 1scommendsd that
ou save full-colar images such as photos taken with a digial

dithering

‘ou cannot specify transparency.

One of methods for reduc- e ot o o e 5
ing colors. Dithering shows fﬁ%}iﬁ'ﬁﬂiﬂl@!&?ﬂim.,m, o S——
colors that are not actually

in the color palette, as
though they were, by ad-
justing the colors of adja-
cent pixe|3_ <Back [ Wew> |  Camcel | Help |

@ Select 256 colors , select Yes from the Dither box,

@ and select the Finish button.

If yOU C"Ck the ﬁl icon and <Original Image> <Converted Image>

click an image in the edit I I
field, an area with the same
color as the point you
clicked becomes transpar-
ent and the Transparent

check box is automatically S —
selected. Normally, this A
technique is used for mak- gy e e || i
ing the background color of ook [0 cokes 2=
the image transparent to Diher [ = I Intetece
merge it with the back-

ground color of the Web <Back [ Fon | | Cewsl | Heb
page being edited.

If you select the Interlace
check box, the image reso-
lution gradually increases
when it is displayed on a
Web browser. This tech-
nique is useful for large im-
ages.
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@ On the displayed dialog box, select the site folder,
specify a file name, and click the Save button to
save the objects in a GIF format image file.

(¢)Tip ]
This section explains how to save objects in a file, but you
can also copy the image data from WebArt Designer and
paste it into Homepage Builder without creating a file. To
copy the image data, select objects in the edit field of
WebArt Designer and select Copy from the Edit menu of
WebArt Designer to store the data in the clipboard.

To paste the data stored in the clipboard onto Homepage
Builder, position the cursor on a Web page you are editing
and select Paste from the Edit menu of Homepage Builder.
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Decorating a photo with a frame

You can decorate a photo you took with your digital camera with a frame and show it
to visitors to your Web site. In addition to adding a frame, you can retouch your digital
photo or apply an effect to it.

(1)Note Pasting a digital photo

Before doing the following . . .
operation, you must have To paste the image file of a digital photo onto the WebArt

imported the image file of a Designer’s edit field, do the following.
digital photo into your com-
puter or other media such

as a floppy disk, MO disk,
and so on.

@ Select Paste File from the Edit menu.

@ On the displayed dialog box, select an image file in
your computer or other media, and click the Open
button to paste the image.

O

You can paste image files in
such formats as GIF, JPEG,
BMP, TIFF, FlashPix, and
Photo CD onto the edit field
of WebArt Designer.

@ Appendix C, “Image file
formats”
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o) Tip ]
Because a photo taken with
a digital camera might be
dark-colored or fuzzy, it is d
recommended that you se-
lect the bright and high con-
trast image in the upper
right.
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Retouching a digital photo

A photo taken with a digital camera might be dark-
colored or fuzzy. You can retouch the brightness and
contrast of the photo as follows:

Click the ﬂ icon to display a dialog box for re-
touching the brightness and contrast. The image
you selected is displayed in the center of nine of the
same image but with slightly changed brightness
and contrast:

Click the image that you think is best.

If you select the Preview check box, the image in
the edit field changes according to your selection.

If the image is satisfactory, click the OK button.

If you want to redo, click the Reset button to return
to the original state and obtain the optimum state by
dragging the Level slider or by reselecting the
image. After you click the best image, click the OK
button to change the brightness and contrast.



OUI———

If you want to retain the
naturalness of the digital
photo, you do not need to
apply an effect.

Applying an effect to a digital photo
Effects change your digital photo dramatically. To apply
an effect to your photo, do the following:

@ Click the H icon to display the Effect Palette for
selecting one of the effects.

@ Click the Preview button to view how the selected
image changes if each effect is applied to it.
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double-clicked.

€@ Double-click an effect button to apply it to the
selected image in the edit field. The following figure
shows an example when the Emboss button is

,,,,

Click the Close button to apply the effect.

If you want to redo, click the ﬂ icon to return to the
original state, double-click another effect, and click

the Close button.



Adding a photo frame
@ To add one of the sample photo frames to your digital

photo, do the following:
You can also create a photo

frame using the wizard that @ Click the Frame tab at the lower left of the main
starts when you click the window to display sample photo frames provided by
@ (Beifl, WebArt Designer.

Select a frame, drag it, and drop it onto the photo
image in the edit field.

@ @ If you want to change the frame size, drag one of

eight white square marks to change the size as you

To save the photo image please. If you want to replace it with another frame,

with a frame in a file, see

“Saving a lettered button” click the frame using the right mouse button, select
on page 10-12 and do the Edit Object from the pop-up menu, and select
same operation. You can another frame in the displayed dialog box.

paste the file onto the edit
field of Homepage Builder,
as you do with other im-
ages.
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An animated GIF image is a combination of multiple images. Viewed on your Web
browser, it appears to move. You can insert an animated GIF image into your Web
page, just as you do with other GIF images.

Starting Web Animator
To start Web Animator, an accessory for creating

animated GIFs, type the following command and press
Enter:

$ hpbuilder -a

The following is the Web Animator main window, with the
Startup dialog box:

1R85 E W N
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OUI——

To start the animation wiz-
ard, you can also click the
@ icon on the toolbar of
the main window.

OUI——

The Startup dialog box also
contains the following but-
tons.

e [ | a button for creating
animation from scratch.
Clicking this button is the
same as selecting New
from the File menu.

e |, a button for opening
an image file you have.

e (3|, a button for opening
an image file from among
the sample materials.

Using the animation wizard

If you already have several images to combine into an
animation, using the animation wizard is the easiest way
to create an animated GIF.

@ Start Web Animator, and click the & | button in the

Startup dialog box to start the animation wizard.
Startup 7] x|

@l Animation Wizard @1 DOpen
D | New @’Fx Open Sample File

™ Don't show this dislog nest time.

@ To add an image to the list, click the Add Image
File button on the File dialog box, select an image
file in the displayed dialog box, and click the Open
button.

Repeat this operation to add several images to the
list. (Note that in the animation to be created,
images are displayed in order from the top.)
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€@ Click the Next button to display the dialog box for

positioning frames. (Here, a frame means a single
image in the collection that makes up the anima-
tion.)

@ Change the position, if necessary, and click the

Next button to display the next dialog box:

Repeat and Delay Time

You can specify the number of repetitions and the
delay time for each frame. If necessary, change



)T

You can open image files in
such formats as GIF, JPEG,
BMP, TIFF, FlashPix, and
Photo CD.

Appendix C, “Image file
formats”

them and click the Next button.

@ To see a preview of the animation, click the H
icon.

Click the Finish button to finish the wizard.

All the frames that make up the animation are
displayed on the main window.

@ Select Save As from the File menu.

€@l On the displayed dialog box, select a folder, specify
a file name for the animated GIF (*.gif), and click
the Save button to save the animated GIF image in
a file.
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OUI

The following types of ani-
mation effects are available.

e Wipe

e Mosaic wipe
e Scroll

e Blend

o Blur

e \ortex

o Tile

e Mosaic

e Noise

e Scatter

e Pinch

e Center focus
e Zoom

e Gray scale
e Bilevel

® Sepia

e Half tone

e Motion Blur
e Wind

o Rotate

Applying an animation effect

You can create animation from a single image, by apply-
ing an animation effect to the image.

@ Start Web Animator and click the @ icon on the
Startup dialog box to display the Open dialog box.

Open =

= TR | || 1|
[EEjoraw001 it Eijdrawd08.gif  [sijuraw015.gil  EEjoraw0z2.gif  Ehjdrawzd.gif
[Eijdrawn0z it Eljdrawn0d git  [Ejdrawiogl  [Eijdrawd2igit  Eijdraw0do gi
[Eijdrawn0a it Eijdrawn0.git [Eijdrawt 701 Eijdrawn2d.gift - Eijdvawat git
IZijorawo0a git  Eijorawo 1ot Bijdraw0is.gr  Eijdrawozsgit  Eijdraw03z git
(Efjdraw005.gift  Eljdrawt1z.gif  [Eijdraw19.91  Eifdraw02.gil  Eijdraw03a.gif
[Eijdrawn06 it Eijdrawni3.git [Eijdrawbzngi  [Eijdrawn27.git  Eijdrawnad git

|Eijoraw007 git  Eijorawo4.git  [Bijdraw0z1 gift  Eijdraw0zagit  Eijdraw03s git

GIF Files (*.gif) =

@ Select an image file, and click the Open button.

The following example shows how the image is
opened:

5, draw002._gif

L

L ol

@ Click 1: Image using the right mouse button, and
select Add Animation Effect from the pop-up
menu. The following dialog box is displayed:
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(=15
ok

- Effect

- =1 [T =] e
L3, ‘wipe (Top -> Botiom) Lime: = Cancel
L | Help

@ Select one of the effects from a box under Effect

Settings and, if necessary, change the values for
Time or Number of Frames . Click theﬂ icon to
preview the effect.

Click the OK button to add frames, the number of
which is the same as you specified in Number of
Frames. (Until you click the OK button, you can
reselect an effect any number of times.) If the
added frames are too many to check all, drag the
scroll bar at the bottom of the window.

1

Select Save As from the File menu.

Select a folder, specify a file name for the animated
GIF file, and click the Save button to save the
animation you created in a GIF file (*.gif). You can
insert the file into the editor of Homepage Builder,
just as you do with other GIF image files.
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Chapter

Advanced techniq 11

This chapter explains such advanced techniques as the frame
function, images maps, dynamic HTML, and so on.

Before doing the tasks in this chapter

1. Start Homepage Builder.

2-5
2. Open a Web page to be edited.

“Starting and ending Homepage Builder” on page

“Opening a site and a Web page” on page 4-11

*
*

LN S S 2 R o

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***.

J
Receiving readers’ responses................ 11-2
Dividing a Web browser window (1)........ 11-3
Dividing a Web browser window (2)........ 11-8
Setting multiple links on a single image .... 11-11
Inserting an access counter................. 11-15
Creatingaform ...........ccccovvnieiininnnne. 11-17
Editing a script program...................... 11-24
Embedding a plug-in object................. 11-26
Customizing a Java applet .................. 11-28
Using dynamic HTML ........................ 11-33

111



Receiving readers' responses

If you want those who read your Web pages to write their impressions or to inquire for
detailed information, embed your e-mail address in your Web page, using the link
function.

@ Related HTML tags @ Select text or an image, which will be a link source,

and click the @ icon.
<A HREF="MAILTO:"></A>

Please send us your comiment or gquestion

@ Click the E-Mail tab, type your e-mail address in the
To box, and click the OK button. (You can also
type the subject in the Subject box.)

Attiibute
Tag IL\nk j
TaFil| ToURL| ToLabel EMai | AddLabel| TaUnsaved T4 |

o
[hpbmailip.ibm. com |
— Subject

Extended..

oK I Cancel | Help |

An e-mail address is embedded as a link
destination. If someone clicks the link source on a
Web browser, his or her e-mail application starts, in
which your e-mail address is automatically typed.

Please send us your comment or question.
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Dividing @ Web browser window (1)

Use the frame function to divide a Web browser window into several sections. This
section explains how to create and save a Web page that uses the frame function.

@ Related HTML tags

<FRAMESET COLS= ROWS=>
</[FRAMESET>

<FRAME SRC= >
<NOFRAMES></NOFRAMES>

@ Vocabulary

frame function

A function to divide a Web
browser window into
several sections.

(¢)Tip

To divide an existing Web
page without using a
template, open the page
you want to divide, select
Split Frame from the
Frame menu, and then
select Split Vertically or
Split Horizontally . The
page is then divided into
two sections and the
original page is allocated to
the left or top section.

Using templates for the frame function

Homepage Builder offers templates for the frame func-
tion. Select one of them, and in each section open Web
pages you have already created.

@ Create Web pages you want to assign to each
section. If you want to divide a window into two

sections, you need two pages; if you want to divide

it into three sections, you need three pages.

@ Select New from the File menu to display a dialog

box for creating a new Web page.

and click the OK button.

Hew

Page Frame |Appl\catmn| Multiple: Pagesl

€@ Click the Frame tab, select a method for dividing,

Split 2h [Type &)
Split h [Type B

Split 2v [Type B)
Split 3 [Type &)
Split 3 (Type B)
Split 3 (Type C)
Spiit 3 (Type D)
Split 3h

Split 3v

Split 4 [Type &)

H
=
5
i
omx

Spiit 4 (Tpe E]

Right=50%, Left=00%

OK I Cancesl

Help
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fo)Tip

To divide one of sections,
click it, select Split Frame
from the Frame menu, and
then select Split Vertically
or Split Horizontally . The
section is then divided into
two, and the original section
is allocated to the left or top
section.

(¢ Tip ]

If you click a section using
the right mouse button and
select Frame Attributes
from the pop-up menu, a
dialog box for changing the
frame attributes is
displayed.

A Web page divided into sections is displayed.

B newpagel.htm - Untitled _[olx]

) ]

@ To open in a section a Web page you have already
created, click a section using the right mouse
button, and select Open in Frame from the pop-up
menu to display a dialog box for selecting an HTML
file.

@ Select a Web page you have already created, and
click the Open button to open the page within the
selected section.

@ In the same way, open another Web page within
another section.

E; index.htm - ABC Florist

LR LB BT et

The ABC Florist offers online ordeting of
‘bouguels, arrangements, baskets, and
centerpicces.
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(¢)Tip ]

To specify the section size
in pixels, click the target
section using the right
mouse button, select
Frame Attributes from the
pop-up menu, enter the
pixel value (for example,
100) in the Size box on the
Frame Attributes panel,
and select the Specify with
pixels check box.

If you want to fix the size of
one of two sections and
make the other section
displayed in the rest of the
window, first, fix the size of
one section as just
described. Next, click the
other section using the right
mouse button, select
“Frame Attributes” from the
pop-up menu, and select
Specify with  * from the left
box of Size on the Frame
Attributes panel.

Changing the size of each section

Dragging a frame border changes the relative size (in 1 1
percentage) of each section.

If you drag a frame border....

B index_htm - ABC Florist
AR R LA SRS

The ABC Florist offers onlins otderife of
bowguets, atrangements, baskets,
centerpieces
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fo)Tip

If you divide the top page,
set links in the No Frame
pane so that readers can
jump from the top page to
subpages.

Editing the No Frame pane

Some Web browsers do not support the frame function,
so you should leave a message in the No Frame pane.

@ Click the No Frame tab, which is displayed while
you are editing your Web page that uses the frame
function.

B framepage1.htm - Untitled = = =] B

Heed browser which supports frames to see this page

@ Type text for guiding visitors.

If someone views your Web page on a Web
browser that does not support the frame function,
he or she reads the message that you leave here.

Ei framepagel_htm - Untitled = 9 [T B

This page uses the frame function. Because your Web Browser
does not support the frame function, you can see only this
message. To jump to another page that does not use the frame
funetion, glick here |

S
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Saving the Web pages

You can save a frame-using page and the other pages 1 1
that are allocated to the sections all at once.

@ Select Save All from the File menu to save all the
Web pages at once.

@ |If there is a Web page that does not have a file
name, the following dialog box appears. Specify a
file name and click the Save button. (At this time,

the page to be saved is displayed in reverse video.)
Save As [x]

ETT—

frame._htm

HTML flles (it httn; s hitrl " i) =

€@ If you have pasted images or other files into the
page to be saved, the following dialog box appears:

[ File Name: | Saved Foider | Capying |
gaide_fr.of Csitetop', es
map. ot L sietop

map i <log, ves
gardle_ft.gi Chisitetop', Yes
garde_bg gif Cisitetop', Yes

(¢)Tip ]

Saving Web pages one S o
by one File Mame: lmaugwfi
Desinsiors [Coeom | Bowe
If you want to save only a 7 o it
frame-using page, select oree s
Save Frame from the
Frame menu. @ Confirm the save location and click the OK button.

If you want to save other
Web pages that are
allocated to each section,
click the target section, and
click the || icon.
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The previous section explains the basic operation for the frame function, including
creating and saving a page with frame. This section explains advanced operation for

the frame function.

@ Related HTML tags

<FRAME SRC= NAME=
MARGINWIDTH=
MARGINHEIGHT= SCROLLING=
NORESIZE>

Increasing the margin of each section

Assigning an appropriate margin for each section gives it

a good appearance.

Click the target section using the right mouse
button, and select Frame Attributes from the pop-

up menu.

P

The ABC Flosist offers
online ig of

@ In the dialog box for changing the frame attributes,
select Use Horizontal Margin and Use Vertical
Margin , and specify their values in pixels.

Attribute
Tam IFlame j
Frame Attributes | Border Attrbutes |

LRL:

Ilndex.hlm Browse... |
FErame Marne:

Ilighl

- Size

[specity with R

I~ Mo Resize on Browser
—hargin

¥ Use Horizontal Margin 100 _:|

v Use Wertical Margi =

¥ Use Yertical Margin 100 =

Scroll Bar
’7 At & ‘

oK I Cancel | Help
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@ Vocabulary

target

One of the link attributes.
This indicates where the
link destination page is to
be displayed.

(¢ Tip ]

For example, specify the
name “left” for the left
section and “right” for the
right section, which is easy
to remember.

€@ Click the OK button.

You cannot see the result in the editor, but you can
see the result when displaying the frame-using
page on a Web browser.

Changing the link target

Suppose you divide the window into left and right
sections, and you set a link on the text on the left section,
the link destination page is normally displayed

in the same left side section. However, if you use the
target attribute, you can display the link destination page
on the right section.

@ To specify a name for the section where you want
to display the link destination page, click the section
using the right mouse button, select Frame
Attributes from the pop-up menu, and type a name
next to Frame Name.

Chapter 11. Advanced techniques 11-9



(¢ Tip ]

To display the link
destination page on the full
window, select Full
Window in the Target box
of the Attribute dialog box
for a link. The link
destination page is then
displayed on the full Web
browser window.

(¢ Tip ]

To remove a target
specification, delete the
frame name in the Target
box on the URL toolbar. To
change a target
specification, type another
frame name.
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@ Set a link into text or an image for the link source.

When you open the Attribute dialog box for a link,
select a frame name that you specified from the
Target box. @) Chapter 8, “Setting links”

Attribute
Tag  |[Link [ |
TaFile | To URL | ToLabel| E-Mail | AddLabel]
r— File Hams
Isulﬂ _htm
i~ Target
Ilight vI
ok I Cancel | Help |

€@ Click text or an image for the link source to check

that the frame name of the target section is
displayed in the Target box of the URL toolbar.

E: moy

eeeee

If you click a link on a Web browser, the link
destination page is displayed in the specified
section.



Setting multiple links on a single image

The section “Setting a link on an image” on page 8-8 explains how to set a single link
on an image. This section explains how to divide a image into several areas and set
links on them. An image that have multiple links is called an image map or a clickable

map.
@ Related HTML tags

<MAP NAME= ></MAP>

<AREAALT= COORDS= HREF=
SHAPE= >

(1)Note ]

This section introduces the
simple flow for the image
map creation. If you want
to learn more about image
maps, click an image using
the right mouse button,
select Edit Image Map
from the pop-up menu, and
click the Help button. A
help topic is then displayed,
where you can read a
detailed explanation.

Opening the Image Map Editor

To open an editor to create an image map:

@ Click the target image using the right mouse button,
and select Edit Image Map from the pop-up menu
to open the Image Map Editor.

i Image Map Editor O] ]
Itap: map Delete Map. |
Image:  [C:\sitetopsmap. gif
@0/ ElxEcw |
Floral r
Arrangements
Order
Services
Home
Cancel Help
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fo)Tip

To create a circular area,
click the @] icon and drag
the image.

To create a polygonal area,
click the ] icon, click the
image multiple times to
make the angular points of
the polygon, and double-
click the last angular point
to finish.

Setting links on multiple areas

You can create areas whose shapes are rectangular,
circular or polygonal and then set links to them.

@ Click the g icon in the Image Map Editor.

@ Drag on the image displayed in the editor, from the
upper left corner to the lower right corner, to create
a rectangular area. When you release the mouse
button, the area is determined, and the Attribute
dialog box for a link is displayed.

o3]S e -

€@ Specify the link destination (refer to “Setting a link
on text” on page 8-2), and click the OK button to
add the area to the image map.

@ Click the down-arrow button in the Image Map
Editor to display a list of the specified areas.
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(1)Note

Alternate text is necessary
for those who use Web
browsers that cannot
display images to jump to
the link destination. Be
sure to enter alternate text
for each area.

OUI——

To change a link
destination, click an area in
the image displayed in the
Image Map Editor , click
the [#|icon to display the
Attribute dialog box for a
link, and change the
destination.

fo)Tie

To cancel a link, click an
area in the image displayed
in the Image Map Editor,
and click the x]icon to
delete the area and to
cancel a link.

@ Type a comment for the area next to Alternate
Text.

\ish Image Map Editor

s |

I o] ol S 5 T
.

Floral Arangements|

[ox ]_corcal |

@ Repeat the preceding steps to create multiple areas
that have links to the different destinations.

i Image Map Editor

s |

{5 o] ol g S 5 TR
-
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(1)Note ]

You do not have to specify
a URL for the Default area.
However, you must specify
URLs for the other areas;
otherwise, you cannot save
an image map.

@ Vocabulary

client side image map

An image map that is
processed on the client (Web
browser) side. Because HTML
tags for this image map are
embedded in an HTML file,
you can easily use and
manage this image map.

@ Vocabulary

Server side image map

An image map that is
processed on the server (your
provider's server) side. To use
this image map, you must
create an image map file in
addition to an HTML file.
There are two types of server
side image maps; NCSA and
CERN, depending on the
application that the server
uses. To save an image map
in one of these formats, select
NCSA or CERN from the
upper right box in the Image
Map Editor.

Saving an image map

You can save an image map (the entire image including
areas you created) in one of the following formats: client
side image map (CSIM) or server side image map
(NCSA or CERN). To save an image map in the CSIM
format, which is easy to manage:

@ Select CSIM from the upper right box in the Image
Map Editor.

@ Check that a map name (a file name for the image
map, which you can change if necessary) is
specified in the Map box.

\liih Image Map Editor

N [=] B

Itap: map Delete Map. |

Image:  [C:\sitetopsmap. gif

I s | )

oral
l;;an; gments

i

Shape | Target | URL ‘ Alternate Text ;I

Rectangle right subZ htm ‘Wedding Services —

Rectangle right sub3. htrn Order Form J J
Home

Fectangle right index. hitm =

e .

q | »|‘| [
Altemate Text IHnma

Cancel Help

€ Click the OK button to save the image map.
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If your provider offers a CGI program for an access counter, you can display the
number of times your Web page has been visited.

@ Related HTML tags

<IMG SRC= >

(1)Note

Before doing this task,
check that your provider
offers the access counter
service as well as guidelines
for specifying it in the HTML
file. The guideline might
state, for example: Specify
<IMAGE src="/cgi-bin/
counter.cgi?id=hpb&n=1">
in the HTML source.

(The text surrounded by " "
differs depending on the
providers.) If there is no
such guideline, or if anything
is unclear, ask your provider.

@ Vocabulary

CGI program, written in
Perl or C language

A program written for
exchanging data between a
client and a server. lItis
often used when a server
receives information—for
example, questionnaires or
orders—entered in a Web
browser, and then
processes it.

@ Open a Web page (typically, the top page) where

you want to insert an access counter.

Position the cursor on the location where you want

to insert an access counter. Click the ﬂ icon to
display the Open dialog box.

Click the Cancel button to display the Image dialog

box.

Read the guideline provided by the provider and
find the text <IMG src="...">. Type the text en-

closed by " " of <IMG src="..."> in the Image dialog

box. For example, if the guideline states:
Specify <IMAGE
src="/cgi-bin/counter.cgi?id=hpb&n=1"> in the
HTML source

type

/cgi-bin/counter.cgi?id=hpb&n=1

Jegi —hindcounter cgi tid=hphbé&n=1

r
[_on | cow | |

Click the OK button to insert the access counter.
the editor, the mark x is displayed.

Chapter 11. Advanced techniques
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@ After you upload your Web page that contains the
access counter to the provider's server, you can
actually view the counter as shown in the following
figure. (The image that contains the number is the
access counter. You cannot view it until you upload
your Web page to the provider's server.)

You are visitor number -




Creating a form

Forms include such things as questionnaires and order forms. Visitors to your Web

site can fill in the blanks and enter responses to multiple choices within the form. This

section discusses how to create a form for a questionnaire.

@ Related HTML tags

<FORM></FORM>
<INPUT TYPE= >
<TEXTAREA>
<SELECT></SELECT>

P Note

Before doing this task,
check that your provider
permits the use of forms
and CGlI programs. Ifit
does not, you cannot use
forms even if you create
them.

You can check that your
form operates correctly only
after you upload your Web
page that contains your
form to your provider's
server.

(1)Note ]

Homepage Builder does
not provide a function for
creating CGI programs. It
is recommend that you use
CGI programs offered by
your provider.

Creating an area for your form

First, you must create an area only for your form in your
Web page. To create the area, position the cursor on the

location where you want to create your form. Select

Form and Input Fields from the Insert menu, and then

select Form to create an area for your form. (The form
area is indicated by a dotted line, but the line is not

displayed on Web browsers. If you insert anything in the

area, the area expands.)

Questionnaire

Chapter 11. Advanced techniques
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Using a table for layout

To create a table within the form area to lay out input
fields:

@ Click inside the form area, and click the icon.

@ In the Insert Table dialog box, type the number of
rows and columns, and click the OK button to
create a table inside the form area.

€@ If you want to use the table only for the layout, you
do not need the table border. Click the table using
the right mouse button, and select Hide Table
Frame from the pop-up menu.

Questionnaire

11-18  Homepage Builder User’s Guide



(¢)Tip
Other input fields

Frequently used input fields
are on the toolbar, but you
can insert all the input fields
from the menu. By select-
ing Push Button in Form
and Input Fields from the
Insert menu, you can insert
input fields other than those
described in the preceding
table. They are:

e Image Button (a button
with an image)

e Button (a button for
general purposes)

e Extended Button (a
button generated by the
selection of its range,
displayable only on
Internet Explorer 4.0 or
later.)

Types of input fields

Before inserting input fields, become acquainted with the
types of input fields.

this area.

Type of Explanation Toolbar Example
input icon
field
Check Visitors can click to e W blue
box select or clear this = I red
check box on their Web W white
M yellow
browsers.
Radio Visitors can choose " - @ right  left
button one radio button from Ll
those of the same
group.
Submit | Visitors can click this Submit |
button button to upload the
information they
entered to the CGI
program on your
provider's server.
Reset Visitors can click this
Feset |
button button to return the
information they
entered to the initially
set value.
Option Visitors can select one :
Iltem—1 v|
menu of multiple choices. s
List box | Visitors can select one e apples =
of multiple choices. =l grapes
Dranges;l
Text Visitors can type one B Ifruitbasket
field line of text in this field. :
Text Visitors can type E
area multiple lines of text in

Thank you for —
vour invitation.
Jid|
J
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(¢ Tip ]

If the Attribute dialog box
is not displayed, select
Options from the Tool
menu, click the General
tab, and select the Open
Attribute Dialog after Cre-
ating an Object check box.

(¢ Tip ]

To change attributes for
input fields later, click the
field using the right mouse
button, and select
Attributes from the pop-up
menu.

Inserting input fields

To insert input fields in a table for layout:

@ Position the cursor on the location where you want to
insert an input field. Click one of input field icons on
the toolbar to display the Attribute dialog box for the
input field. “Types of input fields” on page 11-19

@ Type the input field name under Name.
(I)Note ]

The input field name that you must enter under Name is

used as an identification code in the CGI program. If you
use your provider's CGI program, type the name that the
provider prescribes.

€l Repeat the preceding steps to complete the ques-
tionnaire.

@ Position the cursor on the bottom of the question-
naire, and click the icon to display the Attribute
dialog box for a submit button.
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@ Enter “Submit” under Label, and click the OK
button to create a submit button.

Attribute %]
11

@ Position the cursor to the right side of the created
submit button, and click the icon to display the
Attribute dialog box for a reset button.

Enter “Reset” under Label, and click the OK button
to create a reset button.

Attribute x|
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The following example shows how a form appears
in the editor:

The following example shows how the same form
appears when viewed on a Web browser:




(1)Note

This User's Guide does not
provide details about
specifying these items,
because the specification
varies depending on the
providers.

You can check that your
form operates correctly only
after you upload your Web
page that contains your
form to your provider's
server.

Specifying a CGI program

If your provider permits the use of forms, it provides
guidelines for specifying the CGI program name, form
attributes, and so on. (If it does not, ask your provider.)

@ Click inside the form using the right mouse button,
and select Attributes from the pop-up menu to
display the Attribute dialog box for a form.

Attribute

@ Specify the items according to the provider's guide-
lines.

€@ Click the OK button.
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Editing a script program

You can create a script program, using the script editor Homepage Builder offers. You
can then insert it into your Web page.

OLEEELLINEESSS | Opening the script editor

<SCRIPT LANGUAGE= ></

ol To open the editor for editing script:

@ Position the cursor on the location where you want

@ Vocabulary to insert a script, and select Script from the Insert

menu to open the script editor:
script

A program written in the
script language, JavaScript
or VBScript (Visual Basic
Script). You can write this
program directly into your
HTML file. The use of scripts
enables you to, for example:

« Gradually change the : ‘ o1
background color of your
Web page

« Display the current time in Editing a script
your Web page

Script files are small, which To write a script program using the editor and then insert

makes them handy and it into the Web page:

convenient. However, _ _ _

because they are processed @ Select a script language, JavaScript or VBScript ,

only on the client side, you from the Language box.

cannot exchange data with _ _

the provider's server. @ Write a script program between <!-- and //-->.

Objects and libraries that you can use freely are

@1]_ provided on the left side.

Knowledge of script
language is necessary to
create scripts. Refer to
other books on JavaScript
or VBScript.

o) [
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(¢ Tip ]

JavaScript is conventionally
surrounded by "<!--" and "/
-->"and VBScript is
surrounded by "<!--" and "'--
>" which enables Web
browsers that support
scripts to run the script, and
which enables Web
browsers that do not
support script to ignore
them.

The following example shows how you can write a
script program:

€@l Click the OK button to insert the script at the cursor
position. A script program is indicated by the mark 4 .

s

For Your Dream Weddinga

]

(¢)Tip____________________________]
To insert a script program into the header section (the
section surrounded by the <HEAD> tag and the </[HEAD>
tag in HTML) of your Web page, select Document
Properties from the Edit menu, click the Others tab, and
click the Edit Script button to open the script editor. Write
your script with the editor, and click the OK button to insert
the script into the header section.

(¢)Tip____________________________]
If you have your own JavaScript file (*.js), you can insert it

simply by selecting the file on the Contents tab, dragging it,
and dropping it onto your Web page.

You can also insert sample JavaScripts. To display sample
JavasScripts, click the Contents tab and select JavaScript
from the upper left box. To insert one of them, select one,
drag it, and drop it onto your Web page.
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You can insert such plug-in objects as sound data and multimedia data. This section
introduces how to insert the sample sound data offered by Homepage Builder.

@ Related HTML tags

<EMBED SRC= ></EMBED>

@ Vocabulary

plug-in object

Such objects as the sound
data (*.wav; *.mid; *.au) and
multimedia data
(Shockwave, VRML) that
you can play back on a
Web browser. They are
called plug-in objects
because you must add the
plug-in applications to your
Web browser to play them.

(I)Note ]

You cannot create sound or
multimedia data using
Homepage Builder. To cre-
ate it, use other applica-
tions.

Click the Contents tab.

@ Select Sound from the upper left box (Sound is
one of the sample materials) to display several
sample sound files.

(§ dinner
05 carden
g WaveText

sampl
image

acal mid
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(¢)Tip

If you drag and drop a file
with the right mouse button,
a pop-up menu is displayed
at the dropping location.

If you select Insert as
Background Sound from
the preceding pop-up
menu, the file becomes the
background sound for your
Web page. (This function is
supported only by Netscape
Navigator 3.0 or later, and
Internet Explorer 4.0 or
later.)

(1)Note ]

To play back the inserted
plug-in objects on your Web
browser, the plug-in
applications must have
been added to your Web
browser. Not all Web
browsers have the plug-in
applications. Decide
whether to use plug-in ob-
jects, after considering the
purpose or target readers of
your Web pages.

€@ Using the right mouse button, drag a sound file.

Drop it on the Web page you are currently editing.

The following pop-up menu is displayed.

Create a Link to Thiz File
Pazte az a Flug-in
Ihzert as Background Sound

@ Select Paste as a Plug-in to insert the sound data

at the position where you dropped the file as an

plug-in object. The sound data is indicated by the

. mark.

B sub2 htm - Wedding Services

E;F'or Your Dream Weddinga
o

b N
:We specialize in wedding services. Qur designers and :l
1bidal consultants will make your special day a
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Though you cannot create Java applets with Homepage Builder, you can modify
(customize) the size and movement of existing Java applets. This section describes
how to insert and customize a sample Java applet that Homepage Builder offers.

@ Related HTML tags

<APPLET CODE= CODEBASE=
WIDTH= HEIGHT= ></APPLET>

<PARAM NAME= VALUE= >

@ Vocabulary

Java applet

A program written in Java
language. By changing its
parameters, you can
change such things as the
background, movement,
and text.

(1)Note ]

You cannot create Java
applets with Homepage
Builder. To create them,
you need a knowledge of
Java language and pro-
gramming.

You can display Java
applets only on Web
browsers that support them.

Inserting one of the sample Java applets

To insert one of sample Java applets Homepage Builder
offers:

Click the Contents tab.

@ Select Java Applet from the upper left box (Java
Applet is one of the sample materials) to display
sample Java applets.

Java applet Files

E -

A Show Irngy Blink:

Iy Facle ImgPlay
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(¢ Tip ]

You cannot run Java apples
in the Homepage Builder
editor. (In the editor, an al-
ternative image is displayed
instead of the actual Java
applet.) Applets run only on
a Web browser.

€@l Select the Java applet you like, drag it, and drop it
onto the Web page you are editing.

The Java applet is inserted into the position where
you dropped the file. The Java applet is indicated
by the alternative image.

)T
A single Java applet is composed of several files. If a Java
applet has been inserted as described in this section, a
subfolder for the Java applet is automatically created when
you save the Web page you are editing, and all the required
files are copied into it.

When you upload your files to the provider's server, you
must also upload the subfolder for the Java applet and the
files in it. However, if your provider does not permit the use
of subfolders, move the entire content of the Java applet
subfolder to the top folder and erase the CODEBASE
attribute of the <APPLET> tag.
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Changing the size of a Java applet

To change the size of a Java applet you inserted, click it,
and drag one of eight black square marks around it.

Drag like this...

4

to change the size to this:

Changing the movement of a Java applet

You can easily change the movement, color, displayed
text, or displayed image of a Java applet by changing its
parameters. Change them according to your own
personal taste.

@ Click the Java applet using the right mouse button,
select Attributes from the pop-up menu to display
the Attribute dialog box.
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@ Click the Parameters tab, which has a list of Java
applet parameters.

@ Click one of parameters. The parameter name is
displayed in Name, and the parameter value in

Value. You can change the value as you like. Type
the new value, and click the Replace button.

@ Click the OK button to save the changes. You
cannot check the changes on the Normal pane, but
you can on a Web browser.

You can change this Java applet ...

Me ||

4

to this.

Wedding <
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Inserting your own Java applet

To insert your own Java applet, which is not one of
sample Java applets provided by Homepage Builder:

Create a subfolder for the Java applet in your site
folder.

Copy all the files composing the Java applet to the
subfolder you created. Copy the following files, for
example:
e Class files (*.class)
e Image files and other files specified in the class
files

Select Java applet from the Insert menu to display
the Attribute dialog box for a Java applet. Check
that Applet is displayed in the Tag list box.

Type the class file name in Code, the Java applet
subfolder name in Code Base, the explanation of
the Java applet in Alternate Text , and the size of
the Java applet in Width and Height .

Click the Parameters tab, which has a list of Java
applet parameters.

Enter the parameter name in Name and the corre-
sponding value in Value, and click the Add button.
Repeat this step for all the parameters.

Click the OK button to insert the Java applet. The
mark ¢ is then displayed. (You can view the
actual Java applet on a Web browser, not on the
Normal tab.



Using dynamic HTML

You can use dynamic HTML by using the samples provided by Homepage Builder.
You can create a new Web page that contains dynamic HTML. Or you can insert an
element for dynamic HTML into the Web page you are currently editing.

@ Creating a new Web page that contains dynamic HTML

<SCRIPT></SCRIPT>

This method uses templates provided by Homepage
<DIV ID= STYLE= ></DIV>

Builder. You can view a hew Web page with Netscape
Navigator 4.0, Microsoft Internet Explorer 4.0, or a later

@ Vocabulary version of them.

dynamic HTML @ Select New from the File menu to open the New
The latest technology for dialog box.
creating animated Web @ Click the Application tab, which contains Web
pages. Inthe past, to .
ST EiTE e Wil page templates using the latest technology. The
pages, you had to either Web page titles that begin with <S> use style sheet
create an animated GIF technology, and those that begin with <D> use
image or write a program in dynamic HTML technology.
another file. However,
dynamic HTML requires L . .
only an HTML file. €@ Select a template beginning with <D>, and click the

OK button.

New
@m Page | Frame  Application IMuItipIa Pages |
Netscape Navigator 4.0, Y word e
Microsoft Internet Explorer Zgig‘é‘:ﬁd ¢
4.0, or a later version of Dol
these browsers can display Dt =
dynamic HTML. Decide %Eﬂ”g e e
whether to use dynamic St |
HTML, considering the St 1]
purpose or target readers of Vi siscts: Dyraric Hi page.
sample, using "Bounce” effact
your Web pages. Sﬁifiikiﬁﬂ!é bouncing up and
[ ok | cancel Help
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OIS | o

Another way to check the
movement of the dynamic
HTML is to select Save As
from the File menu to save
all the files composing the
Web page and view the
page on your Web browser.
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The Web page you selected opens in the
Homepage Builder editor.

E: newpage'.htm

......
volleyball
football

To edit the page, click the Normal or HTML Source

tab, and edit it, as you do with other Web pages.



@ Vocabulary

layout frame

The area where you apply
the dynamic HTML effect.
Some Web browsers refer
to this as a layer.

@ Vocabulary

effect

Such movements as:
o Fade-in

« Fade-out

o Jump

« Bounce

« Float

These effects are described
in JavaScript.

Inserting an element for dynamic HTML into the
Web page

In this method, you create a layout frame in any position
you like, select an effect of dynamic HTML, and enter text
within the layout frame, to make animated text. You can
also make an animated image in the same way.

@ Click the E icon to display the dialog box for
creating dynamic HTML.

@ If necessary, change the position (Left and Top)
and size (Width and Height) of the layout frame.

€@ Select the background color from the Color list box.
(You can select the background image by clicking
the Browse button next to Image.)

Layout Frame
Layout Frame IEffact |
i}
’7 Laver! |
Explanation
- Position———————————————
Lelt: 50 3. pirels ] e
Top: 50 32 piels
- Minimum Sige —————————————————— Left HLi
widhe  [100 =] piels [ &
Height: 100 32 pirels —
Wwidth
Digplayed Size: Adjust

i Background

Image: I

Browse... |

 Stack Level

[Baody]

=l
=l

(u] 4 I Cancel | Help |

@ Click the Effect tab, which contains a list of effects
of dynamic HTML.
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(¢)Tip

If you select the Repeat
check box, you can set it to
repeat the same animation.
You can also change the
speed using the Speed
slider.

@ Select one of effects under Effect, and select one
of patterns under Pattern :

Layout Frame

Seroll
‘ipe (Appear)

Creclit

“ibration

Fiotation

@ Click the OK button to close the Layout Frame
dialog box and to create a layout frame.

B newpagel_htm - Unkitled =
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Click the layout frame, and enter text inside it. (Or
insert an image instead of text.)

newpagel_htm - Untitled =

@ To display the Layout Frame dialog box again for
reediting, click the layout frame using the right
mouse button, and select Layout Frame Attributes
from the pop-up menu.

fo)Tip (¢)Tip______________________________]

If you create multiple layout frames, or if it is difficult to select
a layout frame that has a color similar to the background,
select Layout Frames List from the View menu to display
The advantage of dynamic the following dialog box:

HTML is that it is flexible. :

For example, you can
create complex movements
by creating multiple layout
frames and entering
different text or images into
them. In particular, if you

Have fun and challenge
your creativity!

insert an animated GIF Select the target layout frame from this list, and click the Edit
image, you can combine button to display the Layout Frame dialog box of the target
both the animation of the layout frame.

image and the effect of To delete a layout frame, select a layout frame from this list,
dynamic HTML. and click the Delete button. If you delete all the layout
“Creating on animated frames within a Web page, all the script code for the

GIF”" on page 10-20 dynamic HTML is automatically deleted.
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Chapter

Uploading Web pa 19

This chapter explains how to upload your Web pages to your
provider’s server to make them accessible on the Internet.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

i e B Wl — %% Before uploading ....................... 12-2
Next, read “Uploading the en- —— x%* Uploading the entire site .............. 12-9
tire site,” “Uploading a Web .

A S . x% Uploading a Web page .............. 12-12
cording to what you want to do. *x Uploading files........................ 12-14

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 12-1



Before uploading the entire site, you must specify the destination server. Also, you
can find and correct errors in your site with the Site Check function.

You must create a site be-
fore doing this task.

“Creating a site” on
page 4-4

Registering the destination server

To register such server information as the destination
server name, user ID, password, and destination folder,
all of which are necessary for uploading:

@ Select Site Wizard from the Site menu to start the
site wizard, which is the same as the one you used
to create the site.

@ Select Change the Existing Site Settings , and
select a site name.

Select Operation

- Select an Operation

STl

2l € Ceacasie ~
Site Name ,'i ”

Specily a name for the site. Choose a
ame that is easy to understan

<Back Hewt> Cancel | Hep |

€@ Click the Next button. The Set Site Items dialog
box appears, displaying the items you have already
specified.
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@ Vocabulary

server profile

A set of such server infor-
mation as the destination
server name, user ID, pass-
word, and destination
folder. Its default name is
the corresponding site
name, but you can change
it.

O
Enter the values in these
boxes that your provider in-
structs. For example, if you
are instructed to “place data
in the public_html folder,”
enter “public_html” in the
Destination Folder box.
Do not place a slash “/” at
the beginning. If you are in-
structed to “place data in
the /home/username
folder,” place a slash “/" at
the beginning and enter it
as “/lhome/username.” Con-
tact your provider on any-
thing that is unclear.

Server Profile Name box:

Setup Destination Server

@ Click the Next button. The Setup Destination
Server dialog box appears, in which the same
name as the site is automatically entered in the

- Destination Server Seting;
= Server Profile Name:
My Site] |

Specily a name for the server settings. Choose the
same name as the site name,

# Destination Server Name:

= User 1D * Password:

Specily the destination folder{directory] guided by vour
b
[for example, public_htrl)

Specify a server name, a user |D, and a password, The settings in this
page is are required
for transtering pages.
* Destination Folder Browse. “fou can skip the:
stings, and reda
them after using this
Site Wizard

Detail Setings |

<Back [ MWew> |  Camcel |

Help

Enter the address of your provider’s server in the

Destination Server Name box.

Enter your user ID in the User ID box, your pass-
word in the Password box, and the server’s folder

name in which you upload your files in the Destina-
tion Folder box. (The values in the following figure

are examples.)

Setup Destination Server

~ Destination Server Setting:
= Server Profile Name
s et

My Site: =l

Specify a name for the server sattings. Chaoss the

SaMe hame as the site name,

* Destination Server Name:

|np.mm.ne i

= User ID: * Password:

[rouseid [

Specily a server name, 2 user |D), and & password The seltings in this
page is are required
for ransfering pages.

* Destination Folder Browse... *f'ou can skip the
settings. and 1edo

public:_htrl them after uging this

Specily the destination folder(directory) guided by your | Site Wizard

provider

[for example,, public_htmi)

Detal Setings |
<Back Carcel | Help
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)T
If you are uploading files from a LAN-connected personal
computer through a firewall, click the Detail Settings button
and set the firewall. Only the “SITE hostname” type firewall

is available. If you do not know your firewall format, contact
your system administrator.

@ Click the Next button to display the final dialog box.

DOperation after Setting Completion

@ @ Click the Finish button to complete the settings.

If you want to cancel a
server registration, select
Destination Server Setup
from the Site menu, select
a profile name from the
Registered Server list,
click the Delete Server but-
ton, and click the OK but-
ton.

12-4 Homepage Builder User’s Guide



Before doing this task, save

all the Web pages you are
currently editing.

Correcting errors

The Site Check function enables you to find the following
errors in the entire site:
e Images without alternate text

e Spelling errors
@ Select Site Check from the Site menu to display

the Site Check dialog box.

@ Select a site name from the Site to Check list box.
(If you open a site, you can select only that site. If
you do not open a site, you can select any one from
all the registered sites.)

€l You can select either the Alternate Text check box
or the Spelling check box, or you can select both of
them.

Site Check

Site to Check:

Wy Site:
[V &kemnate Test ¥ Speling Cancel |

@ Click the Start button to start searching for errors.
When the search is complete, the Find Result
dialog box is displayed. The file names of the Web
pages with errors and the types of errors are dis-

played.

File Mame | Mo Alternate Text | Misspelled |
C:hmysitetsub3 htm ®

C:Amwsitemap. htm

C:hmpsitetsubl.htm

C:hmpsitetsubZ htm

Cohmusitetw ave T exthiw/ave Text htm

P

Stop Bt Close Help
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12-6

@ Select a file name, and click the Open File button
to open the corresponding Web page.

@ Correct the errors as follows:

e To add alternate text, select URL Editor from
the Tool menu, select the Image or Linked
Image button on the URL Editor, and enter
alternate text.

e To fix spelling errors, select Spelling from the
Edit menu. Enter the correct spelling using the
Spelling dialog box.

(For details, click the Help button on the URL Editor
or the Spelling dialog box.
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(1)Note

Before doing this task,
place the target files into the
site folder.

Registering a file as the one to be uploaded

Homepage Builder categorizes files in the site folder as
either “unused files” or “files to be transferred. ” Remem-
ber that if you upload the entire site, only the “files to be
transferred” are uploaded. This section explains how to

change an “unused file” into a “file to be transferred.”

@ Open a site.

“Opening a site and a Web page” on page 4-11

@ Click the File tab, and click Unused Files to display

the list of files that Homepage Builder regards as
unused files, in the lower half of the File pane.

|My Site

|

[=-&8 My Sie

o B WaveTent

E| {21 Top Folder(C:vmysitet]

Files to Be Transfered
Unused Files

Narne

[ Title

.Weadme htm
[™ index bak
[ map.bak
map.gif
map.htm
[ sub.bak
[ subZ bak
[™ sub3.bak
D frame. bak,
@ Frame. htm

|

Readme First

ABC Flarist

ABC Florist

Link. File: Contents

Chapter 12. Uploading Web pages
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OUI———

If you find an unnecessary
file among the Unused
Files list, delete it by click-
ing the file name using the
right mouse button, and se-
lecting Delete from the pop-
up menu.

€@ Click the target file using the right mouse button,
and select Add to transferred list  from the pop-up
menu.

ek My Site
E& Top Folder(C: \mysitel)
H 0 WaveTest

% Files to Be Transfered

D index. b,

D map.bak

a map.gif

ﬂ map.htm

[ subl.bak el

[ sub2bak —
[ sub3.biak

B frame.bak.

ﬁ frame.htm

@ To check that the file has been moved, click Files
to Be Transferred in the upper half of the File
pane.

gl My Site
=3 Top Folder(C:\mysitsh)
LB wWaveTest

% Unused Files

a garde_fr.gif
a garde_bg.gif
readme. him Readme First
a indes htm
( popl.mid
ﬂ subl.htm
a sub2.htm
i‘ ActChar.class
r‘ Fontlnto.class
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You can connect to your provider’s server, and upload the entire site—that is, all the
files and subfolders that compose a site—to make your Web pages accessible on the

Internet.

Pl Note

You can do this task only
when you open a site.

OUI———

The first upload enables
you to upload all the files
and subfolders that com-
pose a site. The second
and later upload enables
you to upload only files
newly created or changed
since the previous upload.

@ Register the destination server.
“Registering the destination server” on page 12-2
@ Open a site.
“Opening a site and a Web page” on page 4-11

€@ Select File Transfer from the Site menu, and then
select Site Upload to start the upload wizard.

@ On the first dialog box of the wizard, select Select
the Existing Profile , and select a profile name
(normally the same as the site).

— Delete Prafile

e Hewt> Concel | Hep |

@ Click the Next button. The Transfer Mode Set-
tings dialog box is displayed.
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(¢)Tips

In the upper left field on the
Select Source Files dialog
box, Files Updated since
Previous Transfer is auto-
matically selected. Nor-
mally, do not change this.

You can view a list of files
stored in the site folder by
clicking the Files List but-
ton. The selected files in
the list are to be trans-
ferred. (If necessary, you
can select files that are not
selected, or you can dese-
lect files that are selected.)

You do not need to enter a
number in the Estimated
Download Time field.
However, if you want to es-
timate the time required for
uploading, enter your
computer’'s modem speed.

@ Click the Next button to display the Select Source
Files dialog box:

- Server Seltings
Gerver Name:
tpibm e ip
: UserID
Fiee Lt N or=r—
Total e size 124 K bytes ( 23 fles | Password
Dowrload Time———————— | ™™
26K Faec | | Destination Folder,
SK | 2ses || [pbichm
3 183ec | | Source Folder
[®00 o |[Eee

cBack [ Fish | Cancel | Hep |

Click the Finish button.

If your computer is not connected to the Internet, a
dialog box is displayed prompting you to connect.
After connection, the upload begins, and the follow-
ing dialog box that indicates the upload status is
displayed:

Mow Transferring

When the upload is complete, the message “Trans-
fer complete” is displayed.
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@ Click the OK button.

() Note ]

Homepage Builder regards files called by a script program, a
Java applet, an external CSS file, or a CGI program other
than the Homepage Builder samples as “unused files.” To
prevent this, you must, in advance, mark them as “files to be
transferred.” After upload, if you notice that some files were
not uploaded, mark them as “files to be transferred,” and up-
load the entire site again.

@ “Registering a file as the one to be uploaded” on page
12-7
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You can upload a single Web page with the files pasted in it at the same time. For
example, if images are pasted in your Web page, you can upload both an HTML file

and image files at once.

(1)Note ]

You cannot upload the link
destination pages in this
method, however.

OUI—

If you want to create a new
server profile, click the Cre-
ate a Profile button on the
Select Server Profile dia-
log box, enter a new profile
name, and click the Next
button to display a dialog
box for entering the server
information.

g
&

=
B

£

ABC Florist

: LRI R R N

@ Select File Transfer from the Site menu, and then
select Page Upload to start the upload wizard.

€@ On the first dialog box of the wizard, select Select
the Existing Profile , and select a profile name
(normally the same as the site).

B © Cioaoa Proic

Specify a profie name,

QD ' Select the Existing Profile
Delsts Profes

e Next > Cancel Help
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(¢)Tips

You can view a list of files
that make up your Web
page by clicking the Files
List button. The selected
files in the list are to be
transferred. (If necessary,
you can select files that are
not selected, or you can
deselect files that are se-
lected.)

You do not need to enter a
number in the Estimated
Download Time field.
However, if you want to esti-
mate the time required for
uploading, enter your
computer’s modem speed.

(1)Note

Files called by a script pro-
gram, a Java applet, an
external CSS file, or a CGl
program other than the
Homepage Builder
samples are not uploaded.
After uploading your Web
page, upload only the files
that were not uploaded.

“Uploading files” on
page 12-14

@ Click the Next button. The Select Source Files

dialog box is displayed:

Select Source Files

Files List |

Tokal file size 55 K bytes [ 9 files |

- Estimated Dowrload Time
336K 16 sec
BEK. 10sec
B4K Baec

9600 S3sec

|- Senver Settings

4 Files = Saver

Server Name

ltp.ibm.ne.p

UserID:

pusenid

Password

Destinalion Foldr

public_html

Source Folder

Cmysie

cBack | Frsh | Cancel | Hep |

@ Click the Finish button.

If your computer is not connected to the Internet, a
dialog box is displayed, prompting you to connect.
After connection, the upload begins, and the follow-
ing dialog box that indicates the upload status is

displayed:

Now Transferring

When the upload is complete, the message “Trans-

fer complete” is displayed.

@ Click the OK button.

Chapter 12. Uploading Web pages
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You can upload individual files from your computer, or delete individual files on the
provider’s server, using the File Transfer tool.

@ To start the File Transfer tool, type the following

You can use Homepage command and press Enter:

Builder’s File Transfer tool
as an FTP client program.
$ hpbuilder -f

The File Transfer main window is displayed.

bashre-file
dayplan-file
priv-file
dvipsre-file
emacs-fle
exrc-file
girpro-fle
Folder
Folder
jazz-Tile
kermrc-file

@ Open a folder where files that you want to upload
are stored.

e
(]
m|

git-ile
git-fle
git-file
ait-fle
git-le
him-file
nid-file
Folder
him-file
git-fle
git-file
ait-file
him-file
git-fle
him-file
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@ Click the Ef|icon.

@ From the list under Registered Profile , select the
name of a server profile you created for the site
upload, and click the OK button. (It you have not
created a server profile, register it. For details, click

the Help button of this dialog box.)

. o e

@ On the right side, files and folders on the server is
displayed. Select the destination folder.

L1
=Ll

[meme [ size[  Type[wod

air-file ;

git-le
git-fle
git-fle
htm-file
nid-file
Folder
him-file
git-fle
git-file
ait-file
him-file
git-fle
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To delete a file on the
server, on the right side of
the window, click a file us-
ing the right mouse button,
and select Delete from the
pop-up menu.

On the left side, click to select a file you want to
upload. (To select all the files in a folder, click the
list of files using the right mouse button, and select
Select All from the pop-up menu.)

@ Click the icon to upload the selected file or
files. (files appear to be copied from the left side to
the right side.)
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Chapter

Other functions 13

This chapter explains convenient functions that have not been
explained in the preceding chapters.

Before doing the tasks in this chapter

1. Start Homepage Builder.

“Starting and ending Homepage Builder” on page
2-5

2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
[ J

*  Editing HTML directly ................ccceenits 13-2
*  Downloading a Web page .................... 13-5
*  Other functions: Intermediate ............... 13-6
*  Other functions: Advanced ................... 13-8

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 13-1



Editing HTML directly

If you know HTML tags well, or if you wish to enter HTML tags other than those
Homepage Builder supports, edit HTML directly. Appendix B, “HTML tags”

¢ Tip

To edit your Web page both
on the Normal pane and on
the HTML source pane
simultaneously, click your
Web page using the right
mouse button, and select
Open in New Window to
open the same Web page
in another window. If you
click the Normal tab on one
window, and the HTML
source tab on the other
window, you can edit while
comparing the two.

Editing the HTML source

To edit the HTML source directly, click the HTML Source
tab. The content of the HTML source is then displayed.
You can rewrite it as you like. Click the Normal tab to
return to the WYSIWYG editor.

Entering an HTML tag

You can directly enter an HTML tag, even on the Normal
pane.

@ Position the cursor on the location where you want
to insert an HTML tag.

@ Select HTML Tag from the Insert menu to display a
dialog box for entering an HTML tag.
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(¢) Tips

While you are editing your
Web page on the Normal
pane, the HTML tag name
at the cursor position is
displayed on the status bar.
To quickly display the
Attribute dialog box for the
target HTML tag, click the
button in the lower right
corner, and select the target
HTML tag name from the
pop-up menu that indicates
the HTML structure. Note
that some HTML tags have

no attributes to be changed.

Attributes of IMG
Afributes of TD
Attibutes of TR
Attributes of TABLE
Attibutes of BODY

€ Enter an HTML tag, and click the OK button to
insert the tag at the cursor position.

HTHML Tag
,TI Cancel Help
Entering HTML tag attributes

If you know attribute keywords such as “align” and “src,”
you can directly enter the attribute values, even on the
Normal pane, using the Universal Attribute Editor.

@ Click the target element.

index_htm - ABC FI{

v Flotal )
rArrangements i
: o |

@ Select Universal Attribute Editor  from the Tool
menu to open the Universal Attribute Editor.
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e Editor <IMG:

@ Click the Apply

(1)Note

By using the Universal At-
tribute Editor, you can edit
even some attributes that

Homepage Builder cannot
display.
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€ On the left side of the editor, all the HTML tags
within the Web page you are currently editing are
displayed. Click an HTML tag to display its attribute
keywords on the right side. Click one of keywords,
and enter its value in the Attribute Value box.

=

button.



Downloading a Web page

You can open a Web page on the Internet that begins with “http://” and save its files to
your computer. This is referred to as downloading.

@ Select Open URL from the File menu to display a
dialog box for opening a Web page on the Internet.

@ “http://” is already entered, so enter the rest of the
URL.

Open URL

| hitp:Aawran ibm.com¢ =
ok || cancel | Help |

€@ Click the OK button to download and open the Web
page.

@ To save the downloaded Web page, select Save As
from the File menu, specify the location for saving
it, and click the Save button to save all the files that
make up the Web page.
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The following functions are convenient for intermediate users:
e Registering frequently used folders as bookmarks
e Entering your comments

fo)Tip

To edit the registered
bookmarks, click the # icon
to display the dialog box for
editing bookmarks. This
dialog box enables you to
rename the bookmark titles
or to delete unneeded
bookmarks. For details,
click the Help button of this
dialog box.

Registering frequently used folders as bookmarks
After registering folders you frequently use as bookmarks
of the Contents tab, you can easily open them.

Click the Contents tab.

@ Click a folder using the right mouse button, and
select Add Bookmark to register the folder as a
bookmark.

Tlowr 1 gif flowr_i2 gif

€l To open a registered folder, select the folder name
from the uppermost box of the Contents pane.

‘S\te is nat open,

Erra L

*Sample Materials
mage
Sound

Java Applet
JavaScipt
= Template Materials

i
C./mysite
o ik 11 =
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Entering your comments

A comment element (the <!-- --> tag) is never displayed
on Web browsers. You can use it as your memorandum.

@ Select Comment from the Insert menu.

@ Enter your comments, and click the OK button to
insert them.

Edit Comment t 1 3
This is the comment] =

o o

o | Cancel | Hep |

The i mark is displayed at the cursor position.
This mark is not displayed on Web browsers.

€ To read or edit your comments, click the { mark
using the right mouse button, and select Attributes
from the pop-up menu.
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Other functions: Advanced

The following functions are convenient for advanced users:
e Creating a channel file
e Changing heading levels
e Creating an index
e Creating a site map

(4) Vocabulary ] Creating a channel file

channel You can create a channel file and set a link to it. Readers
A Web site that is delivered can then register your Web site as a channel.

to the readers periodically

according to the schedule @ Select Create Channel from the Tool menu, and
the Web site creator then select Netscape Channel. You can create a
determines. channel file for Netscape Navigator.

@n_ @ Create a channel file.

€@ Create a button image with text such as “Register
Channel,” paste it into your Web page, and set a
link from the button image to the channel file.

Some Web browsers do not
have the channel function.
Internet Explorer 4.0,
Netscape Navigator 4.0, a
later version of these have
the channel function.

Upload the channel file and your Web page that
includes the button image to your provider's server.
Readers can then register your Web site as a

@n_ channel, just by clicking the button image.
vou cannot reedita channel | @RI

file for Netscape Navigator. Because Homepage Builder regards files called by your
channel file as “unused files,” register them as “files to be
transferred” before uploading.

“Register a file as the one to be uploaded” on page 12-7
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Changing heading levels

If you are editing a long Web page, and if you want to
change the levels of several headings at once, use the
Heading Editor.

@ Select Heading Editor from the Tool menu to
display the Heading Editor.

@ Click a heading, and click the << button to raise the
level or the >> button to lower the level. Repeat
this to adjust the levels of all the headings within
the Web page.

Heading Editar

Flaral Arrangements
Wedding Services
ABC Florist
Order Form
il

€@ Click the OK button.

Creating an index

You can create an index from the headings of your Web
page.

@ Select Index from the Insert menu to display a
dialog box for creating an index.
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(¢)Tip

Under Labels, select one of
the following:

e Add Labels and Links to
the table of contents to
This Document , to
enable a visitor to jump
from the index to the
headings, and vice versa.

e Add Labels to This
Document , to enable a
visitor to jump from the
index to the headings.

e Do not add Any Labels
to permit no jumps.

@ Under Headings , select the heading levels you
want to include in the index. Under Output , select
the location to transfer the index. (If you select
Another File , specify the file name, too.) Under
List Type , select the list type. (An index is created
in the list format. ) Under Label, select how to
attach labels.

Create Table of Contents x|
—Heading

v L ¥ Heading2 [ Heading3
[~ Headingd [~ Heading5 I Heading &

— Output
& Top of This Document
" Cursor Position Browse... |
" Another File
 List Type
& Bullsted List " Ordered List
 Lawel

o Add Labels and Links to the table of contents ta
This Document

" add Labels to This Document
" Do Mot Add sny Labels

QK I Cancel | Help |

€@ Click the OK button to create the index as you
specified.

e Floral Arrangements

« Wedding Services
« ABC Florist
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Creating a site map

You can create a site map, which contains links to all the
Web pages in your site. To create it, open a site, and
select Create Site Map from the Site menu. The
following figure is an example of a site map.

Site Map

o ABC Florist
o Floral Arrangements 13

o Wedding Services
m Wave Text

o OrderForm
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Appendix A. Homepage Builder functions

The following tables explain the Homepage Builder functions:

Page-editing functions

Page editing
(You can check the layout
in WYSIWYG.)

e Support of such views as

"Normal" (WYSIWYG) and "HTML

Source." (For the frame-using

pages, the "Frame HTML Source"

view and "No Frame" view are
also available)

e Creating pages using the wizard

e Editing multiple pages simulta-
neously

e Checking the display on multiple
Web browsers

e Hiding table borders

e Background colors for table, row,
and cell

e Background image for cell

e Creating a table and rows, and
specifying the table title

e Converting the CSV format table
to the HTML format table (with a
drag-and-drop operation; through
the clipboard; from a file)

Partial support of HTML 4. 0

Support of style sheets

o Partial support of CSS Level 1
(based on W3C)
e Support of CSS-P (positioning)

Form

e Such input fields as check boxes,
radio buttons, send buttons, reset
buttons, option menus, list boxes,
and text entry fields

Offering and customization o

dynamic HTML

Text format

e Support of such paragraph types
as heading, preformatted,
address, and block quote

e Lists

e Superscript and subscript

e Alignment

e Indent

e Font color, size, and face

Frame

o WYSIWYG editing within frames

e Converting a normal page into a
frame page

e Creating frames with the mouse
operation

e Specifying frame size (pixels, %,
or automatic)

e Specifying frame-border width

e Specifying scroll-bar format

Document format

e Text color

e Link color

e Background color

e Background image

e Document title

e Editing meta-information

Script editing

e Editing and inserting JavaScript
and VBScript

e Samples of objects, properties,
and methods

Editing of comments

Insertion of plug-in objects

e Inserting Shockwave, VRML, and
sound files

Text flow around a table or an image

Link

e Links to external Web pages,
other documents, and FTP

o Links within a document

e E-mail (mailto:)

e Setting a link by dragging and
dropping a file from the Link view

e Reading the link destination page
(remote and local)

Table

e Creating a table, specifying
numbers of rows and columns

e Resizing a table with the mouse
operation

e Inserting or deleting columns and
rows

e Merging and splitting cells

e Setting cell size, ruled line width,
and padding

e Setting multiple cells at once, by
selecting multiple cells

Insertion of dates and
times

e Inserting the document-created
date and time

Editing of HTML source

e Editing HTML tags directly

e Colored display of HTML tags for
easy editing

e Finding and replacing text

e Jumping to a field that has a
syntax error

Pasting of images

e Moving and copying images with
drag-and-drop operations

e Changing the image display size

e Pasting an image from another
program through the clipboard

Index creation

e Creating an index from headings
in a Web page

e Creating links between the index
items and headings
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A-2

Page-editing functions

Image-processing functions

URL Editor

e Displaying all the links and
alternate text in a Web page
e Editing links and alternate text

Universal Attribute Editor

o Displaying all the attributes for an
HTML tag
e Setting attribute values

Displaying the document
size and the estimated
download time

e Displaying the size of the
document and files that make up
the document

e Displaying the estimated
download time at each
transmission speed

Spelling check

e Detecting and correcting spelling
errors

e Dictionaries for the U.S. and the
U.K.

Support of many image
formats

e GIF, JPEG, PNG, BMP, WMF,
TIFF, FlashPix, and Photo CD

Image conversion

e Converting from the preceding
image formats to the GIF or JPEG
format.

e GIF transparent coloring

o GIF interlacing

e JPEG progression

e JPEG compression rate change
(enabling you to preview it)

e Converting between GIF and
JPEG

e Trimming

Changing of image file size

e Not only can the screen display
size be changed, but also the file
size can be changed in line with it

Homepage Builder User’s Guide

Color reduction and
adjusting quality

e Enabling the reduction of the
amount of image data, by
reducing the number of colors
used in GIF images and adjusting
the JPEG quality

Image map creation

e Support of three types of image
maps: client side image map and
two types of server side image
maps (CERN and NCSA)

e Specifying areas in circles,
rectangles, and polygons on
images and set link destinations

Creating animated GIFs

e Creating animated images using
Web Animator.

e Enabling image movement, size
change, cutting and pasting,
rotation and up-down inversion

e Thumbnail display of all frames

e Animation effects such as "wipe"
and "fade-in"

Logo creation

e Text decoration (anti-alias,
bordering, spacing, alignment,
layout, transforming, and so on)

o 2D effects (blur, shadow,
embossment, flame, and so on)

Lettering on buttons

e Entering lettering onto buttons
with such shapes as squares,
ellipses, arrows, or with such
textures as marble, aluminum,
grain

Decoration of photos with

e Pasting such frames as

photo frames negativelike and decorative
frames
Retouching of digital photos | e Adjusting brightness and contrast
e Applying effects

Paint




Site-management functions

Samples

Structuring of site by linking
with page editing

e Renewing links along with file
operations

Templates

e Such template genres as
business, hobby, nature, science,
school, texture series, and
conceptual series

Sample materials

Link view e Tree display of site configuration
e Displaying to-and-from links
e Detecting link setting errors
o Displaying unnecessary files
File view e Displaying files to be transferred

e Such materials as images,
animated GIFs, sounds (MIDI),
and Java applets

e Displaying unused files

Detection of errors for the
entire site at once
(site check)

o Spelling check
e 'Alternate text' check

Finding text within the entire site

Site upload

e Preparing upload using the wizard

e Automatically detecting all files
that make up the site

e Automatically detecting updates

e Uploading only updated or new
files

e Displaying estimated uploading
time

Page upload

e Detecting all files that make up a
Web page and uploading them
(link destination pages are not
uploaded)

Management of multiple
sites

e Setting a profile (the destination
server, user ID, and password) for
each site

e Managing the file-transferring log
for each site

Detection and deletion of
unused files

e Automatically detecting unused
files within a site folder and
deleting them (on local machine
only)

File Transfer tool

o Transferring only individual files,
regardless of the concept of Web
pages

e Registering multiple FTP servers

Contents view

e Displaying files such as images,
HTML files, and Java applets

e Previewing images

e Pasting images into Web pages
with a drag-and-drop operation

Creating a channel file

e Creating the Netcaster Script file

Creating a site map using HTML
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Appendix B. HTML tags

HTML tags and attributes available

The following table lists all the HTML tags and their attributes available with Homepage
Builder. Asterisks (*) are attached to tags and attributes that are not defined in HTML 4.0.

(I)Note

If you open a Web page in which tags or attributes other than the following are em-
bedded, Homepage Builder issues either of the following error messages: “Un-
known tag” or “The attribute is invalid.”

Editing on Displaying on
i § the Normal | the Normal
Generic attribute group (Note 1) pane pane(Note 3)
o F=Full o F=Full
Tag Description support support
® P = Partial | ® P = Partial
support support
Attribute Attribute value ® N =No ® N =No
support support
(Note 2)
A core, internationalization, event anchor F F
charset char encoding of linked resource N N/A
type content type N N/A
name label F N/A
href URL for linked resource F F
href langlanguage code N N/A
target target F N/A
rel link destination type N N/A
rev link source type N N/A
accesskey accessibility key character N N/A
shape rect type of drawing N N/A
coords for use with client-side image maps N N/A
tabindex tab index N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
ABBR core, internationalization, event abbreviated form N F
ACRONYM | core, internationalization, event acronym N F
ADDRESS | core, internationalization, event information on author F F
APPLET core Java applet F F
codebase optional base URL for applet F N/A
archive archive list N N/A
code applet class file F N/A
object serialized applet file N N/A
alt short description F N/A
name name N N/A

Note 1 Generic attribute group refers to the three attribute groups: core, internationalization, and event. “Generic attributes group” on page B-9

Note 2 You cannot edit N-marked tags and attributes on the Normal pane, but you can directly edit them on the HTML Source pane or other text editors.
“Editing HTML directly” on page 13-2

Note 3 Some tags and attributes change the Web page appearance. Normally you can see the changes on the Normal pane, but sometimes you cannot. The
marks F, P, and N indicate the support for displaying the appearance changes on the Normal pane. N/Aindicates that the tag or attribute does not
change the Web page appearance.
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width width F F
height height F F
align top, middle, bottom,left, | vertical or horizontal alignment F F
right
hspace horizontal gutter F F
vspace vertical space F F
AREA core, internationalization, event client-side image map area F N/A
shape rect, circle, poly type of drawing F N/A
coords comma-separated list of lengths F N/A
href URL for linked resource F N/A
target target F N/A
nohref no URL N N/A
alt short description F N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus N N/A
onblur action when focus lost N N/A
B core, internationalization, event bold text style F F
BASE document base URL F N/A
href base URL F N/A
target predetermined value of target F N/A
BASEFONT base font size N N
id style ID N N
size size N N
color text color N N
face comma-separated list of font names N N
BDO core, internationalization directionality N N
BIG core, internationalization, event large text style N F
BLINK * core, internationalization, event blinking F F (Note 4)
BLOCKQUOTE| core, internationalization, event long quotation F F
cite \ quotation source N N/A
BODY core, internationalization, event document body F F
onload action when the document has been loaded F N/A
onunload action when the document has been removed F N/A
background background image F F
bgcolor background color F F
text text color F F
link color of links F F
vlink previously read link color F N/A
alink color of selected links F N/A
BR core forced line break F F
clear \ left, all, right, none control of text flow F F
BUTTON core, internationalization, event push button F F
name name F N/A
value value F N/A
type button, submit, reset type F N/A
disabled disabled unavailable in this context F F
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
CAPTION core, internationalization, event table caption F F
align \ top, bottom, left, right alignment F F
CENTER core, internationalization, event center F F
CITE core, internationalization, event citation F F
CODE core, internationalization, event computer code fragment F F
COL core, internationalization, event table column N N
span number of columns N N
width width N N
align left, center, right, justify, | horizontal alignment N N
char

Note 4 This tag is indicated by its red color. (It does not flash.)
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char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N N
baseline
COLGROUP | core, internationalization, event table column group N N
span number of columns N N
width width N N
align left, center, right, justify, | horizontal alignment N N
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N N
baseline
DD core, internationalization, event definition description F F
DEL core, internationalization, event deleted text N N
cite [ comment N N/A
datetime ‘ date and time of change N N/A
DFN core, internationalization, event definition description F F
DIR core, internationalization, event directory list N F
compact \ compact compact N N
DIV core, internationalization, event layout container F F
align ‘ left, center, right, justify | alignment P (Note 5) P (Note 5)
DL core, internationalization, event definition list F F
compact \ compact reduced interitem spacing N N
DT core, internationalization, event definition term F F
EM core, internationalization, event emphasis F F
EMBED * core, event plug-in F F
src object F N/A
height height F F
width width F F
align alignment F F
hspace horizontal gutter F F
vspace vertical space F F
loop loop N N/A
hidden hidden N N
volume volume N N/A
autost artauto-start N N/A
repeat repeat N N/A
panel panel N N
text title N N
palette palette N N
textfocus focus N N/A
FIELDSET core, internationalization, event input field group N N
FONT core, internationalization font F F
size ‘ size F F
color text color F F
face comma-separated list of font names F F
FORM core, internationalization, event interactive form F F
action server-side form handler F N/A
method GET, POST HTTP method used to submit the form F N/A
enctype type of encoding F N/A
onsubmit action when the form is submitted F N/A
onreset action when the form is reset F N/A
target target F N/A
accept-charset list of supported character sets N N/A
FRAME core subwindow F F
longdesc link to long description N N/A
name frame name F N/A
src URL such as file name F F
frameborder 1,0 border N N/A
marginwidth margin width in pixels F N

Note 5 Except for “justify,” both editing and displaying are supported.
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marginheight margin height in pixels F N
noresize noresize does not allow users to resize frames F N
scrolling yes, no, auto scroll bar F N
FRAMESET | core window subdivision F F
rows number of up-down divisions F F
cols number of left-right divisions F F
onload action when all the frames have been loaded N N/A
onunload action when all the frames have been removed N N/A
frameborder * display of borders F P (Note 6)
border * border width F P (Note 6)
H1 core, internationalization, event heading 1 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H2 core, internationalization, event heading 2 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H3 core, internationalization, event heading 3 F F
align ‘ left, center, right, justify | alignment P (Note 5) P (Note 5)
H4 core, internationalization, event heading 4 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H5 core, internationalization, event heading 5 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H6 core, internationalization, event heading 6 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
HEAD internationalization document head F N/A
profile \ named dictionary of meta-information N N/A
HR core, event horizontal rule F F
align left, center, right alignment F F
noshade noshade no shading F F
size thickness F F
width width F F
HTML internationalization HTML document F N/A
version \ version N N/A
| core, internationalization, event italic text style F F
IFRAME core inline subwindow N N
longdesc detailed explanation N N
name frame name N N
src URL such as file name N N
frameborder 1,0 border N N
marginwidth margin width in pixels N N
marginheight margin height in pixels N N
scrolling yes, not, auto scroll bar N N
align top, middle, bottom, left, | vertical or horizontal alignment N N
right
height height N N
width width N N
IMG core, internationalization, event image F F
src file name F F
alt short description F N/A
longdesc detailed explanation N N/A
height height F F
width width F F
usemap CSIM map name F N/A
ismap ismap use of server-side image map F N/A
align top, middle, bottom, left, | vertical or horizontal alignment F F
right
border border width F F
hspace horizontal gutter F F
vspace vertical space F F
name * name N N/A
INPUT core, internationalization, event input field F F

Note 5 Except for “justify,” both editing and displaying are supported.
Note 6 Attribute values other than 0 can be displayed.
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type text, password, checkbox, type P (Note 7) P (Note 7)
radio, submit, reset, file,
hidden, image, button
name name F N/A
value value F F
checked checkeds elected radio buttons and check boxes F F
disabled disabled unavailable in this context F N
readonly readonly no entry possible F N/A
size number of columns F F
maxlength maximum characters for text fields F F
src image file name F F
alt short description F N/A
usemap CSIM map name N N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onselect action when some text is selected F N/A
onchange action when the element value is changed F N/A
accept list of MIME types for file upload N N/A
align top, middle, bottom, left, | vertical or horizontal alignment N N
right
INS core, internationalization, event inserted text N N
cite \ comment N N
datetime \ date and time N N
ISINDEX core, internationalization index search N N
prompt \ prompt message N N
KBD core, internationalization, event text to be entered by the user F F
LABEL core, internationalization, event label of input field N N
for ID for input field N N
accesskey accessibility key character N N
onfocus action when the element gets the focus N N
onblur action when focus lost N N
LEGEND core, internationalization, event fieldset legend N N
accesskey ‘ accessibility key character N N
align \ top, bottom, left, right alignment N N
LI core, internationalization, event list item F F
type 1,a,A, il disc, square, |type F F
circle
value number F F
LINK core, internationalization, event a media-independent link F N/A
charset encoding of link destination text N N/A
href URL for linked resource F N/A
hreflang language code N N/A
type content type N N/A
rel link destination type N N/A
rev link source type N N/A
media media N N/A
target target N N/A
MAP core, internationalization, event client-side image map F N/A
name [ map name F N/A
MENU core, internationalization, event menu list N F
compact ‘ compact compact N N
META internationalization generic meta-information F N/A
http-equiv HTTP response header name F N/A
name NAME item F N/A
content associated information F N/A
scheme scheme N N/A
NOFRAMES | core, internationalization, event alternate content container for non-frame-based rendering F F
NOSCRIPT | core, internationalization, event alternate content container for non-script-based rendering N N
OBJECT core, internationalization, event generic embedded object F F

Note 7 Except for “type=file,” displaying is supported.
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declare declare declaration N N/A
classid object F N/A
codebase base URL for classid, data, archive F N/A
data reference to object's data F N/A
type data type F N/A
codetype content type for code F N/A
archive archive list F N/A
standby standby character F N/A
height height F F
width width F F
usemap CSIM map name N N/A
name name N N/A
tabindex tab index N N/A
align top, middle, bottom, left, | vertical or horizontal alignment F F
right
border border width F F
hspace horizontal gutter F F
vspace vertical space F F
oL core, internationalization, event ordered list F F
type 1,aA il item type F F
compact compact reduced interitem spacing N N
start starting number F F
OPTGROUP | core, internationalization, event option group N N
disabled \ disabled unavailable in this context N N
label \ label N N
OPTION core, internationalization, event selectable choice F F
selected selected selected F F
disabled disabled unavailable in this context N F
label label N N/A
value value F F
P core, internationalization, event paragraph F F
align left, center, right, justify | alignment P (Note 5) P (Note 5)
PARAM named property value F N/A
id ID N N/A
name name F N/A
value value F N/A
valuetype DATA, REF, OBJECT type of value N N/A
type content type N N/A
PRE core, internationalization, event preformatted text F F
width ‘ maximum number of characters in a line N N
Q core, internationalization, event short inline quotation N N
cite \ quotation source N N
S core, internationalization, event strike-through text style F F
SAMP core, internationalization, event sample program output, scripts, and so on F F
SCRIPT script statements F F
charset character encoding for external file N N/A
type content type N N/A
language language F N/A
src external file name F N/A
defer defer defer N N/A
event (unused) N N/A
for (unused) N N/A
SELECT core, internationalization, event option selector F F
name name F N/A
size number of rows F F
multiple multiple multiple selection permitted (default is single selection) F F
disabled disabled unavailable in this context F F
tabindex tab index N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onchange action when the element value is changed F N/A

Note 5 Except for “justify,” both editing and displaying are supported.
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SMALL core, internationalization, event small text style N F
SPAN core, internationalization, event style container N F
STRIKE core, internationalization, event strike-through text N F
STRONG core, internationalization, event strong emphasis F F
STYLE internationalization style info F F
type content type N N/A
media media N N/A
title title N N/A
SuB core, internationalization, event subscript F F
SUP core, internationalization, event superscript F F
TABLE core, internationalization, event table F F
summary summary N N
width width F F
border border width F F
frame void, above, below, type of border N N
hsides, Ihs, rhs, vsides,
box, border
rules none, groups, rows, cols, all| type of ruled line N N
cellspacing spacing between cells F F
cellpadding spacing within cells F F
align left, center, right table position relative to window F F
bgcolor background color F F
datapagesize (unused) N N
height * height F F
background * background image F F
TBODY core, internationalization, event table body F F
align left, center, right, justify, | horizontal alignment N P (Note 5)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N P (Note 8)
baseline
D core, internationalization, event table data cell F F
abbr abbreviation for header cell N N/A
axis names groups of related headers N N/A
headers header cell ID N N/A
scope header cell scope N N/A
rowspan number of rows spanned by cell F F
colspan number of columns spanned by cell F F
align left, center, right, justify, | horizontal alignment P (Note 9) P(Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment P (Note 8) P (Note 8)
baseline
nowrap nowrap no automatic word wrap F F
bgcolor background color F F
width width F F
height height F F
background * texture tile for document background F F
TEXTAREA | core, internationalization, event multi-line text field F F
name name F N/A
rows number of rows F F
cols number of columns F F
disabled disabled unavailable in this context F N
readonly readonly no entry possible F N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A

Note 5 Except for “justify,” both editing and displaying are supported.
Note 8 Except for “baseline,” both editing and displaying are supported.
Note 9 Except for “justify" and “char,” both editing and displaying are supported.
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onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onselect action when some text is selected F N/A
onchange action when the element value is changed F N/A
TFOOT core, internationalization, event table footer N F
align left, center, right, justify, | horizontal alignment N P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N F
baseline
TH core, internationalization, event table header cell F F
abbr abbreviation for header cell N N/A
axis header cell group N N/A
headers header cell ID N N/A
scope header cell scope N N/A
rowspan number of rows spanned by cell F F
colspan number of columns spanned by cell F F
align left, center, right, justify, | horizontal alignment P (Note 9) P (Note 9)
char
char alignment character N N/A
charoff offset for alignment character N N/A
valign top, middle, bottom, Vertical position alignment P (Note 8) P (Note 8)
baseline
nowrap nowrap no automatic word wrap F F
bgcolor background color F F
width width F F
height height F F
background * background image F F
THEA Dcore, internationalization, event table header N F
align left, center, right, justify, | horizontal alignment N P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N P (Note 8)
baseline
TITLE internationalization document title F F
TR core, internationalization, event table row F F
align left, center, right, justify, | horizontal alignment P (Note 9) P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment P (Note 8) P (Note 8)
baseline
bgcolor background color F F
background * background image F F
TT core, internationalization, event teletype or monospaced text style F F
U core, internationalization, event underlined text style F F
UL core, internationalization, event unordered list F F
type \ disk, square, circle item type F F
compact ‘ compact reduced interitem spacing N N
VAR core, internationalization, event instance of a variable or program argument F F

Note 8 Except for “baseline,” both editing and displaying are supported.
Note 9 Except for “justify” and “char,” both editing and displaying are supported.
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Generic attributes group

The following table lists the attributes included in the three attribute groups core,

internationalization, and event.

Editing on Displaying on
the Normal | the Normal
pane pane
Attribute group Attribute Description
e F=Full e F=Full
support support
® No
support
core id document-wide unique ID F F
class space-separated list of classes F F
style style information F F
title advisory title or amplification N N/A
internationalization lang language code N N/A
dir direction for weak or neutral text N N/A
event onclick action when a mouse button is clicked F N/A
ondbilclick action when a mouse button is double-clicked F N/A
onmousedown action when a mouse button is pressed down F N/A
onmouseup action when a mouse button is released F N/A
onmouseover action when a mouse pointer is moved onto F N/A
onmousemove action when a mouse pointer is moved within F N/A
onmouseout action when a mouse pointer is moved away F N/A
onkeypress action when a key is pressed and released F N/A
onkeydown action when a key is pressed down F N/A
onkeyup action when a key is released F N/A
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Appendix C. Image file formats

You can paste such image files as photos taken with digital cameras and illustrations
created with other applications into the Homepage Builder editor. They are automati-

cally converted into GIF or JPEG format. “Inserting an image” on page 7-2

You can also handle image files using the Homepage Builder's accessory tools
WebArt Designer and Web Animator.

Image file formats available

The following table explains how you can handle each image file format using Homepage

Builder and its accessory tools. F means full support; P partial support; N no support.
The file extensions are in parentheses ().

Image file format

Homepage Builder

WebArt Designer

Web Animator

Pasting Saving Reading Saving Reading Saving
GIF (*.gif) F F F F F F
JPEG (*jpg) F F F F F N
PNG (*.png) F P (Note) F F F N
BMP (*.bmp) F N F F F N
WMF (*.wmf) F N F N F N
TIFF (*.tif) F N F N F N
FlashPix (*.fpx) F N F N F N
Photo CD (*.pcd) F N F N F N
DCM (*.dcm) F N F N F N
MIF (*.mif) F N F F F N

Note  You can save an image as a PNG file only if you paste a PNG file on the Homepage Builder editor.
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Explanation of image file formats

Image File _
Format Explanation
GIF (*.gif) GIF stands for Graphics Interchange Format. It can handle only a maximum of

256 colors, but because of its advantage in reducing the size of files, it is
generally used on the Internet to the same extent as JPEG. It is recommended
that you save images that do not require many colors as a GIF file.

GIF files include not only static image but also animated image, which is called
animated GIF. Animated GIF is a combination of multiple images. Both static
GIF and animated GIF can be pasted in the same way on the editor of Homepage
Builder.

JPEG (*.jpg)

JPEG stands for Joint Photographic Experts Group. Itis in general use on the
Internet because of its small file size and inconspicuous image degradation. Itis
recommended that you save full-color images such as photos taken with a digital
camera as JPEG.

PNG (*.png) PNG stands for Portable Network Graphics. It is a new image file format that is
similar to GIF, but it can handle more colors than GIF and it does not lose data
even when compressed. There are still few Web browsers compatible with it, but
it is expected to come into general use on the Internet.

BMP (*.bmp) BMP stands for bitmap. It has been adopted as the standard graphics format for
Windows, and can be created with such Windows applications as Paint, one of
the Windows accessories. It is able to handle up to a maximum of 16 million
colors, and there is no image degradation, because it cannot be compressed.
However, its file sizes are large.

WMF (*.wmf) WMF stands for Windows Metafile. It is used to save such Windows clip art as
graphics and pictures. It is much smaller than BMP.

TIFF (*.tif) TIFF stands for Tagged Image File Format. It is compatible with a number of DTP
applications because it can be handled among different types of equipment and
operating systems and it can be fully restored following compression. However,
sometimes opening it is difficult because there are various types of TIFFs.

FlashPix FlashPix are image files for digital processing. It supports image data in multiple

(*.fpx) resolutions.

Photo CD Photo CD is an image file format stored in a photo CD that can be created from

(*.pcd) such things as photographic negatives and prints. It supports image data in
multiple resolutions.

DCM (*.dcm) DCM is an image file format for the retouching application PerfectPhoto.

MIF (*.mif) MIF is an image file format for WebArt Designer. You can reedit logos, buttons,

or photo frames only if you save them in this format.
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Appendix D. Cascading style sheets

Homepage Builder supports the following cascading style sheets and classes:
“Advanced style-sheet techniques” on page 9-7

CSS1 (cascading style sheet level 1)

Homepage Builder supports the following CSS1 attributes:

Attribute group

Attribute

Setting in the Style Definition
dialog box

® F = Full support

® N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

Font

font-family

-

font-size

font-weight

font-style

font-variant

Color and background

color

background-color

background-image

background-repeat

background-attachment

background-position

Text

word-spacing

letter-spacing

text-decoration

mZ|ZmZmmmmZmmmm

vertical-align

P (Note 1)

text-transform

N

text-align

E

text-indent

N

line-height

P (Note 2)

margin-top

F

margin-left

margin-bottom

margin-right

padding-top

padding-left

padding-bottom

padding-right

border-top-width

border-left-width

border-bottom-width

border-right-width

border-width

border-top-color

border-left-color

border-bottom-color

border-right-color

border-color

border-top-style

border-left-style

border-bottom-style

border-right-style

border-style

border-top

MMM TTTTTTTTTTTTTMTTTTTTTTTTITTTTTTTT M7 mT

MMM TTTTTTTTT T T T 7T T 7T

Notel Some values can be partially displayed.

Note2 A value that is smaller than the font height cannot be displayed.
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border-left

border-bottom

border-right

width

height

float

clear

Classification display

white-space

list-style-type

list-style-image

MM mZ|Zmmmmmmm

ZmmnZ|ZIZ/ZTnmmnm

list-style-position

CSS2 (cascading style sheet level 2)

Homepage Builder supports the following CSS2 attributes:

Attribute

Setting on the Style Definition dialog
box

® F = Full support

o N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

position

P (Note)

top

F

left

z-index

visibility

cursor

page-break-before

MM mmmmm

page-break-after

zZ|z|z|Zz|mmn

Note Only the position of the absolute coordinate (ABSOLUTE specification) can be displayed.

Pseudo classes

Homepage Builder supports the following pseudo classes:

Pseudo class

Setting on the Style Definition dialog
box

® F = Full support

o N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

a:link

a:visited

a:hover

a:active

mmmm

zZ|z|Zzm

D-2 Homepage Builder User’s Guide




Appendix E. Frequently asked questions

The followings are frequently asked questions (FAQ) about Homepage Builder and
their answers.

@ Does using the Homepage Builder sample materials and templates for my
Web pages have any copyright problem?

A There is no problem. Use them as you like.

0 0000000000000 00000000000000000000000000O0C0OCOCOCFOCFOCNOCNOSNOSTIOISNOIYP
@ Why doesn't my Web browser display an image?

A The following three causes are conceivable:

1. You specified the URL of the image file in the document route format.
If you view a locally-saved HTML document on a Web browser, you cannot view an image
with its path that is specified in the document route format.

2. You specified an incorrect value for the Base URL.
Select Document Properties  from the Edit menu, click the Document Info tab, and erase
the Base URL value.

3. You pasted the image, but you specified the Base URL value.
Erase the Base URL value, and paste the image again.

@ Why does nothing happen when | click an image map on my Web
browser?

A You can check the operation of a client-side image map before uploading it, but you
cannot check the operation of a server-side image map until you upload it to the server.
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1.

Why doesn't my Web browser display a Java applet?

The following five causes are conceivable:

There is no class file (*.class), whose name is specified in the CODE attribute of the
APPLET tag, whereas the location is specified in the CODEBASE attribute of the
APPLET tag.

The applet calls another file as the parameter, but its path is incorrect.

An animated GIF is specified as the parameter.
Some Web browsers end abnormally if an animated GIF is specified as the parameter.

An image file in a format other than GIF and JPEG is specified for a Java applet that
supports only GIF and JPEG image files.
Some Java applets limit the image file formats.

Your Web browser does not support Java applets.

® Why doesn't Web browser display a plug-in object?

Q The following three causes are conceivable:

1.

The width and height of the plug-in object is not specified.
Specify the width and height using the Attribute dialog box for the plug-in object.

. Aplug-in program for your Web browser is not installed.

Your Web browser does not support the EMBED tag.
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Why can't | upload my Web pages? (Why can't | connect to the server?)

The following two causes are conceivable. (Contact your provider on anything that is
unclear.)

1. You specified an incorrect server name, user ID, or password.
You might have specified information of another server--for example, that of the Web
browser connection server or that of the e-mail server--instead of that of the Web page ad-
ministration server. Check the guide furnished by your provider, and specify the correct
server name, user ID, and password.

2. You specified an incorrect destination folder.
Enter a folder name in the Destination Folder field of the Setup Destination Server dialog
box as your provider instructs. For example, if you are instructed to “place data in the
public_html folder,” enter “public_html” in the Destination Folder field. Do not place a slash
“/" at the beginning. If you are instructed to “place data in the /home/username folder,” place
a slash “/” at the beginning, and enter it as “/home/username.”

Q,

A

Why doesn't my Web browser display an image after | uploaded it to the
server?

The following two causes are conceivable:

1. You did not correctly specify uppercase and lowercase letters for the image file
names.
Though you can handle uppercase and lowercase letters indiscriminately on your local com-
puter, they are differentiated on the server. This is because operating systems of your local
computer and that of the server are different. Thus, for example, if you specified a lowercase
file name within the IMG tag, and if the actual image file has an uppercase name, the server
computer does not regard them as the same, and therefore your Web browser cannot dis-
play the image.

2. You stored your images in a subfolder on your computer, but your provider prohibits
the use of subfolders.
Some providers prohibit the use of subfolders.
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@ Why doesn't my Web browser display a Java applet after | uploaded it to

the server?

The following four causes are conceivable:

1. You have not uploaded all the files that are required for running the Java applet.
Check that you have uploaded all the files that make up the Java applet, including the class
files (*.class), image files, and sound files.

2. You did not correctly specify uppercase and lowercase letters for the class file name.
The server discriminates between uppercase and lowercase letters. If your provider says
that you must make all the file names uppercase or lowercase, and if you want to use the
sample Java applets provided by Homepage Builder, you must change their file names.

3. You store your Java applet in a subfolder on your computer, but your provider prohib-
its the use of subfolders.
If you collect the files that make up a Java applet in a subfolder, you must upload that folder
to run the Java applet. However, some providers prohibit the use of subfolders.

4. You specified the location of the image and sound files for the Java applet parameters
with an absolute path.
Specify the location with the relative path, which starts from the class file (*.class).

@ How do | make a frame-using page the top page of a site?

E-4

A

Create a Web page that uses the frame function in advance. Select the Create Site
from Existing Pages radio button from the Create a Site tab of the Welcome to
WebSphere Homepage Builder dialog box, which is displayed when you start
Homepage Builder, and click the OK button. The wizard for creating a site then starts.
Then specify the frame-using page as the top page of the new site.
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What should | watch out for when dividing the top page of a site?

If you divide an existing page into multiple sections using Homepage Builder, a frame-
using page is newly created, and the original page is assigned to the left side or top
side section. Unfortunately, if you divide the top page of a site, the file name of the top
page changes. Some providers specify the top page name, such as “index.html.”
Therefore, you must first rename your original top page, and then rename the new top
page (frame-using top page) “index.htm” (or whatever your provider instructs). @ “Di-
viding a Web browser window (1)” on page 11-3.
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Glossary

animated GIF

A combination of multiple images. As you view an
animated GIF on your Web browser, it repeats the
animation. You can create an animated GIF using
the Web Animator tool.

attribute

A property attached to a certain element, such as
size and color. When editing your Web pages
using Homepage Builder, you first create (or insert)
something; then you change its attributes.

CGl program

A program for exchanging data between a client
and a server. A CGlI program is written in Perl or C
language. It is often used when a server receives
information--for example, questionnaires or orders--
entered in a Web browser and then processes it.

channel

A Web site that is automatically delivered according
to the schedule determined by the Web site creator.

client-side image map

An image map that is processed on the client (Web
browser) side. Because HTML tags for this image
map are embedded in an HTML file, you can easily
use and manage this type of image map.

= image map

dynamic HTML

The latest technology for creating animated Web
pages. Netscape Navigator 4.0, Microsoft Internet
Explorer 4.0, or later version of these browsers can
display dynamic HTML.

form

An interactive form, such as a questionnaire or an
order form. Visitors to your Web site fill in blanks
and enter responses to multiple choices within the
form.

frame function

A function to divide a Web browser window into
several sections.

HTML (Hyper Text Markup

Language)

A special language for creating Web pages, which
contains such HTML tags as <P> <H1> <IMG>.

HTML tags consists of alphabetic letters and
symbols. The latest version is HTML 4.0.

image

Digital data such as photographs, illustrations, and
animations. Images in GIF and JPEG formats are
often used for Web pages. Recently, the new PNG
format is also being used. When images in BMP or
TIFF formats are pasted into Homepage Builder,
they are automatically converted into GIF or JPEG
formats.

image map
An image that has multiple links.
= client-side image map, server-side image map

installation
The insertion of a program into a personal
computer to make it available for use.
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Internet

The world's largest network. It can connect com-
puters throughout the world using the TCP/IP proto-
col.

Java applet

A program written in the Java language. By
changing its parameters, you can change such
things as the background, movement, and text.

link

A function to jump. If you click text or an image to
which a link is set, you jump another page or
another place in the same page.

pixel

A small, square, colored dot, frequently used as a
unit defining the display resolution or the image
size. HTML uses it as unit defining the size of each
element.

plug-in object

An object as the sound data (*.wav; *.mid; *.au) or
multimedia data (Shockwave, VRML) that you can
play back on a Web browser. lItis called a plug-in

object, because you must add a plug-in application
to your Web browser to play it back.

provider

An agent that provides a connection to the Internet.
Many providers offer a service for registering Web
sites.
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script

A program written in the script language,
JavaScript, or VBScript (Visual Basic Script). You
can write this program directly in your HTML file.

server

A computer that stores many Web sites on the
Internet.

server-side image map

An image map that is processed on the server (your
provider's server) side. To use this image map, you
must create an image map file in addition to an
HTML file. There are two types of the server side
image maps, NCSA and CERN, depending on the
application that the server uses. # image map

site

The server location where the Web pages are
placed. Using Homepage Builder, you can create a
virtual site on your own computer and match it with
the server site.

style sheet

A file for controlling appearance. Style sheets have
been adopted in HTML 4.0, so that you can
segregate appearance issues from the document-
element issues that are the proper concern of
HTML. Homepage Builder is compatible with CSS
(Cascading Style Sheet).

tag

Descriptions surrounded by < > that specify
document elements in HTML. For example, the tag
<P> indicates a paragraph, <H1> indicates a
heading, and <IMG> indicates an image. Aslash'/'
is added to the tag indicating the end. The end of a
heading, for example, is described as </H1>.



target
One of the link attributes that indicates where the
link destination page is to be displayed.

top page
A page that is initially displayed when you access a
Web site.

URL

An address of a Web page. It usually begins with
http://www.... Because each URL is unique, you can
access the target URL from anywhere in the world.

Web browser

An application for viewing Web pages. Netscape
Navigator and Microsoft Internet Explorer are well-
known Web browsers.

Web page
An HTML file on the Internet.

wizard

A user interface that enables you to do tasks step
by step. You just need to select something or
answer the question and then click the Next button.
Wizards are often used in the Windows world,
because they allow you to do tasks accurately.

Glossary
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